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preface

BEFORE You BEGIN

Welcome

Introduction

Congratulations on your selection of the Compaqg Aero 8000. Before using your device, be
sure to read through ttiguick Start Guiddor an overview of the initial setup procedures.
Please refer to all the other information that came with your device.

What's Here

In addition to the Compaq Aero 80Qick Start Guidgyou can use this onliriRefer-
enceGuideas a comprehensive library of information on the features of your Compaq
Aero 8000. Here you can find information on a variety of topics. We suggest that you
browse through this onlineeference Guiddts hypertext links enable you to move
quickly to the information you need.

Even if you are an experienced user, please refer to this &eieeence Guidgrst if you
encounter any problems. You can find answers to many common questions or error mes-
sages.
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Symbols and Conventions

Some or all of the following format conventions may be used in this guide to distinguish
elements of text:

Names of keys are shown in bold type as they appear on the keyboard, for example,
Ctrl, Backspace, Tab

Keys that you should press at the same time are represented by the key names and the
plus (+) symbol, for exampl&trl + Alt + Delete

Commands are presented in lowercase, bold type as showmi&k:or a:\install.

An arrow is used to separate icons or menu options that you should select in succes-
sion, for example, sele8tart->Settings>Owner.

When you need to type information without pressinggheer key, you are directed
to "type" the information.

When you need to type informatiand press thénter key, you are directed to
"enter" the information.

NOTE: Text set off in this manner presents commentary, sidelights, or interesting points of
information.

CAUTION: Text set off in this manner indicates that failure to follow directions could result in
damage to equipment or loss of information.

WARNING: Text set off in this manner indicates that failure to follow directions could result in
bodily harm or loss of life.

IMPORTANT: Text set off in this manner presents clarifying information or specific instruc-
tions.

Customer Registration

In North America

To receive the latest information on your Compaqg Aero 8000, as well as special offers on
device accessories and software, be sure to register with Compaqg by completing and
returning theRegister Noworm included with your device.

Outside of North America

Outside of North America, use the Compagq Info Messenger service to obtain Internet and
e-mail access to the latest software updates and service documentation for your device.

Once you register with this free servicenatw.compaqg.com/infomessengamd build

your profile(s), Info Messenger searches the Compaq web site and collects information
specific to your Compaq Aero 8000 environment. Info Messenger then sends an e-mail
alerting you when new and/or updated information is available on a Compaq customized
web page.
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Regulatory Notices

Regulatory Agency Identification Numbers

For regulatory identification purposes your product is assigned a Compaq Series number.
The Compaqg Series number for this product is Series PE2000. This series number should
not be confused with the marketing name (Compaq Aero 8000).

The following accessories have been evaluated for use with your device. These Compaqg-
approved accessories can be identified by their assigned series numbers listed below. To
ensure continued reliable and safe operation of your device, use only the accessories listed
below with your PE2000.

Table 1: Compaqg-Approved Accessories

Accessories Series Number
PC Companion PE2000
Vertical Cradle PE2005B
Rechargeable Li-lon Battery Pack PE2001A, PE2001B, or PE2001C
AC Adapter PE2002
Automobile Adapter 2934A
Integrated Modem PE2006A or PE2006B

Federal Communications Commission Notice

Part 15 of the Federal Communications Commission (FCC) Rules and Regulations has
established Radio Frequency (RF) emission limits to provide an interference-free radio
frequency spectrum. Many electronic devices, including computers, generate RF energy
incidental to their intended function and are, therefore, covered by these rules. These rules
place computers and related peripheral devices into two classes, A and B, depending on
their intended installation. Class A devices are those that may reasonably be expected to
be installed in a business or commercial environment. Class B devices are those that may
reasonably be expected to be installed in a residential environment (i.e., personal comput-
ers). The FCC requires devices in both classes to bear a label indicating the interference
potential of the device as well as additional operating instructions for the user.

The rating label on the device shows which class (A or B) the equipment falls into. Class
B devices have an FCC ID on the label. Class A devices do not have an FCC ID on the
label. Once the class of the device is determined, refer to the following corresponding
statement.
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Class A Equipment

This equipment has been tested and found to comply with the limits for a Class A digital
device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reason-
able protection against harmful interference when the equipment is operated in a commer-
cial environment. This equipment generates, uses, and can radiate radio frequency energy
and, if not installed and used in accordance with the instructions, may cause harmful inter-
ference to radio communications. Operation of this equipment in a residential area is

likely to cause harmful interference, in which case the user will be required to correct the
interference at personal expense.

Class B Equipment

This equipment has been tested and found to comply with the limits for a Class B digital
device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reason-
able protection against harmful interference in a residential installation. This equipment
generates, uses, and can radiate radio frequency energy and, if not installed and used in
accordance with the instructions, may cause harmful interference to radio communica-
tions. However, there is no guarantee that interference will not occur in a particular instal-
lation. If this equipment does cause harmful interference to radio or television reception,
which can be determined by turning the equipment off and on, the user is encouraged to
try to correct the interference by one or more of the following measures:

* Reorient or relocate the receiving antenna.

* Increase the separation between the equipment and receiver.

» Connect the equipment into an outlet on a circuit different from that to which the
receiver is connected.

» Consult the dealer or an experienced radio or television technician for help.

Modifications

The FCC requires the user to be notified that any changes or modifications made to this
device that are not expressly approved by Compaq Computer Corporation may void the
Reference authority to operate the equipment.

Cables

Connections to this device must be made with shielded cables with metallic RFI/EMI con-
nector hoods in order to maintain compliance with FCC Rules and Regulations.
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Declaration of Conformity for Products Marked with the FCC
Logo - United States only

This device complies with Part 15 of the FCC Rules. Operation is subject to the following
two conditions: (1) this device may not cause harmful interference, and (2) this device
must accept any interference received, including interference that may cause undesired
operation.

For questions regarding your product, contact:
Compag Computer Corporation

P. O. Box 692000, Mail Stop 530113

Houston, Texas 77269-2000

Or, call 1-800-652-6672 (1-800-OK COMPAQ)

For questions regarding this FCC declaration, contact:
Compag Computer Corporation

P. O. Box 692000, Mail Stop 510101

Houston, Texas 77269-2000

Or, call (281) 514-3333

To identify this product, refer to the Part, Series, or Model number found on the product.

Canadian Notice/Avis Canadien

Class A Equipment

This Class A digital apparatus meets all requirements of the Canadian Interference-Caus-
ing Equipment Regulations

Cet appareil numerique de la classe A respecte toutes les exigences du RA glement sur le
materiel brouilleur du Canada.

Class B Equipment

This Class B digital apparatus meets all requirements of the Canadian Interference-Caus-
ing Equipment Regulations

Cet appareil numerique de la classe B respecte toutes les exigences du RA glement sur le
materiel brouilleur du Canada.
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European Union Notice

Telecommunications Terminal Equipment with the CE marking comply with Telecommu-
nication Terminal Equipment and Satellite Earth Station Equipment (TTE and SES) Direc-
tive (98/13/EC), the EMC Directive (89/336/EEC), and the Low Voltage Directive (73/23/
EEC) issued by the European Community. Compliance with these directives implies con-
formity to the following European Norms or Regulations (the equivalent international
standards and regulations are in parentheses):

* EN55022 (CISPR 22) - Electromagnetic Interference
* EN50082-1 (IEC801-2, IEC801-3, IEC801-4) - Electromagnetic Immunity
* EN 60950 (IEC950) - Product Safety

« CTR21 (ETSI TBR21) - Attachment requirements for connection to the analog PSTNs
of terminal equipment

The equipment has been approved in accordance with Council Decision 98/482/EC for
pan-European single terminal connection to the Public Switched Telephone Network
(PSTN). However, due to differences between individual PSTNs provided in different
countries, the approval does not, of itself, give an unconditional assurance of successful
operation on every PSTN network termination point. In the event of problems, you should
contact your equipment supplier in the first instance.

The equipment is designed to work with all EU telephone networks. However, the equip-
ment may have interworking difficulties for some connections on the EU public networks.
Dialing by loop disconnect pulses in not intended to be used on the PSTN. This feature is
only supported in consideration of PBX or other equipment which requires pulse dialing.
Network compatibility is dependent upon software switch settings which are set automati-
cally by the country selection. The user should contact the equipment supplier in case of
difficulty in network settings.

German Safety Regulation Requirements

The Compaqg Aero 8000 devices that bear the "GS" approval mark meet the requirements
of ZH 1/618 (German Safety Regulations for Display Work Places in the Office Sector)
when used in conjunction with docking bases, keyboards, and monitors that bear the "GS"
approval mark. The Compaq Zero 8000 devices are not intended for continuous use in an
office environment in a stand-alone mode.

Energy Star Compliance

As an Energy Star Partner, Compaqg Computer Corporation has determined that this prod-
uct meets the Energy Star guidelines for energy efficiency. The Energy Star Computers
Program was created by the EPA to promote energy efficiency and reduce air pollution
through more energy-efficient equipment in homes, offices and factories. Compaq prod-
ucts achieve this by reducing the power consumption when not being used. Using the
power-saving features will reduce energy use and maximize battery life.
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Battery Warning

WARNING: Your computer contains both a lithium-ion battery pack and two nickel metal hydride
batteries. There is a risk of fire and burns if the battery pack is handled improperly. Do not disas-
semble, crush, puncture, short external contacts, or dispose of in fire or water. Do not attempt to
open or service the battery pack. Replace only with the battery pack designated for this product.

In North America, dispose of nickel metal hydride or lithium ion batteries by taking
advantage of the Compaq battery recycling program. You will be provided with a postage-
paid battery pack mailer preaddressed to a reclamation facility where the metals are recy-
cled. Call the telephone number listed for your location in Appendix A for more informa-
tion.

In Europe, do not dispose of batteries with general household waste. Dispose of or recycle
them by using the public collection system or returning them to Compagq, your authorized
Compag partners, or their agents.

U.S. Regulations Governing the Use of Modems

This equipment complies with Part 68 of the FCC rules. Located on the bottom of the
Series PE2002 is a label that contains, among other information, the FCC Registration
Number and Ringer Equivalence Number (REN) for this equipment. Upon request, you
must provide this information to your telephone company.

Ringer Equivalence Number

The REN is useful to determine the quantity of devices you may connect to your telephone
line and still have all of those devices ring when your telephone number is called. In most
areas (but not all), the sum of the RENSs of all devices connected to one line should not
exceed five (5.0). To be certain of the number of devices you may connect to your tele-
phone line, as determined by the REN, you should contact your local telephone company
to determine the maximum REN for your calling area.

The REN for this device is 0.5B.

An FCC Compliant 6-position modular plug is provided with this equipment. This equip-
ment is designed to be connected to the telephone network or premises wiring using a
compatible 6-position modular jack which is FCC Part 68 Compliant (jack type: RJ-11C).
If your telephone equipment causes harm to the telephone network, the telephone com-
pany may discontinue your service temporarily. If possible, they will notify you in
advance. But, if advance notice is not practical, you will be notified as soon as possible.
You will also be informed of your right to file a complaint with the FCC.

Your telephone company may make changes in its facilities, equipment, operations, or
procedures that could affect the proper functioning of your equipment. If they do, you will
be notified in advance to give you an opportunity to maintain uninterrupted telephone ser-
vice. If you experience trouble with this telephone equipment, contact your local tele-
phone company for information on obtaining service or repairs. The telephone company
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may ask that you disconnect this equipment from the network until the problem has been
corrected or until you are sure that the equipment is not malfunctioning.

This equipment may not be used on coin service provided by the telephone company. Con-
nection to party lines is subject to state tariffs.

For the Compaq Customer Support Center and your nearest Compaq authorized reseller in
North America, call 1-800-345-1518 or write:

Compaq Customer Support Center
P.O. Box 692000
Houston, Texas 77269-2000

Telephone Consumer Protection Act of 1991

The Telephone Consumer Protection Act of 1991 makes it unlawful for any person to use
a computer or other electronic device to send any message via a telephone facsimile
machine unless such message clearly contains, in a margin at the top or bottom of each
transmitted page, or on the first page of the transmission, the date and time it is sent and an
identification of the business, or entity, or individual sending the message and the tele-
phone number of the sending machine or such business, or entity, or individual.

Canadian Regulations Governing the Use of Modems

NOTE: The Industry Canada label identifies certified equipment. This certification means that the
equipment meets certain telecommunications network protective, operational, and safety require-
ments. The Department does not guarantee the equipment will operate to the user's satisfaction.

Before installing the equipment, users should ensure that it is permissible to be connected
to the facilities of the local telecommunications company. The equipment must also be
installed using an acceptable method of connection. In some cases, the company's inside
wiring associated with a single line individual service may be extended by means of a cer-
tified connector assembly (telephone extension cord). The customer should be aware that
compliance with the above conditions may not prevent degradation of service in some sit-
uations.

Repairs to certified equipment should be made by an authorized Canadian maintenance
facility designated by the supplier. Any repairs or alterations made by the user to this
equipment, or equipment malfunctions, may give the telecommunications company cause
to request the user to disconnect the equipment.

Users should ensure for their own protection that the electrical ground connections of the
power utility, telephone lines, and internal metallic water pipe system, if present, are con-
nected together. This precaution may be particularly important in rural areas.

CAUTION: Users should not attempt to make such connections themselves, but should contact
the appropriate electric inspection authority or an electrician.
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NOTE: The Ringer Equivalence Number (REN) assigned to each terminal device provides an indi-
cation of the maximum number of terminals allowed to be connected to a telephone interface. The
termination on an interface may consist of any combination of devices, subject only to the

requirement that the sum of the Ringer Equivalence Numbers of all the devices does not exceed 5.

The Ringer Equivalence Number (REN) for this device is 0.2.

For the location of the authorized Canadian maintenance facility nearest you, call 1-800-
263-5868 or contact:

Compag Canada, Inc.

45 Vogell Road

Richmond Hill, Ontario L4B 3P6

Australian Modem Statements

General

Modems connected to the Australian telecommunications network must be marked in
accordance with the Labeling Notice. This modem has been specifically configured to
ensure compliance with the ACA Standards. Do not adjust your modem or software out-
side the values indicated below. To do so would result in the modem being operated in a
non-compliant manner.

Modem Commands

Table 2: Australian Modem Commands

Command Default
ATA -
ATB BO
AT&G &GO
Call Attempts/Retries

Applications software shall be configured so that no more than 3 attempts are made to
establish a connection to a given number.

NOTE: If the modem can detect service tones, up to 10 attempts can be made. If the call
sequence is unsuccessful, there shall be a delay of at least 30 minutes before attempting to call
the number again.
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Failure to set the modem, and any application software used with the modem, to the values
shown above will result in the modem being operated in a non-compliant manner. Conse-
guently, this would be in violation of the Labeling Notice for this equipment, and the Tele-
communications Act 1997 prescribes penalties for the connection of non-compliant
equipment.

WARNING: For safety reasons, only connect equipment with a telecommunications compliance
label. This includes customer equipment previously labeled "Permitted" or "Certified".

New Zealand Modem Statements

The grant of a Telepermit for any item of terminal equipment indicates only that Telecom
has accepted that the item complies with minimum conditions for connection to its net-
work. It indicates no endorsement of the product by Telecom, nor does it provide any sort
of warranty. Above all, it provides no assurance that any item will work correctly in all
respects with another item of Telepermitted equipment of a different make or model, nor
does it imply that any product is compatible with all of Telecom's network services.

This equipment is not capable, under all operating conditions, of correct operation at the
higher speeds for which it is designed. Telecom will accept no responsibility should diffi-
culties arise in such circumstances.

This device is equipped with pulse dialing while the Telecom standard is DTMF tone dial-
ing. There is no guarantee that Telecom lines will always continue to support pulse dial-
ling.

Use of pulse dialling, when this equipment is connected to the same line as other equip-
ment, may give rise to bell tinkle or noise and may also cause a false answer condition.
Should such problems occur, the user should not contact the Telecom Faults Service.

Some parameters required for compliance with Telecom's Telepermit requirements are
dependent on the equipment (PC) associated with this device. The associated equipment
shall be set to operate within the following limits for compliance with Telecom's Specifi-
cations:

* There shall be no more than 10 call attempts to the same number within any 30 minute
period for any single manual call initiation, and

* The equipment shall go on-hook for a period of not less than 30 seconds between the
end of one attempt and the beginning of the next attempt.

» This equipment should not be used under any circumstances which may constitute a
nuisance to other Telecom customers.

» This equipment shall not be set to make automatic calls to the Telecom '111' Emer-
gency Service.
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Finding Information

References are provided as printed materials and as online information that is accessible
from a CD-ROM used on your desktop computer. The following printed references come
with your Compaqg Aero 8000:

» Safety and Comfort Guide

e Quick Start Guide

* Options Information

* Important Safety Information

* Register NowCard (North America only)

» Warranty and Service Information

* Program License Agreement

In addition to this online Reference Guide, the following online and electronic references
are also available:

* Online Help located on the Compaq Aero 8000. Se&ieirrt->Help.

» MicrosoftActiveSyndielp; located on thBesktop Software for ActiveSyGD-ROM,
to be installed on your desktop computer.

* Microsoft PC companion Home Page; locatedhatv.microsoft.com/windowsce
» Compaq Aero 8000 Home Page; locatedhatv.compag.com/products/

Hardware Specifications

Table 3: Compaq Aero 8000 Hardware Specifications

Processor High performance Hitachi SH4 processor designed for
Windows CE

RAM 16 or 32 megabytes, expandable to 64 MB

ROM 16 megabytes (32 MB in Japan)

Video Memory 1 megabyte

Expansion Slots 1 PC Card (Type Il), 1 Compact Flash (Type | & 1), L
standard SDRAM DIMM, 1 internal Flash Card slot

Display 800 x 600 SVGA screen

Battery Backup | Two rechargeable NiMH AAA cell batteries

Main One rechargeable Li-lon battery pack

Audio Internal microphone and speaker, external jacks for

microphone and headphone
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Table 3: Compaq Aero 8000 Hardware Specifications

Infrared IrDA on side of device, rate up to 4 megabits per second
Communications Integrated 56 Kbps V.90 modem, serial port, IR port
Smart Card One Smart Card slot

Size 8.5"x 10.9" x 9.8" (21.6 x 27.7 x 24.9 cm)

Weight 2.9 Ibs. (1.32 kilograms)
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Series PE2000 Optional Power Supply Specifications

Table 4: Compaq Aero 8000 Optional Power Supply Specifications

Product Identification Series PE2000
Input Requirements Low Range
Rated Input Voltage 100 to 120 v
Rated Input Frequency 56/60 Hz
Rated Input Current 250 mA
Output Power Low Range
Rated Output Voltage 5Vdc
Rated Output Current 15A

NOTE: This product is designed for IT power systems in Norway with phase-to-phase voltage not
exceeding 240 Vrms.
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Caring for Your Aero 8000

This chapter provides recommended guidelines for taking care of your Aero 8000. Fol-
lowing these guidelines will help ensure the longevity of your device and reduce the risk
of damage. They include:

* routine care

» travel guidelines

» shipping guidelines

Routine Care

To keep your Aero 8000 in good condition and working properly, follow these guidelines:

» Operate the device with the main and backup batteries installed, even when using
external power. This ensures that it will have the necessary power to operate when dis-
connected from external power.

» Keep the device away from excessive moisture and temperature extremes. Do not
expose the device to liquids or precipitation.

» To prevent damage to the screen, do not place anything on top of the device when it is
closed.

» Store the device in a protective case when not in use.

CAUTION: Compagq cases are designed for carrying convenience only. The cases do not protect
the device against damage caused by excessive shock and vibration.

* To clean the device, wipe the screen and the exterior with a soft, damp cloth moistened
only with water.

CAUTION: To reduce the risk of electric shock or damage to the internal components, do not
spray liquid directly on the screen or allow excess liquid to drip down inside the device. Using
soap or other cleaning products on the screen may discolor the finish and damage the screen.

* Avoid exposing the device to direct sunlight or strong ultraviolet light for extended
periods of time. Also avoid scratching the surface of the screen and banging it against
hard objects.
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Travel Guidelines

For safety and convenience when traveling with your Aero 8000, follow these guidelines:

Back up your data before you leave. (For more about using the Backup and Restore
utilities, seeJsing Compaq Softwark

Take a backup copy of your data with you. (For more about backing up data onto an
optional ATA Flash RAM PC Card or CompactFlash Card#eg Compaq Soft-
ware)

Disconnect all external equipment from the device.

Take the AC adapter with you.

Hand-carry your device in a protective case. Do not check it with your luggage.
Do not close objects between the keyboard and screen.

Be aware of potential effects of airport security devices on your Aero 8000.

IMPORTANT: There are three types of airport security devices: X-ray machines, magnetic
detectors (the device you walk through), and security magnetic wands. You can send your device
through airport X-ray machines. However, Compag recommends that you do not send the device
through magnetic detectors or expose it to security magnetic wands.

Check with the airline if you plan to use the device on the plane. In-flight use of elec-
tronic devices is at the discretion of the airline.

International Travel

Before traveling internationally with your Aero 8000, be sure to:

Check local customs regulations.

If using an external modem or PC Card modem, be sure you have the correct modem
and cable for the country you are visiting. Telephone lines differ from country to coun-

try.
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Shipping Guidelines

When shipping the Aero 8000, follow these guidelines:

Safeguard your data by making a backup copy.

If shipping the backup copy, be sure that the medium (diskette, tape, or PC Card) is not
exposed to electrical or magnetic impulses while stored or in transit.

Be sure the PC Card and CompactFlash slots are empty.
Turn off the device and disconnect all external devices.
Close the device.

Pack the device and all external devices (such as cords and cables) in their original
packing boxes or in similar packaging with sufficient packing material to protect them.
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chapter 1

INTRODUCING THE AERO 8000

Introducing the Device

Congratulations on purchasing the Compaqg Aero 8000 powered by the Microsoft Win-
dows CE operating system. The size and capabilities of this device let you keep your most
important business and personal information up-to-date and close at hand. ActiveSync
increases the power of your device by letting you synchronize the information on your
desktop or laptop computer with your device.

Introducing the Aero 8000 1-1



Unpacking the Box

"
~

Before setting up your device, be sure your shipping box includes the following items:
Aero 8000 device

AC Adapter

Power Cord

o—

Auto-sync Cable

Rechargeable Lithium lon Battery Pack
Smart Card

Not pictured:

« Modem Cable
* CD-ROM Discs (2)
+ Documentation

o g M w Db pRE

NOTE: To order accessories that did not come with your Aero 8000 model, refer to the Accesso-
ries card included on the Compagq software CD.
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Front and Left Side Components

Table 1: Front and Left Side Components

1Y

ed.

in to

able.

nto

card.

oice

Item Component Function

1 Lid Latch Secures the lid when the unit is closed.

2 Screen Displays on-screen information.

3 Microphone Speak into the microphone to record a voice
memo. Works whether device is open or clos

4 Power Button Press once to turn on the device. Press aga
turn off.

5 VGA Port Accepts a VGA video cable.

6 Serial Port Connects serial devices such as a printer ca

7 Sync Port Connects the auto-sync cable for connectio
a desktop or docking station.

8 AC Power Connector Connects to external (AC) power via the A(
adapter.

9 CompactFlash Slot Accepts a Type | or Type Il CompactFlash

10 Speaker Produces sound for the alarm, playback of \
memos, and other audio effects.

11 Touch Pad Press and move your finger on the pad to
manipulate the cursor.

12 Mouse Buttons Use like left and right buttons on a regular
mouse.
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Front and Right Side Components

Table 2: Front and Right Side Components

Item Component

Function

1 Notification Button/LED

Flashes once when device is turned on. Flashes

continuously when an alarm you have set goes
off. Press once to stop the alarm.

2 Audio In

~

Accepts audio input for recording or playbac

3 Audio Out

Distributes audio output.

4 Record Button/LED

Press once to record. Press again to stop record-

ing.

5 Power On LED

Appears when the unit is connected to AC
power.

Battery Charge LED

Appears when the unit is charging.

PC Card Slot

Accepts a Type | or Type Il PC card.

Infrared Port (IR)

Allows for wireless infrared communication.

©O©| 0| N| O

Smart Card Slot

Accepts a credit card-sized Smart Card. Simply

slide in the card when needed.

10 Modem Port

Connects an RJ-11 modem cable.

11 PS/2 Port

Allows for connection of up to two devices,
such as a keyboard and mouse, using an
optional "Y" cable.
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Top and Rear Components

Table 3: Top and Rear Components

Item Component Function

1 Battery Pack Powers the device as a rechargeable lithium-ion
(Li-lon) battery pack.

2 Strap Inserts Allows for connection of a shoulder strap fq
easier carrying.

=
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Bottom Panel Components

Table 4: Bottom Panel Components

Item

Component

Function

1 Main Battery Latch

Slide the latch to the side to release the majn
battery.

2 Backup Battery Door

Holds two NiMH AAA batteries used for
backup power to the device.

3 Reset Button

Restarts the operating system.

CAUTION: Pressing the Reset button will perma-
nently delete all of your unsaved information.
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chapter 2

SETTING UP FOR THE FIRST TIME

Setting Up for the First Time

To set up your Aero 8000 for the first time, follow the instructions below.

1. Install the new Lithium-lon battery pack by sliding the pack into the slot on the back
of the device.

2. Raise the lid of the Aero 8000 by sliding the lid release to the right.

"
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3. Connect the unit to AC power for three hours to allow the battery pack to charge.

4. Press the power button to turn on power.

5. Follow the instructions on the screen to complete the setup process.
6. To learn more about your Aero 8000, take the Welcome Tour by pré&ssid .

Once setup is complete, you may want to connect your Aero 8000 to a desktop computer
and load valuable Compagq software.
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Using the Backlight

Backlighting allows you to better see the screen of the Aero 8000 in compromised lighting
conditions. When using AC power, you can set the device to its brightest level for easy
viewing. If you are using battery power, you may want to conserve power and lower the
device's BackLight level.

You can control the Aero 8000 backlight setting using the following directions:

Setting the BackLight Levels

To set the Aero 8000 BackLight levels, follow these steps:
1. Double-click the Compagq Utilities icon on the desktop.
2. Double-click the BackLight icon.

3. Adjust the slider i\C Brightness Levelto the brightness desired when you are using
AC power.

4. Adjust the slider ilBattery Brightness Levelto the brightness desired when you are
running on a battery.

5. Click OK.

Enabling the Auto Dimmer

To enable the auto dimmer on the Aero 8000, follow these steps:
Double-click the Compaq Utilities icon on the desktop.

Double-click the BackLight icon.

SelecEnable Auto Dimmer.

Adjust theBattery Dim Level to the level you want the screen to dim.

a M DN

Select a time increment frodim Timeout to set the time since the unit was last used
(a key pressed or touch pad used) before beginning the dim.

6. Click OK.
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Power and Defined Keys

Table 5: Power and Defined Keys

Item Component Function

1 Power On Button Press once to turn on the device. Press again to
turn off.

2 Application Launch Keys Used to open applications quickly.

3 User Definable Keys Programmable keys used to bring up the user's
favorite applications, programs, Internet sites,
etc.
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Additional Keyboard Functions

' — E E
SEEE

= |

= iF

NOTE: Locations and legends of keys vary by geographic region.

Table 6: Additional Keyboard Functions

Ul

a

[2)

Item Component Function

1 Mute Key Press in conjunction with tRe key to mute the
unit's sound output. Press again to return sound.

2 Volume Down Key Press in conjunction with the key to decrease
sound output.

3 Volume Up Key Press in conjunction with thie key to increase
sound output.

4 External Video Press in conjunction with the to turn on/off
the video output to an external monitor. Pres
again fro simultaneous LCD and CRT. Press
third time for LCD only.

5 Battery Status Press in conjunction with Emekey to display
main battery and backup battery power status.

6 Backlight Off Press in conjunction with tik@ key to toggle
the backlight on and off.

7 Num Lock Key Press in conjunction with tha key to enable
the numeric keypad.

8 Numeric Key Pad Use whédum Lk is enabled. Allows numerig
key pad to function as number keys.
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Table 6: Additional Keyboard Functions

Item Component Function

9 Brightness Up Key Press in conjunction with Emekey to increase
the backlight brightness.

10 Brightness Down Key Press in conjunction withFekey to decrease
the backlight brightness.

11 Contrast Up Key Press in conjunction with Emekey to increase
the display contrast.

12 Contrast Down Key Press in conjunction withfmekey to decrease
the display contrast.

13 Windows Key Press to display the Start menu.
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User-Defined Application Launch Keys

Introduction

The Aero 8000 allows you to customize the function of up to 36 user-defined keys on your
device's keyboard. These keys are located at the top of the keyboard, shown@ items
and® below.

The first set of 12 shortcuts is available by pressing the corresponding key. For example,
pressing the Tasks key displays your current task list. Access the second set of keys by
pressing the desired key in conjunction with8t#lFT key. The third set of keys is avail-
able by pressing theTRL key in conjunction with the desired key.

The nine keys displaying the icons for Microsoft applications such as Inbox, Tasks, and
Pocket PowerPoint are already defined in their path. You can change this path using the
Launch Key Properties dialog box.

For example, rather than the system opening a blank spreadsheet each time it opens Pocket
Excel, you can set the path on the Pocket Excel application launch key to open a specific
spreadsheet, such as an expense report or budget. However, if you want to keep the path of
the Pocket Excel key, you can set 8t¢IFT + Pocket Excel key to access your expense
report and set th€TRL + Pocket Excel key to access your budget.

In addition, there are three keys (displaying a diamond following by the number 1, 2, or 3)
that are completely user-definable. You can use these keys in the same manner as you use
the other application launch keys.
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Programming the User-Definable Application Launch Keys

To program (change the path) of an application launch key, follow these steps:

1. Access the Launch Key Properties dialog box by double-clicking the Compaq Utilities
icon and double-clicking the Launch Keys icon.

2. Select the tab corresponding to the key you want to edit. For example, sel&ct the
Launch Keystab to seCTRL + launch key.

3. Double-click in the path field corresponding to the key you want to customize so the
current text is highlighted.

Press th®eletekey to clear the field.

5. Enter the path you want or, if you are unsure of the path, click the icon to browse for a
file.

NOTE: If you want the icon's path to reset to the default, click the Reset button corresponding to
the icon.

6. Click Savewhen you are done.

NOTE: Click Reset to Default Values to reset all of the launch key paths.
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Using the Application Launch Keys

The application launch keys provide a fast and convenient way to get to many of your
favorite programs. To start a program, press the key corresponding to the icon for the pro-
gram you want to start.

The following table lists the application launch keys and their corresponding programs.

Table 7: Application Launch Key Programs

Key Program Launched

Inbox: Send and receive e-mail.

E Microsoft Pocket Internet Explorer: Access the Internet.

Calendar: Keep track of your appointments and create meeting requests.

Contacts: Keep track of your friends and colleagues.

w%

Tasks: Keep track of your tasks.

Microsoft Pocket Word: View and create Pocket Word documents.

Tl
%—f—a

Microsoft Pocket Excel: View and create Pocket Excel documents.

&

Microsoft Pocket PowerPoint: View PowerPoint presentations.

%,

Microsoft Pocket AccessView and create Access databases.
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NOTE: There are many Windows CE programs available, including freeware and shareware. Visit
www.microsoft.com/windowsce or try searching the Web on the keyword "Windows CE" to find
additional programs for your device.

Using the Touch Pad and Mouse Buttons

The Aero 8000 touch pad is used like a mouse on a desktop PC. Simply press, hold, and
drag your finger on the pad and watch the cursor on your Aero 8000 screen reflect your

movements. To select an item, slide your finger on the pad until the cursor is over the item.
Tap once on the pad and the item is selected. Double-tap an icon to open an application.

Also available are two mouse buttons located near the touch pad. Use these buttons as you
would use the left and right mouse button on your desktop PC’s mouse. Move the cursor
and click the left mouse button once to select an item. Double-click an icon to open an
application. Click the right mouse button to display a menu. You can then select items

from the menu by using the touch pad.
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chapter 3

FORMING A PARTNERSHIP

Introduction

Your Aero 8000 acts much like a "computer assistant” - it supplements the capabilities of
your regularly used computer when you cannot be at your desk. The device does this
through partnering with your regular computer. A partnership is the process of establish-
ing a connection with your regularly used computer for the purpose of synchronizing and
transferring data between the computer and the Aero 8000.

Forming a partnership involves four steps, each of which is discussed in this chapter:
Step 1: Determine Computer Requirements

Step 2: Install ActiveSync

Step 3: Configure the Communications Port
Step 4: Connect the Aero 8000 to the Computer

Additional information on forming a partnership can be found in the ActiveSync Help that
you installed on your computer.

Electrostatic Discharge Notice

Electrostatic discharges can interfere with the normal functioning of electronic devices.
This may cause the Compaq Aero 8000 to function abnormally, and data corruption or loss
of unsaved data can occur. To return to normal operation, reset the Aero 8000 as described
in the section titledResetting Your Aero 8000

To avoid data loss due to electrostatic discharge or other incidents, it is recommended that
you regularly backup your data. Please refer to the section titkag the Backup and
Restore Utilities
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Step 1: Determine Computer Requirements

Before establishing a partnership, be sure your computer meets the minimum configura-
tion requirements listed below:

e 486/33DX or higher processor
* Microsoft Windows 95 (or later)

or
Windows NT Workstation 4.0 (or later)
* 8 MB of memory (Windows 95)
or
12 MB of memory (Windows NT Workstation 4.0)

» 10 MB of available hard disk space

* Available 9- or 25-pin serial port (adapter required for 25-pin serial port)
 CD-ROM drive

* VGA or higher resolution graphics card

* Microsoft Mouse or compatible pointing device

NOTE: Some third-party applications may have additional configuration requirements. Refer to
the documentation included with these applications for more information.

Step 2: Install ActiveSync

ActiveSync is the software that allows you to synchronize data between your Aero 8000
and your computer. Follow the steps below to install ActiveSync on your computer.

IMPORTANT:  Before installing this software, be sure your computer meets the minimum con-
figuration requirements listed earlier in this chapter.
1. Insert the Microsoft CD into the computer's CD-ROM drive.

2. Follow the instructions included with the CD and on the computer screen to install
ActiveSync and other software.
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Step 3: Configure the Communications Port

Before connecting, you must configure your computer's COM port so that it can commu-
nicate with your Aero 8000.

NOTE: This procedure covers only the configuration for an auto-sync or serial cable connection.
For information on connecting with an infrared port, RAS, or network, see Using the Infrared Fea-
ture or "Get Connected" in the ActiveSync Help that you installed on your computer.

Using Windows NT Workstation

SelectStart-> Settings>Control Panel. Choose the Ports icon. Configure a COM port for
your Aero 8000 with the following settings: 115,200 baud, 8 data bits, 1 stop bit, no parity,
hardware flow control.

Using Windows 95 (or later)

SelectStart->Settings>Control Panel. Double-click the System icon and select the
Device Managertab. Configure a COM port for your Aero 8000 with the following set-
tings: 115,200 baud, 8 data bits, 1 stop bit, no parity, hardware flow control.
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Step 4: Connect the Aero 8000 to the Computer

Once ActiveSync is installed on your computer and the communications port is config-
ured, you are ready to connect your Aero 8000 to the computer. To do so, follow the steps
below.

CAUTION: Route cords and cables so that they will not be walked on, tripped over, or pinched by
items placed upon or against them. Pay particular attention to the power plug, electrical outlet,
and the point where cords and cables exit the device.

1. Connect the 9-pin end of the auto-sync cable to the serial connector on your computer.
(Some computers may require a 9-to-25 pin adapter in order to connect the auto-sync
cable).

2. Connect the 16-pin end of the auto-sync cable to the serial connector on your device.

NOTE: The first time you connect your Aero 8000 to the computer, the New Partnership Wizard
appears on the screen. Follow the instructions to establish a connection between the two devices.
The next time you connect, your data will be synchronized automatically, provided that you accept
the default settings.

IMPORTANT:  Refer to Synchronization for more information on establishing a connection and
synchronizing data.
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chapter 4

USING POWER

Using AC Power

The AC Adapter included with your Aero 8000 allows you to connect to AC power via an
electrical outlet. When connected to AC or other external power (such as automobile
power), the device functions normally, except battery power is not used. A plug icon
appears in the status area of the taskbar to indicate that the device is connected to external
power.

WARNING: To reduce the risk of electrical shock, fire, or damage to the device, do not use con-
verter kits sold for appliances to power the device.

NOTE: The rechargeable Li-lon battery pack automatically recharges while the device is con-
nected to external power. The amber indicator light appears and the battery charging icon dis-
plays in the taskbar while the battery pack charges.

Use the AC adapter to plug the Aero 8000 into external power whenever possible, espe-
cially when you are using a modem card, Ethernet card or other peripheral, or if you are
connecting to a desktop computer.
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Connecting to AC Power

It is not necessary to turn off your Aero 8000 before connecting to AC power. To connect
to AC power, follow the steps below:

CAUTION: Make sure that the electrical outlet you plug the AC adapter into is easily accessible at
all times. To disconnect power from the device, unplug the AC adapter from the electrical outlet.
1. Connect one end of the power cord to an electrical outlet.

2. Connect the power cord to the AC Adapter.

3. Plug the other end of the cable into the AC connector on your Aero 8000.

The device automatically switches to AC power without interrupting operation.

Power Cords

If you were not provided with a power cord for your computer or for an AC power acces-
sory intended for use with your computer, you should purchase a power cord that is
approved for use in your country.

The power cord must be rated for the product and for the voltage and current marked on
the product’s electrical ratings label. The voltage and current rating of the cord should be
greater than the voltage and current rating marked on the product. In addition, the diame-
ter of the wire must be a minimum of 0.75 mm2/18AWG, and the length of the cord must
be between 5 feet (1.5 meters) and 6.5 feet (2 meters). If you have questions about the type
of power cord to use, contact your Compaq authorized service provider.

A power cord should be routed so that it is not likely to be walked on or pinched by items
placed upon it or against it. Particular attention should be paid to the plug and electrical
outlet.
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WARNING: To reduce the risk of personal injury, electric shock, fire, or damage to the equipment:

* Do not disable the power cord grounding plug. The grounding plug is an important
safety feature.

* Plug the equipment into a grounded (earthed) electrical outlet that is easily accessible
at all times.

» Disconnect power from the equipment by unplugging the power cord from the electri-
cal outlet.

* Do not place anything on power cords or cables. Arrange them so that no one may
accidentally step on or trip over them.

* Do not pull on a cord or cable. When unplugging from the electrical outlet, grasp the
cord by the plug.

Battery Information

Your Aero 8000 has a dual power supply that consists of:

* main battery (a rechargeable Li-lon battery pack)

* backup batteries (2 rechargeable NiIMH AAA cell batteries)

The main battery powers the Aero 8000 when it is not connected to an external power
source. The backup batteries, which come preinstalled, protect your saved data when the

main battery is drained or has been temporarily removed (for example, when you are
replacing the main battery).

Checking Battery Power Levels

To see the estimated amount of remaining battery power for the main and backup batter-
ies, press the Battery Status kEn (+ battery status). You can also access this information
by selectingStart-> Settings>Control Panel. Double-click the Power icon, then select
theBattery tab.

NOTE: The amount of remaining battery power is an estimate. The actual amount of remaining
power can vary, depending on your Aero 8000 usage and operating conditions.

Recognizing Low Battery Indicators

To protect against data loss, the following precautionary measures are built into your
device:
* Low battery icons notify you when the condition of any battery drops below Good.

* A warning message appears on the screen when any battery reaches a critical low
level.

* Afinal warning message and a low battery shutdown (which saves all data in memory)
occur when the batteries are too low to run the device.
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Low Battery Icons

The Aero 8000 displays various battery icons in the status area of the taskbar when the
battery is low. When you see a low or very low battery icon, save your work, turn off the
device, and recharge the battery as soon as possible.

Critical Low Battery Warning

If no action is taken to resolve the low battery condition described above, a critical low
battery warning appears on the screen when the battery enters a very low state. When you
see this warning, take immediate action by saving your data, then connect the AC adapter
to your device until the battery pack recharges.

CAUTION: To avoid losing data stored in memory, do not allow the backup batteries to run down.
Connect to AC power as soon as you are notified that backup battery power is low. Do not remove
the main and backup batteries at the same time. Doing so will cause data, configuration settings,
and user-installed programs to be lost.

Low Battery Shutdown

When the main battery is too low to run the device, a final warning message appears noti-
fying you that your Aero 8000 can no longer run and will be shut off. This is followed by
an automatic shutdown which saves all data and suspends operation until the device is
connected to external power.

Conserving Battery Power
To get the longest life from your batteries, follow these guidelines when using your Aero
8000:
* Use external power for PC Card operations.

PC Card modems and other PC Cards use large amounts of power to operate and can
quickly drain the batteries in your device. Use AC power or automobile power for PC
Card operations whenever possible.

e Limit PC Card use when you must use battery power.

When using battery power, limit the amount of time that you use the PC Card, and
remove it from the PC Card slot when it is not in use.

» Use external power for communications connections.

Extended connections (communicating via the modem, serial port, or IR port) can
quickly drain batteries. Use the AC adapter to connect to an external power source
when your PC companion is communicating through one of these channels.
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Limit the use of backlight.
* Minimize backlight use when you are operating on battery power.

* When using the backlight and battery power, use the lowest level of backlight
needed to see the screen.

* Use Backlight Properties in the Compagq Utilities to automatically dim backlight
brightness when running on battery power.

Shorten auto-suspend time.

Your Aero 8000 is configured to automatically suspend operation to conserve battery
power if you have not used the keyboard or touch pad after three minutes. To shorten
auto-suspend time, follow these steps:

1. SelectStart->Settings>Control Panel, then double-click the Power icon.
2. Select the Power Off tab, then select another auto-suspend setting.
NOTE: Your Aero 8000 does not auto-suspend while communicating through the
modem, serial port, IR port, or docking station.
Enable suspend while on external power.

To auto-suspend the device while it is connected to AC power or automobile power,
follow these steps:

1. SelectStart>Settings> Control Panel, then double-click the Power icon.
2. Select théower Off tab, then place a check in the appropriate checkbox.
Turn off sounds.

SelectStart-> Settings> Control Panel, then double-click the Volume & Sounds icon
and turn off sound events that you do not need.

Replacing Batteries

WARNING: To reduce the risk of injury or damage to the battery pack, do not crush, puncture, or
incinerate the battery pack or short the metal contacts. Do not attempt to open or service the bat-
tery pack.

Observe the following precautions when replacing batteries:

Use only battery packs purchased through Compaqg or a Compag-authorized dealer.

Keep track of the main and backup battery life by frequently checking battery status. If
the batteries used for both power supplies are low at the same time, data stored in
memory can be corrupted or lost.

IMPORTANT:  Before replacing any batteries, Compaq recommends performing a data backup.
For complete instructions on this, see Using the Backup and Restore Utilities.

Using Power 4 -5



Replacing the Main Battery

When replacing the main battery, use a rechargeable Li-lon battery pack.

WARNING: This device contains a lithium ion battery pack. There is a risk of fire and chemical
burn if the battery pack is handled improperly. Do not disassemble, crush, puncture, short exter-
nal contacts, dispose in water or fire, or expose to temperatures higher than 140°F (60°C). Do not
attempt to open or service the battery pack.

CAUTION: Do not remove both the main and backup batteries at the same time. Doing so will
cause data, configuration settings, and user-installed programs to be lost.

To replace the main battery, follow these steps:

1. Save your work.

2. Turn off the Aero 8000 by pressing the power button.

3. Close the device and turn it over.
4

Release the battery by sliding the latch, then removing the old battery pack from the
device.

5. Install the new rechargeable Li-lon battery pack.
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6. Connect the device to AC power and allow the battery pack to charge for three hours.
7. Turn over your device, raise the lid, and press the power button to resume operation.

Replacing the Backup Battery

Two NiMH AAA cell batteries (available through your local reseller) come preinstalled in
the device. Be sure to replace the backup batteries as soon as possible when they no longer
hold a charge (such as when the low battery icon appears in the status area of the taskbar).

WARNING: This device contains an internal battery-powered real-time clock circuit. There is a
risk of explosion and injury if the batteries are incorrectly replaced or improperly handled. Do not
attempt to recharge, disassemble, immerse in water, dispose of in fire, or expose to temperatures
higher than 140°F (60°C). Do not attempt to open or service the batteries. Replace the batteries
only with batteries designated for this product and approved by Compagq.

CAUTION: Do not remove both the main and backup batteries at the same time. Doing so will
cause data, configuration settings, and user-installed programs to be lost.

To replace the backup batteries, follow these steps:

1. Save your work.

2. Turn off the Aero 8000 by pressing the power button.

3. Close the device and turn it over.
4

Loosen the screw on the backup battery compartment cover using a small flat head
screwdriver.

5. Remove the compartment cover and old batteries.

A

6. Wipe the surface of the new backup batteries with a soft cloth, then place them in the
backup battery compartment.
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7. Replace the compartment cover and tighten the screw.

Disposal and Recycling of Used Batteries

Disposal of batteries should comply with country, state, province, and local regulations.
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Resetting Your Aero 8000

During a severe system lockup or when a malfunction cannot be corrected any other way,
you may need to completely reset and restart your device. Your Aero 8000 can be reset
two different ways, depending upon your situation and the action that is called for: normal
reset, which does not affect data that has been saved in memory, and full reset, which
erases memory contents and settings.

Performing a Normal Reset

A normal reset restarts your Aero 8000 much like presSirig+ Alt + Del restarts a
computer. To perform a normal reset, follow these steps:

WARNING: All unsaved work will be lost.
1. Save all work (if possible).
IMPORTANT: Do not press the power button to turn off the device.

2. Close the lid and turn over the device.

3. Using a paper clip tip, press the reset button.

4. The device automatically restarts.
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Performing a Full Reset

A full reset restarts your device and removes all information that was stored in memory,
such as your data files and your system settings.

NOTE: If you saved your data using one of the backup and restore utilities provided with your

Aero 8000, it is possible to restore your saved data after performing a full reset. For more on using

the backup and restore utilities, see "Using Compaq Software".

To perform a full reset, follow these steps:

If using external power, disconnect the device from the AC adapter.

Close the lid and turn over the device.

Remove the main and backup batteries.

Wait at least 5 minutes, then replace the batteries.

Turn over the device, open it, and press the power button to restart the Aero 8000.

2L T o

Run through the Welcome Tour again to reestablish your system settings.

NOTE: If you previously saved data using the backup utility, you will be prompted to restore your
saved data. Select Yes if you wish to do so.
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Winbows GE

General Information

Starting Programs

Select the Start menu and then select the program name to open a program that isn't listed
on the desktop.

Using Context Help

For information about a program or dialog box, se®tatt->Help while using the pro-

gram or dialog box. To see the name of a toolbar button, select and hold the cursor on the
button. Drag the cursor off the button so the system does not actually carry out the com-
mand.

Opening the Shortcut Menu

PressALT and click anywhere on the desktop.

Switching Between Menu and Toolbar

Use the slider to control the display of menus and the toolbar. To quickly switch between
menus and toolbar buttons, select the slider. Drag the slider left or right to display menus,
toolbar buttons, or a combination of both. To see both menus and toolbar buttons, drag the
toolbar below the menu bar.

Moving a File to a CompactFlash Card

1. Open the file you want to move.
2. Selecfile>Save As
3. Save the file in the folder named for the storage card.
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Deleting Information

You can delete such items as appointments, contacts, messages, notes, recordings, and
tasks.

1. Select the desired item in the list.
2. Click the Delete button.

Using Windows Explorer

Windows Explorer works almost exactly the same on your mobile device as it does on
your PC. See the topics below for information about the differences in operation for Win-
dows Explorer on your device.

Navigating in File View

Going Forward and Backward

You can go up a level by selecti@gp->Back. To go down a level, seleGo>Forward.

Using the Go Menu

To quickly access thly Documentsfolder, selecGo>My Documents To see all of the
folders you have accessed, sel@oe History. Double-click a folder to return to it.

Viewing Files as Icons or Lists
1. Selectview->Large Iconsor Small Iconsto view icons.

2. SelectvView->Detailsto view a list.

Working with Files and Folders

Creating a New Folder
1. If necessary, open the folder where you want the new folder to reside.

2. Selectfrile>New Folder.

Adding a Folder to Your Favorites List

1. Open the folder.

2. Selecfavorites>Add to Favorites.

3. Type the shortcut name in tName box.

To open a favorite file or folder, seldeavorites and then select the folder. To organize
your favorites, seledtavorites>Organize Favorites
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Transferring a File using Infrared

To send a file, select the file, line up the infrared ports, and $éleetSend to>Infra-
red Recipient To receive a file, line up the infrared ports and sétdet>Receive

Switching to the Internet
Type a URL in the Address bar.

Programs

The basic set of Windows CE programs is installed on your Compaqg Aero 8000. You can
switch to any program by selecting from Si&rt menu or by pressing a program button
on the device. The program buttons use icons to identify which programs they access.

NOTE: The pre-installed programs on your device are stored in ROM (read-only memory) and
cannot be removed or lost. You can install additional software that will be placed in RAM (random
access memory). Programs placed in RAM can be removed. See the ActiveSync Help on your
desktop computer for information on installing third party software.

Table 8: Windows CE Programs

Program Description

Calendar Keep track of your appointments and create meet-
ing requests.

Contacts Keep track of your friends and colleagues.

Inbox Send and receive e-mail.

Tasks Keep track of your tasks.

Microsoft Pocket Access View and create Pocket Access databases.

Microsoft Pocket Excel View and create Pocket Excel documents.

Microsoft Pocket PowerPoint View PowerPoint presentations.

Microsoft Pocket Word View and create Word documents.

ActiveSync Initiates synchronization with your desktop com¢t
puter from your device.

PC Link Initiates a connection with your desktop computer.

Remote Networking Set up connections with other computers or the
Internet.

Terminal View and download files from a bulletin board of

send and receive e-mail.
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Table 8: Windows CE Programs

Program Description
Microsoft Voice Recorder Record your spoken ideas.
Microsoft InkWriter Create handwritten or typed notes and drawings.
World Clock Set the date, time, and alarm for your home city
and the city you are visiting.
Calculator Perform calculations.
Solitaire Entertain yourself while on the road.
Microsoft Pocket Internet Explorer Browse the Internet.
Windows Explorer Allows you to manage your files.

Microsoft ActiveSync

Introduction

This chapter provides information on Microsoft ActiveSync and synchronization possibil-
ities. These features allow you to successfully synchronize files between your Aero 8000
and your desktop computer. This process includes:

* installing ActiveSync

* setting up a partnership

* synchronizing and converting files

Microsoft ActiveSync enables you to synchronize the information on your desktop com-
puter with the information on your device. Synchronization is the process of comparing

the data on your device with your desktop computer and updating both computers with the
most recent information. For example:

» Keep Pocket Outlook data up-to-date by synchronizing your mobile device with your
choice of Microsoft Outlook (Inbox synchronization with Outlook Express in not cur-
rently supported), Microsoft Schedule+, or Microsoft Exchange on your desktop com-
puter.

» Synchronize Word and Excel documents, Access and other ODBC databases and
tables, and InkWriter documents between your device and desktop computer. Your
files are automatically converted to the correct format.

With ActiveSync, you can also:

» back up and restore your device data.
* add and remove programs on your device.
» copy (rather than synchronize) files between your device and your desktop computer.
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Installing ActiveSync and Setting Up a Partnership

1. If you want to upgrade to Microsoft Outlook 98, install it first.

2. Locate the synchronization cable that came with your device. Use this cable to connect
your device to your desktop computer.

3. Insert the Desktop Software for Microsoft Windows CE compact disc into your CD-
ROM drive.

4. The ActiveSync Setup Wizard starts automatically. If it doesn't, type d:\setup where d
is your CD-ROM drive.

5. Follow the directions on your screen.

Once installation is complete, a wizard will instruct you to connect your device and desk-
top computer and guide you through setting up a partnership and performing your first
synchronization. Some items, such as messages, are not synchronized by default. To
change the type of items that get synchronized after you've completed the wizard, select
your device icon in the Mobile Devices folder and then dfickveSync Optionson the

Tools menu.

If you are synchronizing with a computer running Windows 95, you can also use an IR
connection to synchronize. For more information, see ActiveSync Help.

NOTE: Regularly back up your device data on your desktop computer using ActiveSync in case
information on your device is ever corrupted or lost. Connect your device and then click Backup/
Restore on the Tools menu in the Mobile Devices folder on your desktop computer. Your first back
up may take some time, depending on how much information you have on your device. Subse-
quent backups will be faster if you select Incremental.

Synchronizing and File Conversion

One way to move documents to your device is to simply connect your device and desktop
computer, open your device icon in the Mobile Devices folder, and drag the files. Copies
of the files will be placed on your device, and files will be automatically converted to a
format that the device can read.

However, if you have documents that you update frequently on both your device and desk-
top computer, you may want to synchronize the copy on your desktop computer with the
one on your device so that you always have an up-to-date copy on both computers. To do
so, store the files you want to synchronize in the Synchronized Files folder on the device
and desktop computer. During synchronization, files are updated in both locations.

NOTE: On the device, the Synchronized Files folder is in the My Documents folder. On the desk-
top computer, the Synchronized Files folder is called device Synchronized Files, where device is
the name of your device. If you are using Windows 95, the folder is located in the My Documents
folder (c:\My Documents\device Synchronized Files). If you are using Windows NT, the folder is
located in the Personal Folder (c:\Winnt\Profiles\your username\Personal\device Synchronized
Files).
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When you transfer a file from your desktop computer to your device, the file is converted
to a format that the device can read. During file conversion, some of the file's attributes
may be changed or removed, and the file extension is changed. For example, when you
transfer a Microsoft Word file to your device, some of the file's formatting may be
removed or changed, and the file extension is changed to .pwd (Pocket Word).

When this file is transferred back to the desktop computer, the file extension is converted
back to .doc, but any changed or removed formatting will still be lost. Therefore, if you
are using the Synchronized Files folder to transfer files and you want to preserve all for-
matting in the original document, keep a copy of the original file in another folder.

See ActiveSync Help for specific information on how file attributes are affected during
conversion.

NOTE: If you have password protection on an Excel or Word file on your device, you must first
turn off the password protection before the file is synchronized with the desktop computer. To do
so, open the file, select File, select Password, and clear the Password field.

Remote Synchronization

You can synchronize with your desktop computer while away from the office by connect-
ing to your network or directly to your computer via a modem attached to your computer.

Getting Help on ActiveSync

For additional setup, usage, and troubleshooting information, see online Help in the desk-
top computer by choosing ActiveSync Help Topics on the Help menu in the Mobile
Devices folder.

Calculator

Switching Between Views

You can switch between Standard (view full calculator) and Pop-Up (view entry box only)
views. If you are in the Standard view and want to display the Pop-Up view, cliflophe

Up button. To display the Standard view from the Pop-Up view, clicktaedard but-

ton.
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Using the Paper Tape

The paper tape appears on the left side of your Aero 8000 screen and displays the most
recent 100 lines of calculation. You can select a value from the paper tape, copy it, and
paste it into another program.

If you are entering a number that you have previously used in a calculation, and it appears
on the paper tape, you may use that information as a shortcut. Simply double-click on the
line of the paper tape containing the number and that number (and function, if necessary)
appears in the entry box.

You can clear all information from the paper tape by seleé&ditgy> Clear Paper Tape

Storing Numbers

The Calculator contains memory functions that allow you to store numbers. Clidk-the
button to activate the memory storage function. An M appears in the box to the left of the
entry box. If you store another number in memory, the system adds this to the number cur-
rently in memory.

To add the displayed number to the number already in memory, clibkthmritton again.
You can check the number in memory by clickingfe button. If you need to clear the
information in memory, cliceiC.

Calendar

Introduction

Use Calendar to schedule appointments, meetings, and other events. You can check your
appointments in one of several views (Day, Week, Month, Year, and Agenda) and set Cal-
endar to remind you of your appointments with a sound or other notification method.

If you use Schedule+ or Outlook on your desktop PC, you can synchronize Calendar
entries between your Aero 8000 and PC. For more informatiogysesronizing

Appointments

Appointments

Going to a Date

1. SelectGo>Go To Dateand pick a date.

2. Selectview->Day, Week, Month, or Year and select a date.
3. SelectGo>Go To Todayto go to the current day.
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Adding an Appointment
Selectrile>New Appointment.

N

Enter a description and a location.

w

Adjust the date and time, if necessary.

»

Click theNotesbutton to add appointment notes. Then click inNlbéesarea and
enter your notes.

5. Click theCategoriesbutton to assign an appointment to a category. Then select a cat-
egory from the list and select other desired options.

NOTE: To quickly add an appointment in Day view, click the time and enter the description. Enter
a location in parentheses if you want Calendar to recognize it as the location.

Adding or Deleting an All-Day Event
1. Selectrile>New All Day Event
2. Complete the information in the appointment card.

NOTE: To delete an all-day event, select View->Agenda, click on the event, and then select
Edit->Delete Item.

Setting a Reminder
1. Open the meeting or appointment.
2. SelecReminder.

3. Click the Reminder button (has a picture of a bell) and select how soon before the
appointment you want to be notified.

4. Click Reminder Optionsto change the notification type. The options available
depend on the device you are using.

Sending a Meeting Request

Before you can send a meeting you have scheduled, you must enter e-mail addresses in
Contacts and set up Inbox so that it can connect with the source of your e-mail. You also
must have a default e-mail service selected to send meeting requests.

1. Selecflools>Options and select an e-mail service from Mail transport list. If
you synchronize e-mail between your device and PC, select ActiveSync frivaithe
transport list.

Selectrile>Meeting.
Enter the description and location.
Select the date, time, and other information.

o r~ DN

Select the attendees' names and e-mail addresseQamiiact. The meeting request
is sent the next time you connect to your mail server.
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Finding an Appointment
1. Selecflools>Find.

2. Enter the search data (name, time, or other dakhdh If you have looked for this
item before, select its name from the list.

3. Verify Appointments (all) or Appointments (recurring only) is listedype.
4. Click Find Now.

Changing Appointments

Editing an Appointment
Double-click the appointment and make the necessary changes on the appointment card.
NOTE: To select an all-day event, switch to Day or Agenda view and open the event in the All Day

Events list. If you want to change the time duration in Day or Week view, select the appointment
and drag the upper or lower triangle to the desired time.

Editing the Recurrence Pattern
1. Select the This item occurs once list on the appointment card check box.

2. Choose a pattern from the list, or select Edit Pattern to open the Edit Pattern wizard
and create a new recurrence pattern.

3. Follow the steps in the wizard.

NOTE: To remove a recurrence pattern, click Remove Recurrence in the Edit Pattern wizard.

Moving an Appointment

In Day or Week view, drag the appointment to the new day or time slot. You may just want
to make changes to the appointment.

Adding Notes
1. Click the Categories/Notes button in an appointment card.

2. Click in the Notes area.
3. Selectiew and select an input method.
4. Enter your notes.

When you are in the notes area, the InkWriter input methods, formatting functions, and
editing functions are available to you. For more information)rde&'riter.
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Organizing Appointments

Changing Your Schedule's Design

1. Selectiew->Day, Week, Month, Year or Agenda

2. Selectview->Number of Daysin Day or Week view to set the number of days to dis-
play.

3. SelecView->Half-Hour Slots in Day or Week view to display half-hour time incre-
ments.

4. SelecWiew->Wide Day Viewin Day view to remove the month calendar and active
task list. Only appointment information displays.

Reordering Columns

You can reorder the columns by selecfiiogls>Customize Columns To add a field,
select it from thévailable fields list, and clickAdd. You can display up to 10 columns.
To remove a field, select it from tighow these fielddist and clickRemove To arrange
fields, select a field and clididove Up or Move Down. To restore the default fields, click

Reset

Changing Categories

Categories may be changed by seleckdg-> Category List. To add a category, enter it

in theNew categorybox, and clickAdd. To delete a category, select it in the list and click
Delete Items assigned to deleted categories keep their assignments. To restore the default
categories, cliclReset

NOTE: The categories you create in Calendar are also available in Contacts and Tasks.

Displaying a Subset of Your Schedule

1. Click theAll Items button. If you have used the filter before, the button displays the
name of the category you used last.

2. Select the category you want to display.

3. SelectAll Items to clear the category you selected in step 2 and to view all of your
appointments.

NOTE: If you do not see the All Items button, slide the gripper to the left.

4. If no categories appear in the list, you have not assigned appointments to any catego-
ries. Double-click an appointment, click the Categories button, and select the category

you want.
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Printing Appointments

Selecfile>Print.

Select the printing options you wantRnnter.
Select a start date and end date.

In Fields, select the type of information you want to print for each appointment.

a M DN

In Selection select to prinAppointments or Events To print your whole calendar,
selectAll Data.

NOTE: Port lists the available printer ports. If Network is selected from the Port list, enter the
path to the network printer in the Net Path box.

Changing Options for Calendar

SelectTools>Options and select your desired options.

NOTE: You can view the list of mail services available for sending meeting requests by selecting
Mail transport. To see features, such as notes or reminders, select Show icons and select the
icons to display. To view your appointment information in another font, click Choose Font... and
select desired options.

Synchronizing Appointments

Calendar items stored on your device can be synchronized with Schedule+ or Outlook on
your desktop PC. The Appointment synchronization service is automatically enabled in
ActiveSync.

New items entered on one computer are copied to the other during synchronization. When
you synchronize, typed notes from your device are added to your Schedule+ or Outlook
data, while handwritten notes and drawings are saved as metafiles (pictures) and added to
Outlook only. For specific instructions on setting up and using ActiveSyn&ysedro-

nization
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Contacts

Introduction

Contacts maintains a list of your friends and colleagues so that you can easily find the
information you're looking for, whether you're at home or on the road. You can enter both
personal and business information. If you use Schedule+ or Outlook on your desktop PC,
you can synchronize contacts between your Aero 8000 and PC.

Adding and Working with Contacts

Creating a Contact

1. Selecfile>New Contact
Enter the contact's name.

w N

Enter information in the appropriate fields.

e

Select the Business (displays the image of a briefcase) or Personal (displays the image
of a house) button and continue entering information in the appropriate fields.

You can assign a category or add a note to a contact by selecting the Categories/Notes but-
ton (displays the image of a note). Cliokher and select a field to add a field.

Updating a Contact

Updating a contact is as easy as double-clicking the contact in the contacts list and making
the change(s) to the contact card.

Duplicating a Contact Card

You can make a duplicate of a contact card while in the contact list by selecting the entry
and selecting:dit>Create Copy

Finding a Contact

1. Selecflools>Find.

2. Enter the name, phone number, or other data you want to find. If you have looked for
this item before, select its name from the list.

3. Verify Contacts appears Trype.
4. Click Find Now.
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Viewing Details about a Contact

Contacts contain details that you can view by opening the contact and selecting the Busi-
ness, Personal, or Categories/Notes button, depending on the details you want to view.
You can even sort the contact information to narrow your scope.

Sending a Message to a Contact

Before you can send a message to a contact, you must set up a connection to a mail server
and set up Inbox. Select one or more contacts to receive your message, but take note that
combined e-mail names are limited to 255 characters. Selels> Send Mail to Con-

tact and compose your message in Inbox. When you are done,s&ecsend

Transferring a Contact using Infrared

Using the infrared ports to send contacts gives you a quick way to exchange data. Select
the contact to send and line up the infrared ports. Séleet Sendand the contact trans-
fers. You can receive a contact by lining up the infrared ports and seledtirdReceive

Adding Notes

You can add notes to a contact card by clicking the Categories/Notes button and then
selecting the Notes area. Selémw and select an input method to begin entering your
notes. When you are in the notes area, the InkWriter input methods, formatting functions,
and editing functions are available. For more information]rge&friter.

Organizing Contacts

Sorting the Contact List

Select the heading of the column you want to sort by. The triangle in the column heading
indicates ascending or descending order. Select the heading again to reverse the order.

Reordering Columns

1. Selecflools>Customize Columns

2. To add a field, select it from tiwailable fields list and clickAdd. You can display
up to 10 columns.

3. Toremove a field, select it from tdow these fielddist and clickRemove
4. To arrange fields, select a field and selMote Up or Move Down.
5. To restore the default fields, cli@eset
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Changing Categories
1. Selectdit>Category List.
2. To add a category, enter it in thew categorybox, and clickAdd.

3. To delete a category, select it in the list and dlielete Items assigned to deleted cat-
egories keep their assignments.

4. To restore the default categories, citbset

NOTE: The categories you create in Contacts are also available in Calendar and Tasks.

Displaying a Subset of Your Contacts

1. Click the All Items button. If you have used the filter before, the button displays the
name of the category you used last.

2. Select the category you want displayed.
3. To view all of your tasks, select All Items to clear the category you selected in step 2.

NOTE: If no categories appear in the list, you have not assigned any contacts to categories. Open
a contact, click the Categories/Notes button, and select the category you want.

Printing Contacts

You can print contacts by selectiRge->Print and selecting the printing options you
want. SelecPort to list the available printer ports. If Network is selected from the Port
list, enter the path to the network printer in ket Path box.

Changing Options for Contacts

Change contact options by selectirapls>Options and selecting the desired options. All
of your contacts are recorded with the default country and area code you selected. To view
your contact information in another font, sel€ttoose Fontand select desired options.

Synchronizing Contacts

Contacts stored on your Aero 8000 can be synchronized with Schedule+ or Outlook on
your desktop PC. The Contact synchronization service is automatically enabled in Active-
Sync. New items entered on one computer are copied to the other during synchronization.
When you synchronize, typed notes from your handheld device are added to your Sched-
ule+ or Outlook data, while handwritten notes and drawings are saved as metafiles (pic-
tures) and added to Outlook only. For specific instructions on setting up and using
ActiveSync, se&ynchronization
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Inbox

You can send and receive e-mail by synchronizing with your PC, or by connecting to a
POP3 or IMAP4 server. Inbox contains an e-mail service for each method you use. For
example, if you receive e-mail through synchronization and through a connection to an
IMAP4 server, Inbox contains two services: ActiveSync and IMAP4 Mail. Each e-mail
service has its own folder hierarchy with four default folders: Inbox, Outbox, Deleted
(local), and Sent. The messages you receive and send through the mail service are stored
in these folders. You can also create additional folders within each hierarchy. For more
information, se&\Vorking with folders

When using synchronization, messages are directly or remotely synchronized between
ActiveSync service in the device Inbox and a PC using ActiveSync and Microsoft
Exchange or Microsoft Outlook. The ActiveSync service in the device Inbox has already
been set up for you. You can also copy individual messages using Windows CE Inbox
Transfer and Microsoft Outlook.

When connecting to a POP3 or IMAP4 server, you use a modem to connect to your Inter-
net service provider (ISP), or use a modem or Ethernet card to connect to the local area
network to which your mail server is connected. In addition to creating a connection to
your ISP network, you must create an e-mail service in Inbox.

Synchronizing E-Mail

How Inbox Synchronization Works

After enabling the Message synchronization service, e-mail messages are synchronized as
part of the general synchronization process. During synchronization:

» Messages are copied from the Inbox folder of Exchange or Outlook on your desktop
PC to the ActiveSync folder on your device. By default, you'll receive only the last
three days, the first 100 lines of each new message and no mail attachments or meeting
requests.

* The messages on the two computers are linked. When you delete a message on your
device, it's deleted from your desktop computer as well the next time you synchronize.

* Messages in the Outbox folder on your device are transferred to Exchange or Outlook
and then sent from those programs.

NOTE: Message synchronization with Microsoft Outlook Express is not supported. To use mes-
sage synchronization, your Aero 8000 device must have a single partnership with a desktop PC. If
you enable message synchronization and combine information, and then cancel the synchroniza-
tion service, messages can remain permanently out of date. To resolve this problem, first save
important files, delete the partnership icon, and then create a new partnership. Storing large
amounts of messages on your device lowers performance. Keep the number of messages in the
Inbox folder on your desktop PC as low as possible so less information downloads during synchro-
nization. For more information on synchronization, see Synchronization.
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Enabling Message Synchronization

The Message synchronization service is not automatically enabled. If you did not select
this service when you created the partnership with your device, you must enable it in
ActiveSync.

1. Disconnect your Aero 8000 from your desktop PC.

2. Open the Mobile Devices folder on your desktop PC and select your mobile device.
3. Selecflools>ActiveSync Options
4

SelectMessage under Synchronization Serviceshen clickOK. ActiveSync goes
though the Initializing Synchronization process, but actual synchronization does not
occur.

5. SelecflTools>ActiveSync Options
6. SelectMessagesOptions to set message synchronization options.

Now your messages are synchronized based upon your synchronization settings. Automat-
ically upon connection, automatically whenever messages are out-of-date, or manually
whenever you choosg&ynchronize Now For more information on synchronization, see
Synchronization

Copying Inbox Messages

You can use Windows CE Inbox Transfer to copy or move specific messages between
Exchange or Outlook and your Aero 8000, and you can move them into folders other than
the Inbox. Because the messages on the two computers are not linked, you can modify or
delete messages from one location without affecting the other.

You can also use this method to move messages to your desktop computer that you've
received on your device from other services, such as paging and faxing services.

To open Windows CE Inbox Transfer, open Microsoft Outlook on your desktop PC and
selectTools>Windows CE Inbox Transfer. Synchronize your messages to automatically
send messages from Outlook. For more information, see ActiveSync Help.

Connecting to a Mail Server

Setting Up a Mail Service

1. To connect to your POP3 or IMAP4 mail server, you need to set up an Inbox mail ser-
vice and a remote connection to the Internet or network to which the mail server is
connected. For more information on setting up a remote connectidResege Con-
nections

2. Get the following information from your ISP or network administrator: POP3 or
IMAP4 server name, SMTP host name, user name, password, and domain name (for
network connections only).

3. Open Inbox and selegervices>Options and select th&ervicestab.
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Click Add.

5. Select POP3 Mail or IMAP4 Mail from tt&ervice typelist. POP3 is the most com-
mon mail protocol for ISPs.

6. Enter a unique name for the service. This name cannot be changed later.
7. Click OK.
8. Follow the steps in the setup wizard.

Other malil protocols, such as the protocol used by AOL, are not supported. In addition,
services that use special authentication, such as MSN, are not supported. However, you
can gain access to the Internet through these services. There may be third-party programs
available that would enable you to send and receive mail through proprietary protocols.
Try searching the Web on the keyword "Windows CE" to find third-party programs for

your device.

If you use the same service to connect to different mailboxes, set up and name a different
service for each connection.

Setting Service Definitions

The Mail Service Setup wizard appears after you add a service. If you are adjusting the
settings of an existing service, sel8etvices>Options, select the service you are using,
and therProperties. In the Service Definition dialog box, complete the following entries
as needed:

1. Enter the name of the connection you created to connect the specified POP3 mall
server in th&€onnectionbox. If you are using a network (Ethernet) connection, select
Network Connection If you're not using a network connection and you haven't set up
a remote connection, selétteate new connectionin Remote Networking, create a
remote connection to use when connecting through the IMAP4 Mail service. For more
information on setting up a remote connection,Be@ote Connections

2. (POP3 only) Enter the name of the POP3 host mail server you use to receive and send
messages in trtOP3 Hostbox. For more information, contact the mail system
administrator when the mail account is created.

3. (IMAP4 only) Enter the name of the mail server you use to receive and send messages
in theServer box.

4. Enter the user name or mail box ID assigned to you by the mail system administrator
in theUser ID box.

5. Enter the password you use to access this mail accountfiaseevordbox. If you do
not want to be prompted to enter the password each time you conneciSaeéect
password

(Windows NT only) Enter your domain name in B@main box.

Enter the name in tH®MTP Host box if your mail service uses a separate server for
SMTP. For more information, contact the mail system administrator.
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8. Enter a return address in tReturn Addressbox. The default return address is user-
name@POP3host name or username@Servername.

9. Click Nextto continue.

Setting General Preferences

In theGeneral Preferencesdialog box, choose any of the following settings, all of which
are optional:

1. SelecDisconnect service after actions are performetb automatically disconnect
from the server upon completion of all pending actions. When you connect, all actions
are pending. This option minimizes connect time and cost.

2. Select the time interval (in minutes) at which you want the service to check for new
mail from theCheck for new mail everylist. If the two preceding options are both
turned off, then your device stays connected but you must check for new mail manu-
ally.

3. (POP3 only) Sele®isplay a messagbox when new mail arrives to be informed that
new mail has arrived.

(IMAP4 only) SelecPlay a soundto be informed that new mail has arrived.

5. (POP3 only) Sele@end using MIME format in order to send and receive an
extended character set. Using MIME may be necessary to correctly receive and dis-
play all of the letters of certain written languages.

6. To save space on your device you can choose to download messages from only the last
few days by selectin@nly display messages from the last 3 days

7. Click Next to continue.

Setting Inbox Preferences

In the Inbox Preferences dialog box, select the options that determine how you connect
and transfer messages. These settings are optional.

1. SelecGet message headers ontp save space and time by downloading only head-
ers. You can select which messages you want to read or download at a later time.

2. Set the message length (number of line&)ctude number lines of the message
body that you want to save in storage memory. The number of lines is approximate.

3. SeleciGet full copy of messagew receive the full copy of all messages. However,
selecting this option increases the amount of time needed to download messages.

4. SeleciGet meeting requestso download and store copies of meeting requests. This
option is available for Microsoft Exchange servers only, and the mail system adminis-
trator must enable the Microsoft Rich Text Format.

5. (POP3 only) Selecdet file attachmentsto download and save files attached to mes-
sages. Selecting this option may use significant RAM and take longer to download.

6. Click Finish.
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You can use the POP3 Mall service by select Services and selecting the POP3 Mail service
you created. Then seléservices>Connect To disconnect, sele®ervices>Connect
again.

Downloading Messages from the Server

When you download messages, you need to create two connections: a remote connection
and a mail server connection. The remote connection connects you to your ISP or net-
work. The mail server connection downloads messages from your mail server to Inbox on
your device. When you seleBervices>Connectin Inbox, Inbox starts a remote connec-

tion using the connection you specified when setting up the current mail service. If you are
already connected through a remote connection other than the one you specified in the
mail service, you are asked if you want to use the current connection. If you choose not to,
you must disconnect from the current connection before you can check for new messages.
For more information on setting up a remote connectionRse®te Connections

1. Select th&ervicesmenu and make sure that the service you want to use is selected
(has a bullet next to it).

2. SelectServices>Connect The messages on your device and mail server are synchro-
nized.

3. Selectile>Get Full Copy while in the message window if you read a message and
decide that you need the full copy. You can als@pices>Get Full Copy while in
list view. Receiving entire messages consumes storage memory.Salect
vices>Connectto disconnect when you are finished.

Reading and Responding to Messages

Downloading Messages

You can receive the full content for individual e-mail messages without changing settings
or options. Select the message and then se&wices> Get Full Copy. When receiving

e-mail from a remote service, you automatically receive message headers. To receive the
entire message, adjust the message length limit for that remote service. When synchroniz-
ing with your PC, you automatically receive up to 100 lines of a message. To make sure
you receive the entire message, change your options in ActiveSync. For more information,
see ActiveSync Help on your PC.

NOTE: Receiving entire messages drains memory.

Replying to or Forwarding a Message
1. Open the message.

2. SelectCompose>Reply to Sender Reply to All, or Forward.
3. Enter your response.
4. Click Send

Selections in the Options dialog box determine whether the original text is included.
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Adding the Sender to Contacts

Open the message and sel@ompose>Add Sender to Contacts A new contact card
opens with the sender’s name and e-mail address already entered. Enter other desired
information.

Checking Inbox Status

Check your Inbox status by selecti@gmpose> Status You can view details such as the
number of messages and attachments to be sent, deleted, copied, and downloaded the next
time you connect or synchronize.

Finding a Message
1. Selectrile>Find Message

2. Enter the name, text, or other data you want to find. If you have looked for this item
before, select its name from the list.

3. Select Mail Messages Trype.
4. Click Find Now.

Including the Original Message in a Reply

1. SelectServices>Options and select th€omposetab.
2. Selecinclude Body under Reply

3. Selectndent to indent the original message.

4. SelectAdd leading characterand add the character you want to add leading charac-
ters such as or * to the original message lines.

Enlarging the Message Font
1. Open the message you want to read.

2. SelectFile>Large Font.
3. SelecfFile>Large Font again to return the font to its original size.

Composing and Editing Messages

Composing and Sending a Message
1. SelectCompose>New Message

2. Enter the address of one or more recipients. If the recipient is listed in Contacts or
Address Book, enter a few letters of the recipient's name and Gelect
pose>Address Book

3. Selecfile>Attachments>Add Attachment to attach a file.

Click Send If you are working offline, the message moves to the Outbox folder and is
sent the next time you connect.
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Saving a Message

SelectFile>Saveto save the message you are composing or editing. The message is not
sent and is saved in the Inbox folder of the active service.

Saving Copies of Sent Messages
After mailing, messages are not saved on your device unless you select the following:
1. SelectServices>Options and select th€omposetab.

2. SelecKeep a copy sent mail in Sent folder

Address Book Options

Many mail servers, including Microsoft Exchange servers, have the ability to verify
names with an online address book, called a directory service, using LDAP (Lightweight
Directory Addressing Protocol). Inbox can use both a directory service and your Contacts
list to verify names you enter in the To, Cc, and Bcc boxes. When you create a mail ser-
vice, your mail server is added to the Address tab, and you are given the opportunity to
enable it. If you did not enable it or if you want to use additional services, follow these
steps:

1. SelectServices>Options>Address

2. Select which e-mail address field to check in Contacts imt@entacts, get
addresses fronlist. Contacts are checked first unless you chidaoke

Select the check box next to your mail server and €i€k
SelectAdd to add a directory service.
Enter the name of the service that stores the Address BookSeher box.

o o M w

Ask your network administrator if authentication is necessary for your server. If so,
selectAuthentication is necessary on this serveand enter a user ID and password.

7. SelectCheck name against this serveto have Inbox check this Address Book and
then clickOK.

To delete an Address Book, sel8etrvices>Options>Address Then select the Address
Book and clickRemove You can change an Address Book's settings by selegting
vices>Options>Address Then select the Address Book and ckekperties.

Changing the Address Book

1. SelectServices>Options>Address

2. Select which e-mail address list to check in Contacts fronmtB8entacts, get
address fromlist. Contacts is checked unless you sdi\smte

3. Select an Address Book in thstalled servicesbox.

To change an installed Address Book's settings, select the Address Book afdogick
erties.
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Messages

Moving or Copying a Message

CAUTION: When you move a message to your device, it and its attachments are permanently
deleted from the server. Depending on the line limit you have set, the complete message may not
be moved.

1. Select the message.

2. SelectFile>Move To or File=>Copy to.

3. Select the destination folder.

If you are working offline, the message is moved or copied from the server the next time
you connect.

Deleting a Message

1. Select the message and seff@let>Delete Messages are moved to the Deleted folder
and deleted when you disconnect from your mail service or exit Inbox.

SelectServices>Options and select thBeletetab.

Selectmmediately to have messages delete as soon as you EdkeeDelete The
Manually option holds deleted messages in the Deleted folder until you select
File>Empty Deleted Items

TheOn connect/disconnecbption holds deleted messages in the Deleted folder until you
disconnect from the server. To delete server messages, your Aero 8000 must be connected
to the server.

Emptying the Deleted Folder

Empty the Deleted folder by selectiRge->Empty Deleted Items This permanently
deletes messages in the Deleted folder. To check or adjust the current settings for deleting
messages, seleServices>Options and select thBeletetab.

Usually when a message is deleted from the Mailbox folder on your Aero 8000, it is
moved to the Deleted folder and removed from the desktop PC and device the next time
you synchronize. Deleting messages while synchronizing with your PC can result in mes-
sages becoming "stuck" in the Deleted folder on the device. Use the following steps to
permanently remove the message from your device:

1. Move the message from the Deleted folder to the Inbox folder.

2. Create a new folder.

3. Move the message from the Inbox folder to the folder you created.
4. Synchronize your Aero 8000 with your desktop PC.
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5. Open the folder you created and delete the message.
6. Selectile>Empty Deleted Items

Clearing Messages

When receiving mail from a remote server, sefatvice>Clear All. Memory space is
expanded on the device without actually deleting messages on the server. The next time
you connect, the messages are downloaded again.

Unmarking a Message

To unmark a message that is marked for download, move, or copy, double-click the
marked message.

Working with Meeting Requests

You must have Microsoft Outlook or Microsoft Exchange installed on your PC to use
meeting requests on your device. If you are using Exchange, your system administrator
must activate Rich Text Format on the IMAP or POP3 server. When using this format,
Inbox also downloads attachments. To save memory, attachments are deleted once they
are downloaded to your device unless you select the s@iinfjle attachmentsin the

Inbox Preferences dialog box.

Receiving Meeting Requests

To receive meeting requests from a remote server, you must select the Get meeting
requests setting in the Inbox Preferences dialog box. If you only receive message headers
and/or a limited number of lines per message, select the message arfeseiees> Get

Full Copy. You automatically receive meeting requests when you synchronize your

device with your PC.

NOTE: To receive message requests from a remote server, the remote server must use Microsoft
Exchange and be configured properly. For more information, see your system administrator.

Responding to a Meeting Request
1. Open the meeting request.

2. Select thé\ccept, Tentative, or Decline button. The response is sent the next time
you synchronize with your desktop PC or connect to a remote server.

Working with Message Attachments

Receiving Attachments

When synchronizing with your desktop PC, you must sétetide File Attachments
from the Inbox Synchronization Options box in ActiveSync. For more information, see
ActiveSync Help.
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You can receive attachments from a remote e-mail service by selecting theGettiihg
attachmentsin the Inbox Preferences dialog box. Embedded images and OLE objects
cannot be received as attachments but can be viewed as an attachment when using IMAP4
to receive e-mail.

Because ActiveSync is needed to convert file attachments, attachments received from a
remote server may not be converted to a file type that the device can display.

NOTE: If you receive the Error retrieving from POP3 server message, set the number of lines to
be downloaded to a higher number, such as 100 lines.

Checking Attachment Status

Any attachments sent with an e-mail message will be listed at the bottom of the message
in its own window. To hide this window, while viewing a message, sEllech Attach-
ments>Show Attachments

Attachments that have not been downloaded appear shaded. To mark an attachment for
downloading, double-click it. The attachment will be downloaded the next time you con-
nect or synchronize. To download the attachment immediately while connected, select
Services>Get Full Copy.

Opening an Attachment

With the message open, double-click the attachment's icon at the bottom of the e-mail
message.

Storing Attachments

1. SelectServices>Options and select th&toragetab.

2. Select to store messages on internal RAM or an external Compact Flash storage card.
3. Select your storage card from the list if you use more than one card.

Once you make the above selection, all e-mail messages are moved to the selected storage
card.

Deleting an Attachment
1. Select the attachment to delete an attachment from a message you are sending.
2. SelectEdit>Clear. To delete an attachment you have received, delete the message.

Attaching a File to a Message
1. Open the message.
2. Selecfile>Attachments>Add Attachment.

3. Select the file you want to attach.

NOTE: OLE objects cannot be attached to Inbox messages.
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Working with Folders

You can send or receive e-mail by synchronizing with your PC, or by connecting to a
POP3 or IMAP4 server. Each way of getting e-mail has it's own folder hierarchy. Each
hierarchy has three default folders: Inbox, Outbox, and Sent. You can create additional
folders within each hierarchy.

Messages received by synchronization are stored in the ActiveSync folder. Each time you
synchronize with your PC, messages are downloaded into the Inbox folder and sent from
the Outbox folder. Other folders you create on your device are not synchronized.

Messages or message headers received from a POP3 server are stored in a folder that bares
the same name you entered for the service when you created it. Each time you connect and
disconnect from the server, messages are downloaded into the Inbox folder and sent from
the Outbox folder. The server ignores other folders you create on your device.

Messages or message headers received from an IMAP4 server are stored in a folder that
bares the same name you entered for the service when you created it. IMAP4 folders work
differently than POP3 folders. Each time you connect and disconnect from the server,
messages are downloaded to the Inbox folder and to any other folders you have created
and marked as Offline. If you do not mark a folder as Offline, you will only be able to read
and respond to messages in that folder when you are connected to the server. Messages are
sent from the Outbox folder when you connect and disconnect from the server. If you have
opted to save sent messages, they are stored in the Sent folder.

Creating a Folder

1. Selectrile>Folder>New Folder.
2. Type a name for the folder.

Renaming a Folder

1. Select the folder you want to rename.
2. Selectile>Folder>Rename Folder
3. Type the new name for the folder.

NOTE: You cannot rename default folders such as Inbox, and folders you create for IMAP4 mail
Servers.

Deleting a Folder

1. Select the folder you want to delete.
2. Click theDeletebutton.

NOTE: You cannot delete default folders such as Inbox.

Windows CE 5 - 25



Designating a Folder as Offline

Only IMAP4 folders can be designated as offline. Select the folder you want to designate
as offline, and sele&ervices>Offline Folder. If a folder is not designated as offline, you

are only able to read and respond to messages in that folder when connected to the server.
All IMAP4 default folders, such as Inbox, are automatically designated as offline.

Synchronizing Folders while Connected

When you connect to your desktop PC or to a POP3 server, the Inbox and Outbox folders
on your Aero 8000 are synchronized with the corresponding folders on your PC or POP3
server. To synchronize after the initial connection, s8ectices>Send/Receive Mail

When you connect to an IMAP4 server, Inbox, Outbox, and all folders marked as offline
are synchronized. To synchronize after the initial connection to a server,Smtect
vices>Synchronize Folders

InkWriter

Introduction

Using InkWriter with Rich Ink technology, you can write or draw on the screen, or type
using the keyboard. You can also edit and format what you've written or drawn. When you
write on the screen, you can apply formatting, such as bold and italic, to the words you
write. When you draw, you can resize and reshape the drawing and group it with other
drawings. If you do not see a menu or toolbar button, move the gripper to the left to see
more buttons or to the right to see more menus.

Creating and Managing Documents

Creating a Document
1. Selectrile>New
2. SelecDocumentor Document from Template

3. If you want to draw, selediew->Drawing and use the touch pad to draw. To type,
selectView->Typing.

4. When finished, sele&ile>Save

You can also create a drawing in Writing view by crossing three ruled lines on the first
stroke of the drawing.

5 - 26 Windows CE



Creating a Template

Selectfile>New.

Enter a format text for the template.
Selectfile>Save As

Enter a name for your template in ti@me box.
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Select InkWriter Template (.pdt) in thgpe box.
You can also select a predesigned template Fider> New->Document from Template

Selecting a Page Style

Selecflools>Options>and select thPage Styletab. Select one of the four page styles to
use in Writing view.

To view text against a yellow background, seMattow background. While in Typing
view, no lines display. While in Drawing view, a grid pattern is always display¥dl-If
low Background is selected, the background is yellow in all views.

Adjusting Saving Options

SelectTools>Options and select th8avetab. Select desired options.

Iransferring a Document using Infrared

To send a document, open the document, line up the infrared ports, an&is=eSend
To->Infrared Recipient. To receive a document, open Windows Explorer, line up the
infrared ports, and seleEtle>Receive

E-mailing a Document

If an e-mail program is installed on your device and the program supports attachments,
open the document and selede->Send To>Mail Recipient. The e-mail program opens

and the InkWriter document is automatically attached to the message. For more informa-
tion, sednbox.

Editing Documents

Finding Typed Text in a Document

1. SelectEdit>Find in Typing view.

2. Enter the text you want to find.

3. Select desired search options and dhicid Next.
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Replacing Typed Text

SelectEdit>Replacein Typing view.

In theFind what box, type the text you want to find.

In theReplace withbox, type the replacement text.

Click Find Next.

Click Replaceto replace individual instances, Replace allto replace all instances.

a M DN

Selecting Text and Drawings

You can select text in Typing view by selecting or clicking and dragging the cursor across
the text. To select text in Writing view, click tBelectbutton and drag the cursor across

the text you want to select. To select a drawing in Drawing view, clicBelectbutton

and draw a box around the area of the drawing you want to select.

Select a drawing in Typing or Writing view by selecting the drawing. To select a word
while typing, double-click anywhere in the word. To select a paragraph while typing, tri-
ple-click anywhere in the paragraph.

Zooming In on Text and Drawings

From any view, seledfiew->Zoom and select a percentage. You can enter an exact per-
centage by selectingiew->Zoom->Custom, and enter a percentage in #wom box.
Wrapping Text to Screen

From any view, seledtiew->Wrap to Window. Notes wrap to a six-inch width when
Wrap to Window is not selected.

Viewing Full Screen

From any view, seledtiew->Full Screen To use the toolbar, seldgestoreat the bottom
of the screen.

Formatting Text

Creating Bulleted Lists
From Typing view:

Click the Bullets button.
Type the first item.

w N

Pres€NTER, type the next item, and repeat as needed.

B

Click the Bullets button again to end the list.

5 - 28 Windows CE



From Writing view:

1. Write a list of items.

2. Click the Select button, and select the list.
3. Click the Bullets button.

Selecting a Different Font or Style
Select the text in Writing or Typing view.

no

Selectrormat->Font, Ink, Drawing....

w

Select desired options.

»

SelectSet as Defaultto set the new font and/or style as the default for all new docu-
ments. To apply the default font and style to selected text, sgipbt Default.

5. Select a new line thickness from ten Weightlist. You can also select a new line or
font color from theLine Color list.

Changing Font Formatting

Select the desired text in Typing or Writing view and click the Bold, Italic, or Underline
button.

To change the color of the text, selEotmat->Font, Ink, Drawing... and select the color
you want from the.ine Color list.

Adjusting the Paragraph Alignment

Select the paragraph whose alignment you want to change in Typing or Writing view and
then select the Align Left, Center, or Align Right button. To see more formatting options,
selectFormat->Paragraph.

Indenting a Paragraph

Select the paragraph or paragraphs you want to indent in Typing or Writing view and
selectFormat->Paragraph. Adjust the indentation settings as needed.

Formatting Drawings

Correcting a Drawing's Shape

It's not always easy to draw the perfect rectangle, circle, triangle or straight line. Use Ink-
Writer's Shapes command to make your drawings more precise.

1. Selectview->Drawing and create a drawing with the basic shape you want.
2. Select the drawing.

3. SelectFormat->Shapes

4. Select desired shape.
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Aligning a Drawing

To align drawings together, select two or more drawings and use one of the following
commands:

» To align drawings to the left of the selection area, select the Align left button.

» To align drawings to the right of the selection area, select the Align right button.

» To align drawings to the top of the selection area, select the Align top button.

» To align drawings to the bottom of the selection area, select the Align bottom button.

NOTE: The above buttons become active once you select two or more drawings.

Centering a Drawing

To center drawings on a vertical or horizontal axis, select two or more drawings and use
one of the following commands:

* To center drawings vertically in the selection area, select the Center Vertically button.

» To center drawings horizontally in the selection area, select the Center Horizontally
button.

NOTE: The above buttons become active once you select two or more drawings.

Changing the Layered Order of Drawings

Select two or more drawings and then use one of the commands below:

* To bring a drawing to the top of the stack, sefemimat->Bring to Front.

» To move a drawing to the bottom of the stack, sétectnat->Send to Back

* To bring a drawing up one level in the stack, sdfectmat->Bring Forward .

* To move a drawing back on level in the stack, séteatnat->Send Backward

Grouping Drawings

Select two or more drawings and click the Group Objects button. This button becomes
active once you select two or more drawings. To ungroup drawings, select the drawings
and select the Ungroup Objects button.

Changing Line Thickness and Color

1. Select the drawing.

2. Select the Font, Ink, Drawing button.

3. Select a thickness from tRen Weightlist.
4. Select a color from thieine Color list.
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Filling a Drawing with Color
1. Select the drawing.
2. Select the Font, Ink, Drawing button.

3. Select a color from theill Color list.

Printing Documents

Selectrile>Print and select the printing options you waart lists the available printer
ports. If Network is selected from tiRort list, enter the path to the network printer in the
Net Path box.

Changing Options for InkWriter

SelectTools>Options and select th&eneral tab. Then select desired options. To auto-
matically scroll when needed, sel&aroll upon reaching last line

Setting a Password for a Document

1. Selectrile>Password

2. Type and verify the password.

3. Selectile>Saveto retain the password.

You cannot synchronize documents that are password protected. You must remove the
password protection in the appropriate program on your PC or device, and then synchro-
nize. Once synchronized, you can reset password protection.

Synchronizing Documents

Documents are synchronized using the File synchronization service in ActiveSync. The
service is enabled automatically. Documents on your device are automatically synchro-
nized with documents in a folder on your desktop computer named device
name_Synchronized Files.

You can view documents in this folder by double-clicking your device icon in the Mobile
Devices window. This folder is stored in one of the following locations:

* Windows 95: My Documents\device hame_Synchronized Files

* Windows NT: WINNT\Profiles\your username\Personal\device name_Synchronized
Files

ActiveSync converts documents during synchronization. For more information on docu-
ment conversion, see ActiveSync Help on your desktop PC. If you mark a document as
hidden on your desktop, the document is deleted from your device the next time you syn-
chronize. When you delete a document on either your desktop computer or your device,
the document is deleted in the other location the next time you synchronize.
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Pocket Access

Introduction

Microsoft Pocket Access is a companion program that contains Microsoft Access features
that are essential for mobile professionals. You can synchronize information from Access,
SQL Server, and other ODBC databases with Pocket Access on your device. Access files
(.mdb) and SQL Server database (or other ODBC database) information is converted into
a Pocket Access (.cdb) file. While on the road, you can update and query data in the corre-
sponding tables. Once you return home or back to the office, synchronize the new infor-
mation with the data accessed from your PC.

You can also create databases on your device while you are away and synchronize the
information with your PC when you return. During synchronization, Pocket Access files
(.cdb) are converted to Access files (.mdb). Pocket Access databases are limited to 65,536
records.

The Windows CE Store enables you to store tables and SQL procedures created on your
device without creating a database. To view information located in the Windows CE Store,
selectFile>Recent Files>Windows CE Store Tables located in the Windows CE Store
cannot be synchronized with your PC. However, you can copy the information from your
device to your PC.

Pocket Access Help explains the features and procedures for using Pocket Access as it is
sold with your device. However, programmers can use Microsoft ActiveX Data Objects

for Windows CE (ADOCE) and Microsoft Visual Basic or Visual C++ to develop custom
database solutions. For more information,\8@sv.microsoft.com/windowsce/

Synchronizing and Copying Pocket
Access Information

Introduction

Databases are synchronized using the Table synchronization service in ActiveSync. The
service is not enabled automatically. Once you have enabled Table synchronization, select
which tables and fields you want to synchronize. If you want to make sure you don't
change information as you're viewing it on your mobile device, you can set tables to be
"Read-Only" on your Aero 8000.

ActiveSync converts presentations during synchronization. For more information on pre-
sentation conversion, see ActiveSync Help on your desktop PC.
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Enabling Table Synchronization

Databases are synchronized through the Table synchronization service. The service is not
automatically enabled. If you did not select this service when you created the partnership
with your device, you must enable it in ActiveSync. Use the following steps to enable syn-
chronization:

0N

Disconnect your Aero 8000 from your desktop PC.
On your PC, open the Mobile Devices folder and select your mobile device.
Click Tools>ActiveSync Options

Click Table and then click OK under Synchronization Services. ActiveSync goes
though the Initializing Synchronization process, but actual synchronization does not
occur.

Once you have selected which databases on your PC or mobile device you want to
synchronize, your files will be synchronized during ActiveSync, or whenever you
choose Synchronize Now.

Synchronizing PC Database Information

1.
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On your PC, open the Mobile Devices folder and select your mobile device.
Click Tools>ActiveSync Options

Select Table and click Options.

Click Add in the Database Synchronization Options dialog box.

Double-click the database you want to synchronize. To synchronize information other
than Access database information, select ODBC Database from the File of Type list.
An ODBC database must already be set up as an ODBC data source.

Select the tables and fields you want to synchronize in the Import from Database to
Mobile Device dialog box.

Click the plus sign (+) to view individual fields within a table or to mark the table as
Read-Only.

NOTE: If you do not want to synchronize only certain tables and fields, or set tables as read-only,
drag and drop the Microsoft Access database file into the Mobile Devices folder. This option is not
available with Microsoft SQL Server databases.
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Adjusting Synchronization Options for PC Databases

On your PC, open the Mobile Devices folder and select your mobile device.
Click Tools>ActiveSync Options

Select Table and click Options.

Select the database and click Remove to stop synchronizing a database.
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Select the database and cliioperties>Browseto change the location of the data-
base on your PC.

You can change other properties by removing the database and adding it with the new
properties. By clicking Default in the Import from Database to Mobile Device dialog box,
you can quickly select all tables and fields within a database.

To stop synchronizing a database for a short period of time, you do not need to remove it
from the Database Synchronization Options dialog box. Instead, clear Keep tables syn-
chronized in the Import from Database to Mobile Device dialog box.

Synchronizing Mobile Device Database Information
1. Onyour PC, open the Mobile Devices folder and select your device.
2. Double-click the My Documents folder.

3. Drag and drop the database onto your PC desktop. ActiveSync converts the informa-
tion and places it in the /Program Files/ActiveSync/Profiles/device name folder. The
file is named Dbx.mdb.

To synchronize information to another type of database other than an Access database,
click Browse in the Export from Mobile Device to Database dialog box. Select the data-
base and select ODBC Database in the File of Type list. An ODBC database must already
be set up as an ODBC data source.

Database information is synchronized when using ActiveSync or when you choose Syn-
chronize Now.

NOTE: If you do not want to synchronize only certain tables and fields, or set tables as read-only,
drag and drop the Microsoft Access database file into the Mobile Devices folder. This option is not
available with Microsoft SQL Server databases.

NOTE: You do not have to specify a database or database location when synchronizing tables and
SQL procedures in the Windows CE Store.

Copying Windows CE Store Information

On your PC, clicklfools>Export Database Tables

Clear the check mark beside any table you do not want to copy. The table synchronization
service does not need to be enabled. Information copied to the PC is converted by Active-
Sync, but it is not synchronized.
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Working with Databases

Creating a Database

By default, Pocket Access database files are stored in the device name\My Documents
folder. If you save the database files in another location on your Aero 8000, ActiveSync
does not know where to look for the file when you synchronize. Adjust the synchroniza-
tion options for PC databases in ActiveSync to reflect the location.

If you create tables and/or SQL procedures before creating a database, the system moves
this information to the Windows CE Store.

NOTE: You cannot delete a database from Pocket Access. Delete the database from Windows
Explorer.

To create a database, follow these steps:

1. Selectrile>Open/New Databaseavhile in Database view.

2. Enter a name for the database.

3. Create any necessary tables or SQL procedures.

Opening a Database

Once you have created a database, you can open it by selglgibblew Database
while in the Database view. Double-click the database you want to open and the system
opens the information.

Printing Data

You can print data by selectifgle->Print while in the Table view. Column widths you
set in Datasheet view determine the column widths of printed data.

Working with SQL Procedures

Introduction

The Find and Filter commands are fast and easy ways to locate and organize information
based on one field. Using the Sort command, you can sort information based on more than
two fields only if those fields are adjacent to each other. To develop more complex que-
ries, you must create an SQL procedure. SQL (Structured Query Language) is the com-
puter language Pocket Access uses to compute search and filter requests. When you use
the Find, Sort, and Filter commands, Pocket Access generates the SQL procedure for you.
Pocket Access supports only a subset of the SQL language.
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Using the SQL View

The Edit pane, located under the SQL Address bar in SQL view, displays the last SQL
procedure run by Pocket Access. If you have used the Find, Sort, or Filter commands, the
generated SQL procedure displays. You can edit and/or create new SQL procedures in the
Edit pane.

The List pane, located under the Edit pane, includes the last 15 SQL procedures that have
successfully run from the SQL window since you started Pocket Access. SQL procedures
listed in the List pane are not automatically saved.

NOTE: Even if you haven't used the Find, Sort, or Filter commands, you may see an SQL proce-
dure in the Edit pane. Even opening a table or switching from Datasheet view to SQL view gener-
ates a simple SQL procedure.

Creating an SQL Procedure

You can create a new SQL procedure from within the SQL view. Simply select Create new
procedure from the Address bar and enter the SQL procedure in the Edit pane. Save the
procedure by selectirfgle->Save Procedure

Running an SQL Procedure

While you are in the Database view, running a query is as simple as selecting SQL Proce-
dures and then double-clicking the procedure you want to run. Results display in the
Datasheet view.

Renaming an SQL Procedure

If you need to rename a query, access the Database view. Select SQL Procedures and
select the SQL procedure. Selgdit->Rename ProcedureEnter the new name in the
To box.

SQL Reference

Pocket Access supports a subset of the SQL language. The following SQL reference lists
the code that can be used in Pocket Access SQL procedures, and any limitations. If you
are new to using SQL or need more information, see Access Help on your PC.

SELECT statement
SELECT fieldlist
FROM tablename

To sort data from more than one table, use an INNER JOIN operation. You can use double
or single quotes to delimit field names that contain spaces or special characters.

ORDER BY clause
SELECT fieldlist
FROM tablename
ORDER BY fieldname [ASC | DESC][, fieldname2 [ASC | DESC], ...]
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To sort data from more than one table, use an INNER JOIN operation. You can include up
to four fields with the ORDER BY clause; however, you cannot use fields with a Binary
data type in the ORDER BY clause.

WHERE clause
SELECT fieldlist
FROM tablename
WHERE criteria [AND | OR criteria]
The criteria expression can include:

* [NOT] fieldname comparison operator value
» fieldname IS [NOT] NULL

» fieldname IS [NOT] TRUE

» fieldname IS [NOT] FALSE

» fieldname IS [NOT] LIKE "string%"

To sort data from more than one table, use an INNER JOIN operation. Implied join opera-
tions using the WHERE clause are not supported. The LIKE statement matches only string
constants followed by a wildcard. The string may be empty or null. Valid comparison
operators for the WHERE clause are: "=", "<", ">", "<=" ">=" or "<>",

INNER JOIN operation
SELECT fieldlist
FROM tablel INNER JOIN table2
ON tablel.field1l = table2.field1
[(] INNER JOIN table2
ON tablel.field2 = table2.field2[)] ...

You must use the above INNER JOIN syntax. Outer join and implied join operations are
not supported. Up to four tables can be joined. When using an INNER JOIN operation,
only the equality comparison operator (=) is supported and at least one of the tables in
each INNER JOIN operation must be indexed on the joined field.

The results of an INNER JOIN operation created using a fieldlist that contains fields from
only one table is updateable. All other INNER JOIN operations create read-only results.

DELETE statement

DELETE *
FROM tablename

[WHERE criteria]

INSERT INTO statement

INSERT INTO tablename [fieldlist]
VALUES (valuel[, value2 ...])
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You cannot insert data into fields with a varbinary or long varbinary data type. When any
field in the table is a varbinary or long varbinary data type, you must provide a list of
fields.

CREATE TABLE statement
CREATE TABLE tablename
(fieldname datatype][, fieldname datatype ...])

Each table in a database or the Windows CE Store must have a different name. The CRE-
ATE TABLE statement offers different data type choices than Design view. See the table
below for a list of valid data types, and notes detailing any unique characteristics these
data types have in Pocket Access.

Table 9: Valid data Types

Data Type Notes

Varchar[(n)] A null-terminated character string of
length n. Maximum length is 255 charag
ters. If n is not specified, the length will he
one character.

Text A variable length string that can hold up|to
32,733 characters.

Varbinary[(n)] A binary value of less than 256 bytes. If n
is not specified, the size will be 1 byte.
This data type is called Binary in Design

view.

Long Varbinary A binary value up to 65,469 bytes in size.
This data type is called OLE Object in
Design view.

Integer or int A 4-byte signed integer.

small int A 2-byte signed integer.

float A double-precision floating point number.

datetime Automatically formats date and time.

bit A logical or Boolean value (0 equals false

and non-zero equals true).
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ALTER TABLE statement
ALTER TABLE tablename
TO tablename?2
| ADD fieldname datatype [BEFORE fieldname2]
| DROP fieldname
| MOVE fieldname [BEFORE fieldname2]
| RENAME fieldname TO newfieldname

NOTE: The last field in a table cannot be dropped.

CREATE INDEX statement
CREATE INDEX indexname ON tablename
(fieldname [ASC | DESC] [CASESENSITIVE] [UNKOWNFIRST])

You can sort capital letters after lower case letters by using the CASESENSITIVE
attribute. To display fields with null (empty) values at the start of the resulting table, use
the UNKOWNFIRST attribute.

The CASESENSITIVE and UNKNOWNFIRST attributes are unique to Pocket Access
and other databases created for your mobile device. These attributes may not be supported
in other database systems.

CREATE DATABASE statement
CREATE DATABASE databasename
DROP statements

Table 10: DROP Statements

Statement Action
DROP TABLE tablename Drops a table.
DROP INDEX Drops an index.
tablename.indexname
DROP DATABASE Drops a database.
databasename
ALTER TABLE tablename Drops a field.
DROP fieldname
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Working with Tables

Creating a Table

Review the type of data, size of the field, and whether to sort the information before you
attempt to create a table. Pocket Access cannot display certain types of information such
as images and OLE objects. Any fields not interpreted by Pocket Access are assigned the
Binary or OLE Object data type during synchronization. If all the fields contain informa-
tion Pocket Access cannot interpret, the table cannot be synchronized between your desk-
top PC and the Aero 8000.

You can create a table by following these steps:
1. Double-click the Create a new table icon while in Database view.

NOTE: Tables created on your Aero 8000 must be created using the Create a new table icon or by
using the CREATE TABLE syntax in an SQL procedure.

2. Enter a name for the field in tRé&eld Namebox. The table name cannot be more than
31 characters long.
3. Select a data type from tBata Typelist.

NOTE: You cannot change a field's data type after you save the table.

4. Enter an amount in tHéeld Sizebox to set the size limit of a field. The default size is
50 characters.

NOTE: You cannot change a field's size after you save the table.

5. Select Yes from thimdexed list to index the field. Select Ascending or Descending
from theSort list. You can use indexing to find and sort information faster for that
field.

6. Repeat these steps until you have created all the fields you want for your table.
7. SelecfFile¢ Save Tableto save the table.

About Data Types

When creating a table, keep in mind that using the Text data type limits you to a size limit
of 255 characters. You can enter longer notes by selecting the Memo data type. You can
enter numbers with decimal points by using the Float data type. The Integer data type
allows you to enter numbers between -32,768 and +32,767. To enter smaller numbers,
select the Small Integer data type.
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The Binary and OLE Object data types denote place holders for certain types of informa-
tion Pocket Access cannot display, such as images and OLE objects. Data up to 255 bytes
is synchronized with a Binary data type, and data from 255 bytes to 64K is synchronized
with an OLE Object data type.

NOTE: You cannot change a data type once a table is saved.

If you are aware that Pocket Access cannot interpret a certain field, you can select to not
synchronize that field within a given table. This process decreases the time it takes for
your Aero 8000 to synchronize with your PC. For more informationSgeehronization

Adding Data

You can add data while in either the Database or Tabular views. While in the Database
view, double-click the table's icon. If you are in Tabular view, move to the empty row at
the bottom of the table. You are now ready to enter data in the appropriate fields. The sys-
tem saves any new data upon leaving the table or switching to another view.

Reordering Fields

You can reorder fields within a table by following these steps:
1. Access the Database view.

2. Select the table and sel&teéw->Design View

3. Select the box to the left of the field you want to move.

4. SelecEdit>Move Field Up to move the field up or selegtdit->Move Field Down
to move the field down. The field moves within the data list.

Renaming a Table

Pocket Access allows you to rename a table while in the Database view. Select the table
and clickEdit>Rename Table The present name for the table appears ifrtbe box.
Enter the new name in tA® box and clickOK.

Deleting Data

If at any point you need to delete a table, field within a table, record, or SQL procedure,
Pocket Access provides you with a quick deletion function. Pocket Access displays a mes-
sage warning that you are deleting information before completing any deletion.

To delete a table or SQL procedure, simply select the item within the Database view and
click Edit>Delete Tableor Edit>Delete Procedure You can delete a field while in the
Design view by selecting the field and clickiBdit->Delete Field If you want to delete a
record, access the Table view and select the record. &eli¢etDelete Recordand

Pocket Access deletes the information. If you are in SQL view, you can delete information
by selecting the data and then seleckialt > Clear.
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Viewing Data

Once you have created a table or SQL procedure, you can view the data in a number of
ways as well as customize what you are viewing.

Using the Address Bar

The Pocket Access Address bar is similar to the Address bar in Windows Explorer. While
in Table, Design, or SQL view, Pocket Access displays the present table or SQL procedure
in the Address bar. To change the displayed information, select the arrow at the far right of
the Address bar and select a new table or SQL procedure.

Displaying Different Views
You can view Pocket Access information in a number of different views.

Table 11: Viewing Pocket Access Information

Select Function

View->Database View View all tables and queries contained
within a database.

View->Display-> Split View the table in Form and Tabular format
at the same time.

View->Display->Form View the table as a form.

View->Display-> Tabular View the table in Tabular format.

View->Design View View a table’s design for editing.

View->SQL View View an SQL procedure to add or edit &
query.

Hiding Columns in Tabular Format

You can hide any columns appearing on your table. While in the Tabular view, hide a col-
umn by selecting the column and clickidggw->Column->Hide. If you want to reveal a
hidden column, sele&tiew->Column-Unhide.

Hiding Gridlines in Tabular Format

Hide gridlines by selectingiew->Column->Gridlines. If a check appears next to Grid-
lines, the lines appear. If the check is absent, the lines are hidden.

Zoom In on Data

The zoom feature in Pocket Access allows you to "zoom in" or increase the view of the
information on your screen. To zoom in, seMieiwv>Zoom-the desired percentage. You
can manually enter a percentage by seledfiegy>Zoom->Custom.., and enter a per-
centage in th&oom box.
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Editing Data

Selecting Data

Before you edit any data within a table or SQL procedure, you must select the informa-
tion. To select a column within a table, select the column header. To select a row, select the
row header to the left of the field name. You can select all data by selEditrgSelect

All Records. To select data in a field or SQL statement, click and hold the cursor across
the desired data to highlight the information.

Editing Data in a Field

Data within a field also may be edited. Simply select the data you want to edit while you
are in the Table or SQL view. Selé&udit >the desired action.

Pasting Data into Pocket Access Files

Pocket Access allows you to paste data from within tables, spreadsheets, or documents
into a table of SQL procedure. Open the desired table, spreadsheet, or document and select
the data for copying. SeleEdit->Copy. Instead of copying the information, you can cut

or remove it from its current location. Select the information and getkicd Cut. Open

the desired table in Pocket Access and select where you want to paste the information.
SelectEdit>Pasteto add cells or rows to the end of the table or s@ditt> Paste

Append Recordto add cells or rows in the middle of a table.

NOTE: If the information you are pasting into Pocket Access contains more columns than the
table, the extra column information is ignored. In addition, you cannot paste information into a
field with an incompatible data type. For example, text data cannot be pasted into a field with an
integer data type.

Pasting Data into Other Files

You can copy or cut information from Pocket Access and paste it into other tables, spread-
sheets, and documents. Open the desired table and select the data you want to copy. Select
Edit->Copy to copy the information or selegtlit>Cut to remove the information to

place in another area.

Open the file and select where you want to paste the information. BdleetPasteand
the information appears in the new location.
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Finding Data

About Finding and Sorting Data

There are a variety of ways to locate and organize information using Pocket Access. Use
the Find, Filter, and Sort commands to look for specific information in a field. The Find
command locates specific information you want to view and moves the insertion point to
the matching data. The Filter command displays only certain data within a table. Both
Find and Filter can be used on only one field at a time. Use the Sort command on two or
more adjacent fields to arrange data in alphabetical or mineralogical order.

If you want to search for information based on more than one field, you will need to create
a query, or SQL procedure, using an SQL statement. For more informatiddodeeg
with SQL Procedures

Finding Data

Data may be hard to find in even the simplest of tables. You can perform a quick search by
using the following steps while in the Datasheet view or you can create a more complex
search using an SQL procedure:

1. SelecRecords>Find.
2. Enter the data you are searching for inRim&l what box.

3. Select the field you want to search fromltek In list. You can select All Fields and
Pocket Access searches all available fields.

4. Select Whole field in th®latch list to search for an exact match. For example, "Will"
finds "Will" but not "William"; OR

Select Beginning of field in thiglatch list to match only the first part of the field. For
example, "12" finds "120" but not "1512".

NOTE: If you began your search in the middle of the table and you want to search the entire
table, select Start from Top.

5. Click Find. To find another match, seldRecords>Find Next.

Replacing Data

You can replace any data within a table by using the following steps while in the Datasheet
view:

1. SeleciRecords>Replace

2. Enter the data you are replacing in Eed what box.

3. Enter the data you want to replace the old data iRépace withbox.
4

Select the field you want to search fromltbbek In list. You can select All Fields and
Pocket Access searches all available fields.
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5. Select Whole field in th®latch list to search for an exact match. For example, "Will"
finds "Will" but not "William" OR

Select Beginning of field in thiglatch list to match only the first part of the field. For
example, "12" finds "120" but not "1512".

NOTE: If you began your search in the middle of the table and you want to search the entire
table, select Start from Top.

6. ClickFind.

To replace another match, selBecords>Find Next.

Sorting Data

In Datasheet view, select the fields you want to use for sorting records. When selecting
more than one field, the fields must be adjacent to each other. In addition, when two or
more adjacent fields are selected, they are sorted left to right unless you select them in a
right-to-left order. You can create more complex sorts by developing an SQL procedure.

To sort in ascending or descending order, s&ecbrds> Sort Ascendingor
Records>Sort Descending

Filtering Data

Filtering data allows you to pinpoint the exact information you want to result from your
Pocket Access. You can attach a filter while in the Datasheet view.

1. SelecRecords>Filter and select the field you want to filter from tReld list.
2. Enter the name on which you want to run the filter fron\vélae box.

3. Click Run Filter and Pocket Access runs the filter for results. The filter displays all
the data that matches your filter criteria. If you want to display data that does not
match your criteria, sele&ixclude these valuesYou can also choose to show all
records in the table by seldRécords> Filter >Show All.

NOTE: If you want to create more complex filters, you must develop an SQL procedure.

Pocket Excel

Introduction

You can use Pocket Excel much the same way as you use Excel on your PC. You can enter
formulas and functions, and then filter data to see the subset of information you want.

Split panes so that you can view labels appearing at the top and/or left edge of a sheet. You
can also freeze the top and left-most panes in a worksheet to keep row and column labels
or other data visible as you scroll through a sheet. For more informatidéntsgesg and

Locating Data
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Entering and Locating Data

Inserting Cells, Rows or Columns

Select the location where you want to insert cells and deteotat->Insert Cells. In the
Insert box, select how you want the cells, rows, or columns inserted. To insert more than
one row or column, select the same number.

Going to a Cell

You can access any cell by selecfimgpls>Go To and typing the cell reference (example:
C4). If the cell has a defined name, you can type the name instead of the reference. To go
to the cell or range currently selected, in the dialog box, elecent Region.

Entering a Value in a Cell

Enter a value in a cell by first selecting the cell into which you want to enter information.
If the cell is not visible, seledbols>Go To, type the reference (example: A4), and click
OK. Type the value and preBSNTER or select another cell.

Entering Text

Enter text by selecting the cell. If the cell is not visible, sélleots>Go To, type the ref-
erence (example: A4), and cli€K. Type the text and preEBNTER. The text is auto-
matically left aligned.

Automatically Entering a Sequence of Values

Select both the range containing the data you want to copy and the adjacent destination
cells. SelecEdit->Fill. InFill Type, selectSeries Select the direction you want from the
Direction list and select the type of series and step value (incrementBSedes Type

Finding or Replacing Data

1. Selectdit>Find/Replace

Enter the data you want to find or replace inRimel What box.
SelectMatch caseandMatch entire cellsas needed.

Select either Formulas or Values from tloek in list.

a M DN

Click Find or Replace In the Replace dialog box, type the replacement text or value,
and then seledtind.

6. Select the appropriate button on the toolbar. To stop searching and replacing at any
time, select the Close box.

You can repeat your most recent search by seleEtiitg> Find Next. To move the Find/
Replace toolbar, drag the bar on the left side.

5 - 46 Windows CE



Sorting Data
Select the range you want to sort.

N

Selecflools> Sort.

w

Select the first column you want to sort orsort by.

»

SelectAscendingto sort the column in ascending order. The default sort is descend-
ing.
5. Repeat steps 3 and 4 in filgen by lists for additional columns as needed.

You can undo a sort by selectiigit->Undo Sort and exclude headers from a sort by
clearingHeader row in list.

Filtering Data

1. Select a cell in the list you want to filter or select the range.
Selecflools>AutoFilter . Arrows appear at the top of each of the selected columns.
Select an arrow in one of the columns.

Select a value (filter criterion) from the list to display only rows containing that value.

o~ 0N

SelectCustomto display the Custom AutoFilter dialog box, where you can specify
comparisons.

6. Repeat steps 3 and 4 to further refine the displayed rows.

You can turn off the AutoFilter by selectifigols> AutoFilter . Click All from the filter
list in each of the selected columns to again display all rows.

Editing Data

Editing Cell Contents
Select the cell.

no

Select the Formula bar to activate.

w

Edit the contents.

B

Pres€NTER to enter the changes in the cell. You can undo an action by selecting
Edit->Undo Typing in Cell X.

Moving Data

1. Select the cell or range containing the data you want to move.

2. SelectEdit>Cut.

3. Select the cell where you want to paste the data. For a range, select the upper-left cell.
4. SelecEdit>Paste
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Copying Data

1. Select the cell or range containing the data you want to copy.

2. SelectEdit>Copy.

3. Select the cell where you want to paste the data. For a range, select the upper-left cell.
4

SelectEdit>Paste UsePaste Speciato paste formulas, values, or other options.

Copying Data to Adjacent Cells

1. Select the range containing the data you want to copy and the adjacent destination
cells.

SelecEdit>
Select Copy irfill Type.
Select the direction you want from tBeection list.

Clearing Data from Cells
1. Select the cell or range containing the data you want to clear.
2. SelectEdit>Clear.

3. SelectAll to clear cell formatting and contengrmats to clear just cell formatting
or Contentsto clear just cell contents. You can undo this action by detbteUndo
Clear.

Deleting a Row or Column

1. Select one or more rows or columns that you want to delete.

2. Selectormat->Delete Cells

3. Select how you want the cells, rows, or columns deleted iDglete Cellsbox.

Formatting Data

Formatting Numbers

1. Select the cell or range.

2. Selectormat->Cells and click theNumber tab.
3. Select the desired format.

You can view a broader selection of number formats by seldétimgat->Cells and
clicking theNumber tab. You can view the format as you type. Example:

Currency: $25

Percentage: 25%

Date or Time: 8-15-97 1:30 PM

Fraction: =1/4 (Without the equal sign, the fraction is interpreted as a date.)
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Formatting Text

1. Select the cell or range.

2. Select the font and size you want from the Font list.

3. Select the Bold or Italic button to change the style.

4. Select the Align Left, Center, or Right Align button to change the alignment.

You can view more formatting options by selectiaymat->Cells and make the changes
on theAlignment andFont tabs.

Setting the Default Font
SelectFormat->Cells and select theont tab.

N

Select the font you want and sel8et As Default

w

Click Yesto confirm your changes.

»

Selectrormat->Cells, select thé-ont tab, andApply Default to apply the default
font and style to the selected cell or range.

Changing the Font in a Cell or Range

1. Select the cell or range.

2. Select the font you want from tRent list.

3. Select the size you want from thent Sizelist.

4. Selectrormat->Cells and select thEont tab, for more formatting options.

Changing the Cell Alignment

1. Select the cell or range.

2. Click the Align Left, Center, or Align Right button.

3. Selectrormat->Cells and select thAlignment tab, for more formatting options.

Change Cell Borders and Fills

1. Select the cell or range.

2. Selectormat->Cells and select thBorders & Fills tab.

3. Select the borders, border color, and fill color you want.

Working with Formulas and Functions
Naming a Cell or Range

1. Select the cell or range.
2. Selecflools>Define Name
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3. Type the name.
4. Click Add.

You can delete a name by selecting the name and clibletege Paste a list of cell names
and locations on the worksheet by seleckRagte List

Entering a Formula

1. Selecta cell.

2. Select the formula bar.

3. Begin the formula with an equal sign (=).
4

Enter values, cell references, name references, operators, and functions as appropriate.
Example:

=(B4/25)+100
=Revenue-Expenses
5. Pres€£NTER to enter the formula in the cell.

Inserting a Function

1. Selecflools>Insert Function.
2. Select a function category @ategory.
3. Select a function ifunction. You can review the function in tii@escription area.

Referring to a Cell or Range in a Formula

1. Begin entering a formula.

2. Select the cell or range where the reference belongs.
3. Finish entering the formula.

4. Pres€NTER.

Referring to a Cell on Another Worksheet

Enter, into your formula, the worksheet name followed by an exclamation point (!) and the
cell, range, or name reference. Example: =ThirdQtr!Earnings

Creating a 3-D Reference

Specify, in your formula, two or more sheets in a workbook. Use a colon between the first
and last worksheet names. Example: =SUM(Sheet2:Sheet6!$A$2:$C$5)
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Automatically Calculating Values

1. Select the range of values you want to calculate.

2. Select the AutoCalculate area on the right of the status bar to display a list of calcula-
tion types.

3. Select the calculation type from the list. The result appears in the AutoCalculate area.

Automatically Summing Values

1. Select the cell where you want to insert the sum.
2. Click the AutoSum button.

3. Check the proposed range, enclosed in a dotted border and displayed in the formula
bar. If necessary, adjust the range by dragging the border, selecting a new range, or
editing the range in the formula bar.

4. PresENTER.

Pocket Excel Functions

The following functions are available in Pocket Excel:

Database Functions

DAVERAGE
DCOUNT
DCOUNTA
DGET
DMAX
DMIN
DPRODUCT
DSTDEV
DSTDEVP
DSUM
DVAR
DVARP
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Date and Time Functions

DATE
DATEVALUE
DAY

HOUR
MINUTE
MONTH
NOW()
SECOND
TIME
TIMEVALUE
YEAR

Financial Functions

DDB
FV
IRR
NPER
NPV
PMT
PV
RATE
SLN
SYD

Information Functions

ERROR.TYPE
ISBLANK
ISERROR
ISERR
ISLOGICAL
ISNA
ISNONTEXT
ISNUMBER
ISTEXT

N

NA()
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Logical Functions

AND
FALSE
IF
NOT
OR
TRUE

Lookup Functions

CHOOSE
COLUMNS
HLOOKUP
INDEX
MATCH
ROWS
VLOOKUP

Math and Trigonometry Functions

ABS
ASIN
ATAN
ATAN2
COS
COUNTIF
DEGREES
EXP
FACT
INT

LN

LOG
LOG10
MOD
PI()
POWER
PRODUCT
RADIANS
RAND()
ROUND
SIN
SQRT
SUM
SUMIF
TAN
TRUNC
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Statistical Functions

AVERAGE
COUNT
COUNTA
COUNTBLANK
MAX

MIN

STDEV
STDEVP

VAR

VARP

Text Functions

EXACT
FIND
LEFT
LEN
LOWER
MID
PROPER
REPLACE
REPT
RIGHT
SUBSTITUTE
T

TRIM
UPPER
VALUE
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Shortcuts

Selecting
Table 12: Selecting Shortcuts
To Select Press
A cell Arrow keys
A range SHIFT + arrow keys
A row SHIFT + SPACEBAR

Multiple rows

SHIFT + SPACEBAR andSHIFT + UP
andDOWN arrow keys

A column

CTRL + SPACEBAR

Multiple columns

CTRL + SPACEBAR andSHIFT +
LEFT andRIGHT arrow keys

Entire worksheet

CTRL +A

From current cell to first or last cell in rov
or column

VCTRL + SHIFT + arrow keys

From current cell to beginning of work-
sheet

CTRL +ALT + SHIFT + HOME

From current cell to last cell in workshes

2{CTRL +ALT + SHIFT + END

From current cell to beginning of a row

ALT +SHIFT + HOME

From current cell to end of row

ALT +SHIFT + END

From current cell down one screen

ALT + SHIFT + PAGE DOWN

From current cell up one screen

ALT + SHIFT + PAGE UP
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Navigating

Table 13: Navigating Shortcuts

To Select

Press

Complete a cell and move down

ENTER

Complete a cell and move up

SHIFT + ENTER

Complete a cell and move right

TAB

Complete a cell and move left

SHIFT + TAB

Move to the first or last cell in a row or column

CTRL + arrow keys

Move to the beginning or a row

ALT + HOME

Move to the end of a row

ALT + END

Move to the beginning of a worksheet

CTRL + ALT + HOME

Move to the end of a worksheet

CTRL + ALT + END

Move one screen down

ALT + PAGE DOWN

Move one screen up

ALT + PAGE UP

Move to next sheet

CTRL + ALT + PAGE DOWN

Move to previous worksheet

CTRL + ALT + PAGE UP

Move to the next/previous workbook

CTRL +>orCTRL + <

Zoom

ALT +Z

Reverse zoom

ALT + SHIFT + Z
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Entering and Editing Data

Table 14: Entering and Editing Data Shortcuts

To Select Press
Complete an entry ENTER
Cancel an entry ESC
Complete a cell and move down ENTER
Move to the beginning of a line ALT + HOME
Move to the end of a line ALT + END

Delete the contents of the selected cell

SHIFT + BACKSPACE

Activate cell CTRL+E
Fill down CTRL+D
Fill to the right CTRL+R

Fill the selected range with the current
entry

CTRL + ENTER

Open the Replace With dialog box CTRL +H
Calculate all open sheets CTRL +=
Hide row CTRL+9
Unhide row CTRL + SHIFT +9
Hide column CTRL+0

Unhide column

CTRL+ SHIFT +0

Enter current date

CTRL +;

Enter current time

CTRL +:
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Formatting Data

Table 15: Formatting Data Shortcuts

To Select Press
Bold CTRL +B
Italic CTRL + I
Underline CTRL+U

General format

CTRL + SHIFT + ~

Decimal format

CTRL + SHIFT +!

Time format

CTRL + SHIFT + @

Date format

CTRL + SHIFT + #

Currency format

CTRL + SHIFT + $

Percentage format

CTRL + SHIFT + %

Exponential format

CTRL + SHIFT + 7

Working with Workbooks

Setting a Password for a Workbook

Protect your workbook with a password. Seleéitg>Passwordto access a password dia-
log box. Type and verify the password you want to protect your file. SeleetSaveto

save your workbook and retain the password.

NOTE: You cannot synchronize workbooks that are password protected. You must remove the
password protection in the appropriate program on your PC or device, and then synchronize. Once
synchronized, you can reset password protection.

Switching to Another Worksheet

In the middle of the status bar, select the current worksheet's name (example: Sheetl) to
display a list of worksheets. Select the worksheet you want to switch to from the displayed

list.

Adding a Worksheet

You can add a worksheet by selectirggmat->Sheet
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Removing a Worksheet

Remove a worksheet by selectifgrmat->Sheet Sheets Select the worksheet you
want to remove and clidRelete

Renaming a Worksheet

You can rename a worksheet. Switch to the worksheet you want to rename areoselect
mat->Sheet>type the worksheet's new name.

Reordering Worksheets in a Workbook

SelectFormat-> Sheeb Sheets Select the worksheet you want to move and doke
Up or Move Downas many times as needed.

Adjusting the View of a Worksheet

Displaying and Hiding Window Elements

Click View and select the elements you want displayed.

Splitting the Window

Drag the split bar located above the vertical scroll bar or to the right of the horizontal split
bar. You can remove the split by dragging the split bar out of the window. A split window
is saved with the worksheet and displayed as split the next time you open that worksheet
in Pocket Excel.

Freezing Panes on a Worksheet

Select the cell where you want to freeze panes and Sédsed Freeze PanesYou can
unfreeze panes by selectixggw->Unfreeze Panes

Zooming In on Data
1. Selectview>Zoom.

2. Select the magnification you want. You can enter a percentage by se(@aciom
and entering the percentage.

Zoom settings apply to the entire workbook and are saved when you save the workbook.

Using the Full Screen

SelectView->Full Screen Exit the Full View screen by clickingestore This setting is
not saved with the workbook.
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Adjusting Column Widths
1. Select one or more columns.
2. Point to the right border in the column heading and drag the two-headed arrow.

Adjusting Row Heights
1. Select one or more rows.

2. Point to the lower border in the row heading and drag the two-headed arrow.

Hiding a Row or Column

1. Select a cell in the row or column you want to hide. You can select more than one adja-
cent row or column.

2. Selectormat->Row or Column.
3. SelecHide.

Displaying a Hidden Row or Column

1. Selecflools>Go To.

Type a reference for a cell in the hidden row or column (example: E4).
Click OK.

SelectFormat->Row or Column.

SelecUnhide.

o pr WD

Fitting Rows and Columns to Data
1. Select the rows or columns you want to automatically fit to their contents.

2. Double-click the lower border of the row heading or the right border of the column
heading.

Inserting Symbols

1. Place the cursor where you want to insert the symbol.
2. SelecfTools>Insert Symbols

3. Select the symbol you want and cllokert.

If you select a different font, or subset of a font, a different set of symbols displays. To use
additional symbols that are available on your desktop PC, connect your Aero 8000 to your
PC and open the Mobile Device window. Copy the .ttf file from the Font folder on your
desktop PC to the device name\My Handheld PC\Windows folder in the Mobile device
window. In the Synchronized File dialog box, cligh, just copy these filesFor more
information, see ActiveSync Help on your desktop PC.
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Printing a Worksheet
1. Selectile>Print.
2. Select the print options you want.

You can set the print area by selecthilg-> Print Area > Set Print Area. Clear the print
area by selectingile>Print Area->Clear Print Area. ThePort list displays the avail-
able printer ports. If Network is selected from Bt list, enter the path to the network
printer in theNet Path box.

Synchronizing and Converting Pocket Excel Files

Synchronizing Pocket Excel Files

Pocket Excel files are synchronized using the File synchronization service in ActiveSync.
This service is enabled automatically. Your device files are synchronized with files in a
folder named device name_Synchronized Files on your desktop PC.

You can view files in this folder by double-clicking your device icon in the Mobile
Devices window on your desktop computer. This folder is stored in one of the following
locations on your PC:

* Windows 95: My Documents\device name_Synchronized Files

* Windows NT: WINNT\Profiles\your username\Personal\device name_Synchronized
Files

If you mark a file as hidden on your desktop, the file is deleted from your Aero 8000 the
next time you synchronize. When you delete a file on either your desktop computer or
your Aero 8000, the file is deleted in the other location the next time you synchronize.

Converting Pocket Excel Files

Introduction

ActiveSync converts Excel files (.xIs) and templates (.xIt) created in Excel version 5.0 (or
later) during synchronization. If an e-mail program is installed on your Aero 8000 and you
receive an Excel file created in Excel version 5.0 or later, your Aero 8000 converts the
file. Simply open the attachment from the e-mail program, or open the file in Pocket Excel
to view the information.

During conversion, some formatting attributes may be changed or lost. To avoid losing
these attributes permanently, close the file after viewing it rather than saving the file on
your Aero 8000. If you want to save the file, save the file with a different file name. For
more information about conversions performed by ActiveSync, see ActiveSync Help on
your desktop PC.
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Changes in Formatting

Alignment: Horizontal, vertical, and wrap text attributes remain the same, but vertical
text appears horizontal.

Borders: Borders appear as a single line.
Cell patterns: Patterns applied to cells are removed.

Fonts: Fonts not supported by your Aero 8000 are mapped to the closest font available.
The original font is listed on your device. When converted back to Excel, the data displays
in the original font.

Number formats: Numbers formatted using Microsoft Excel 97 conditional formatting
feature are displayed in Number format.

Changes to Formulas and Functions

If an Excel file contains a function that is not supported by Pocket Excel, the function is
removed and only the returned value of the function appears. The formulas described
below are also converted to values:

Formulas entered as an array or containing an array argument. Example:
=SUM({1,;2;3;4}).
Formulas containing external link references or an intersection range reference.

Formulas containing references past row 16384 are replaced with #REF!.

Changes to Protection Settings

Most worksheet and workbook protection features are disabled but not removed during
conversion. Workbooks that are password protected cannot be synchronized. You must
remove the password protection in Excel or Pocket Excel and then synchronize. Once syn-
chronized, you can reset password protection.

Changes in Zoom Settings

The zoom settings are not retained during conversion. Excel supports a per worksheet
zoom setting while Pocket Excel's zoom setting is applied to the entire workbook.

Changes to Worksheet Names

Names that reference worksheets within the same workbook are displayed accurately, but
names that refer to other workbooks, arrays (for example, ={1;2;3;4}), array formulas, or
intersection ranges are removed from the name list. If a name is removed from the list, it is
left in formulas and functions, causing those formulas to resolve as "#NAME?". All hid-
den names are unhidden.
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Changes to AutoFilter Settings

AutoFilter settings are removed during conversion. If you have an AutoFilter applied to a
worksheet that causes rows to be hidden, the rows remain hidden after converting the file
to Pocket Excel. Use thénhide command to display hidden rows.

Unsupported Worksheet Features

The following features aren't supported in Pocket Excel and are removed or modified dur-
ing conversion:

e Chart objects are removed.
* Hidden sheets are unhidden.

» Chart sheets, VBA modules, macro sheets, and dialog sheets are removed and replaced
with a blank sheet.

» Text boxes, drawing objects, pictures, and controls are removed.
* Pivot table data is converted to values.

Pocket Internet Explorer

Introduction

With Pocket Internet Explorer you can view Web sites on your device. You can view Web
pages on the Internet and/or Intranet. You must use a modem or an Ethernet card to con-
nect to the Internet service provider (ISP) or network.

Getting Connected

Connecting to the Internet

Before you can view Web pages, you must set up a remote connection to your ISP or net-
work.

1. SelectStart->Programs>Communication->Remote Networking Double-click the
connection you want to use.

2. Enter any necessary user information. To adjust the way the number is dialed, click
Dialog Properties

3. Click Connection

If you are having problems connecting, you may need to access the Internet using a Proxy
server.
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Setting Up an Automatic Internet Connection

Use the steps below to set up an automatic Internet connection. Once this connection is set
up, the remote connection of your choice will automatically be dialed when Pocket Inter-
net Explorer needs to access the Internet or corporate network.

1. Selectiew->and click theAuto Dial tab.

2. Select théJse AutoDialcheck box.

3. Specify the remote connection to be used.
4

SelectAuto Disconnectif you want to automatically disconnect from the Internet
after a certain amount of idle time (time when your device has not been used).

5. InDisconnect If Idle For enter how long your device must be idle before disconnect-
ing from the Internet.

Setting Up a Proxy Server

Proxy servers are often used when connecting to the Internet for added security.
1. Selectview->Options and click theProxy Servertab.

2. SelectUse Proxy Server

3. Enter the proxy server address and port.

To bypass the proxy server for local address, such as corporate Intranet pages, select
Bypass Proxy for Local Addresses

Enabling Cookies
1. Selectview->Options and select thAdvancedtab.

2. SelectEnable Cookies

Selecting Security Options

1. Selectview->Options and select thAdvanced tah
2. SelectSecurity Settings

3. Select the security protocols you want.

SSL2 is Secured Sockets Layer Level 2, a standard protocol for secure transmissions. All
secure Internet sites support this protocol.

SSL3is Secured Sockets Layer Level 3, a proprietary protocol that is intended to be more
secure than SSL2. Some Internet sites do not support this protocol.

PCT is Private Communications Technology, a proprietary protocol developed by
Microsoft that is significantly more secure than SSL2. Some Internet sites do not support
this protocol.
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Locating and Browsing Web Sites

About Security

Pocket Internet Explorer supports the security protocols used by secure sites. When
accessing a secure site, you can send personal information safely. To determine if a Web
site is secure, check for a lock icon on the Pocket Internet Explorer button on the status

bar.

Searching for an Internet Site
SelectGo->Search the Web

Going to an Internet Address

1.
2.
3.

SelectView->Address Bar, if necessary to display the Address bar.
Enter the address.
PresE€NTER.

Viewing Previously Visited Sites

1.
2.

SelectGo->History.
Select the page you want to view.

Adding and Viewing Favorites

1.
2.
3.
4.

Go to the page you want to add.
Selectavorites>Add to Favorites.

If necessary, locate the folder you want.
Confirm or change the name.

To view your favorite Web sites, selé@vorites and the Web site you want to view. To
organize your Favorites list, selé@vorites>Organize Favorites Your Favorites list is
available in both Pocket Internet Explorer and Windows Explorer.

Browsing Web Pages

To move to a page you have previously viewed, s€eetBack. To move to the next
page (provided you have viewed it previously), seBed Forward . Return to your
home page by selectifigo>Home Page

Windows CE 5 - 65



Refreshing Current Page

SelectView->Refresh

Stop Loading a Page
SelectView- Stop.

Viewing Current Page Properties

1. Selectrile>Properties.
2. Select th&eneral tab to view the protocol, page type, size, and address.

3. Select thé&ecurity tab to view security information about the page.

Viewing HTML Source Code

1. While viewing the page, sele€iie>Save Asand save the file.

2. Open the file in a word processing program, such as Pocket Word.

Changing Home and Search Page Settings

1. Open the page you want to use as your home or search page.

no

SelectView->Options and select thBefault Pagedab.

w

Select eitheHome Pageor Search Page

»

SelectUse Current Pageto make the current page the default. To change back to the
original default page, seledise Default Page

Creating a Desktop Shortcut to an Internet Site
1. Display the page for which you want a shortcut.
2. Selectile>Send Ta

3. SelecDesktop as Shortcut You can also sele€esktop Shortcuton the page's
shortcut menu (hold dowALT and select the page).

Saving, Caching, and Copying Web Pages
Saving a Copy of the Current Page

You can save Web pages and view them later when you're disconnected from the Internet
or Intranet without using cached memory.

1. Selecfile>Save As

2. Specify a folder location and give the file a name.
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Viewing a Cached Page while Disconnected

As you view pages on the Internet, they are cached in the Temporary Internet Files folder
in My_device name. Browsing among cached pages is faster than returning to their Inter-
net sites. However, once you exit Pocket Internet Explorer cached memory is cleared.

1. Before you disconnect, seléate->Offline.
2. SeleciGo~>History once you have disconnected.
3. Select the page you want to view.

Adjusting Settings for Gache Memory

Pocket Internet Explorer's cache is by default 10 percent of your device's total memory
storage. If you're having problems with memory storage, try clearing Pocket Internet
Explorer's cache.

1. Selectview->Options and click theAdvancedtab.
2. If you want to allow caching (temporary storage), ckclable Caching

NOTE: Caching drains memory.

3. Move theSize Of Cacheslider to increase or decrease the storage devoted to caching.

4. SelecEmpty Cache When Exitingif you want the folder emptied when you close
Pocket Internet Explorer.

5. SelecEmpty Cache Nowto empty the folder immediately.

Copying a Web Page to a Document

1. Select all or part of the Web page you want to copy.
Selectdit->Copy.

w N

Go to the document where you want to place the information and select the location.
SelecEdit>Paste

»

Changing the Pocket Internet Explorer Display

Changing the Font Size

SelectView->Fonts, and select desired size.

Displaying a Page in a New Window

SelectFile>New Window.
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Fitting the Page to the Window

SelectView~>Fit To Window.

Displaying or Hiding the Address Bar

SelectView>Address Bar.

Changing the Default Appearance of Pages

1. Selectview->Options and select thA&ppearancetab.
2. Select desired options. To save memory, dew PicturesandPlay Sounds

Protecting Important Information

You may keep valuable data on your device, such as names and phone numbers of impor-
tant contacts, credit card numbers, and confidential documents. Here are some ways to
protect your important information.

» Use a passwordYou can set a password that must be entered before you can access
Windows CE. Selec$tart-> Settings>Password

NOTE: Choose a password that's easy to remember. If you forget it, you must perform a full reset
to use your device again. A full reset erases all of your data.

» Back up your data: You can create and maintain a backup file that contains your
device program data. If, for example, you accidentally remove both the main and
backup batteries and lose your data, you can restore it from the backup file. For more
information, see ActiveSync Help.

Save As dialog box

Up one level:Navigates upward in the folder structure.
New Folder: Enter the name you want.
List: Displays folders and files as icons.

Details: Displays folders and files in a list, providing file details such as size, type, and
date last modified.

Name: Type a name for the file.

Type:Select the file type for the file you are saving. The available types vary, depending
on the program you are using.

Print dialog box: NOTE: Options available depend on the program you are using. Some
options may not be visible or may be disabled within individual programs. For more infor-
mation on specialized printing functions, see individual program's help files on your
device.
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Printer: Lists available printers. The one you select remains the default printer until you
change it.

Port: Lists the available printer ports.

Net Path: When Network is selected from the Port list, enter the path to the network
printer.

Paper Size:Lists the available paper sizes.

Draft Mode: Allows you to print a document at a lower resolution. This is usually faster.
This option may not be available on the selected printer.

Color: Printin color.

Print Range: Specifies whether to print the whole document or only the selected part.
Orientation: Allows you to specify Portrait or Landscape.

Margins: Resets the margin amounts.

Start date and End date:Allows you to specify a date range of information to print.
Fields: Specifies which columns of information to print.

Selection: Select to print Appointments, Events or All Data to print an entire calendar.

Browse dialog box

Up One Level: Navigates upward in the folder structure.
New folder: Creates a new folder. Enter the name you want.
List: Displays folders and files as icons.

Details: Displays folders and files in a list, providing file details such as size, type, and
date last modified.

Name: Displays the name of the selected folder or file.

Type: Select the file type you want to display. To display all files in the current folder,
select All Documents (*.*).

Color dialog box

Basic colors:Shows the basic colors available. To define a custom color, select the basic
color closest to it, and then select Define.

Custom colors:Displays any custom colors you have defined. To change the settings for
a custom color, click a custom color box, and then select a different color. To define a new
custom color, click an empty custom color box, select a different color, and then select
Add to Custom Color.

Define: Defines a custom color. If unavailable, you are already viewing custom colors. To
define a custom color, select in the color matrix, or select the color using the hue, satura-
tion, and luminosity definitions or the red, green, and blue definitions.

Windows CE 5 - 69



Add to Custom Colors: Adds the custom color you defined.

Color/Solid: On the left, this box displays the amount of white and black in the current
color. On the right, this box displays 100% of the color with no white and black. Adjust
using the slider at right. To select 100% of color with no white or black Alpe+ O. To

change the color, change the values described below. Or experiment by selecting and drag-
ging on the color matrix.

Hue: The value of a color wheel. Red = 0, Yellow = 60, Green = 120, Cyan = 180,
Magenta = 200, and Blue = 240. Shorté&ibor ALT +E.

Sat: Saturation level; the amount of color in a specified hue, up to 240.

Lum: Luminosity, or brightness. As you change the luminosity, the values for red, green,
and blue change.

Red: The amount of red in the selected color.
Green: The amount of green in the selected color.
Blue: The amount of blue in the selected color.

Font dialog box

NOTE: Options available depend on the program you are using. Some options may not be visible
or may be disabled within individual programs.

Font: Displays the current font. To change fonts, select the arrow and select the one you
want from the list.

Size:Displays the current size. To change sizes, select the arrow and select the one you
want from the list.

Font Style: Formats text as bold, italic, underline, or a combination of these items.

Color: Displays the current color if your device supports color. To change colors, select
the arrow and select the one you want from the list.

Preview: Displays text formatted with the selection options.
Apply Default: Restores the default formatting, overriding changes you have made.

Set as Default:Uses the current settings as the default text formatting, which will be
applied to new documents you create.

Open dialog box

Up One Level: Navigates upward in the folder structure.
New folder: Creates a new folder. Enter the name you want.

List: Displays folders and files as icons.
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Details: Displays folders and files in a list, providing file details such as size, type, and
date last modified.

Name: Displays the name of the currently selected folder or file.

Type: Select the file type you want to display. To display all files in the current folder,
click All Documents (*.*).

Setting a Password for a Document

1. Selectile>Password
2. Type and verify the password.

3. SelecfFile>Saveto save the document. You must save the document to retain the
password.

You cannot synchronize password-protected Word or Excel files. You must remove the
password protection in Word or Excel, and then synchronize your Aero 8000 with your
desktop PC. Once the document has been synchronized and converted to a Pocket Word or
Pocket Excel file, you can set password protection using the above steps.
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Pocket PowerPoint

Introduction

Use Pocket PowerPoint to quickly and easily deliver a professional online presentation.
Simply create the presentation in Microsoft PowerPoint on your desktop PC and then
transfer the presentation to your Aero 8000. You can show the presentation directly on
your device, or connect your device to a VGA monitor and show the presentation to a
large group.

Preparing a Presentation

While you are on the road you can add a new title slide, or first slide, to the presentation
on your device to customize the presentation for a specific audience. The title slide you
create in Pocket PowerPoint is the only slide you can edit in Pocket PowerPoint. The rest
of the slides must be created and updated on your desktop PC. However, once you are on
the road, you can change the order of your slides and update your notes.

Creating a New Title Slide

You can create a new slide by selecfliogls> Title Slide and entering the text for the
slide. ClickFont and you can change the font in the slide. Change the alignment by click-
ing Position.

Use thePreview feature to view you slide. Click anywhere on the slide to return to the
Title Slide. If you need to make any edits to your slide, s8¢ Title Slide and make
your changes.

Editing Notes in Notes Page View

Notes can be edited in the Page View of your presentation. S@ect Notes Page
View and select the information you want to edit. Make your changes and save your work.

Sorting Slides

The slide sorter allows you to sort the slide within your presentation. Jetds® Slide
Sorter and select on the slide you want to move. Seledlthee Slidebuttons as needed.

Hiding One or More Slides

The slide sorter also allows you to hide an unnecessary slide. Badss Slide Sorter
and select on the slide you want to hide. Séikae Slide and the slide disappears from
view in the presentation.

5 - 72 Windows CE



Viewing and Displaying Slides

Specifying the Display Method

You can display your slide presentation by different methods. Selels> Set Up Show

and select the device from the displayed list. This list displays information only for device
drivers you have already installed.

Advancing Slides Manually or Automatically

SelectTools> Set Up Show SelectManually to move through the slides using tevi-
ousandNext commands. You can set the slides to move automatically after a set period of
time by selectingAutomatically Every and entering the frequency in seconds. If you

want to repeat the show, click tRepeat continuouslybox.

Running a Presentation

Selectingview->View Showallows you to start or stop a presentation. You can choose to
advance the slides manually by selectgw-> Previousor View->Next to display
slides.

NOTE: If your Pocket PowerPoint presentation is running slowly, has display problems, or causes
an out-of-memory message, try one of the following:

» Close all open programs.

» Allocate more memory. SeleStart-> Settings>Control Panel and double-click the
System icon. Use thdemory tab to adjust program memory.

Navigating through Slides

SelectView->Previousor View->Next.

Going to a Slide by Number

Select the slide's number you want from $tide Number list.

Zooming In or Out on a Slide

Select thezoom button once to zoom in on a slide. Select again to zoom out on a slide.

Annotating a Slide

Annotating, or editing, a slide is available in PowerPoint. Sélaals>Setup Showand
selectManually. Selectview->View Showand select thAnnotate button. Use the touch
pad to draw or write on the slide. Click tAanotate button again to stop annotation or to
change slides. You can erase by presking
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Using Notes Page View

Switching between Slide View and Notes Page View

You can switch between Slide view and Notes Pages view by sel€wing Slide View
or View->Notes Page View

Changing the Font Sizes of Notes

Changing font size is as simple as selecVirgyv>Notes Page Viewand selecting the
Zoom button. Continue selecting t@@om button until you reach the desired font size.

Editing Notes in Notes Page View

To switch to Notes Page view, sel®@w->Notes Page Viewand edit the notes as
desired.

Synchronizing Pocket PowerPoint Files

Pocket PowerPoint files are synchronized using the File synchronization service in
ActiveSync. The service is enabled automatically. Your device files are synchronized with
files in a folder on your PC named device name_Synchronized Files. This folder is stored
in one of the following locations on your PC:

* Windows 95: My Documents\device hame_Synchronized Files
* Windows NT: WINNT\Profiles\your username\Personal\device name_Synchronized
Files

ActiveSync converts presentations during synchronization. For more information on pre-
sentation conversion, see ActiveSync Help on your PC.

NOTE: If you mark a file as hidden on your desktop, the file is deleted from your device the next
time your synchronize. When you delete a file on either your desktop computer or your Aero 8000,
the file is deleted in the other location the next time you synchronize.
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Shortcuts

Table 16: Pocket PowerPoint Shortcuts

To When running a slideshow, press
Advance to the next slide N, ENTER, right arrow orfSPACEBAR
Return to the previous slide P, left arrow orBACKSPACE
End a slide show ESC
Zoom in or out ALT +Z
Turn annotation on or off A
Erase annotations E
Black out or restore display B
White out or restore display wW
Advance to the next slide right arrow
Return to the previous slide left arrow
Go to a slide by number (slide numberENTER
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Pocket Word

Introduction

You can create and edit documents and templates in Pocket Word just as you do in
Microsoft Word. A spelling checker is provided to verify spelling accuracy, and you can
quickly format text using buttons and menu commands that are similar to the version of

Word on your PC. You can work with files in either Normal or Outline view.

Pocket Word documents are usually saved as .pwd files, but you can also save documents
in other file formats, such as .rtf. During synchronization, Microsoft Word (.doc) files are
converted to Pocket Word (.pwd) files, and vice versa. Microsoft Word templates (.dot)

are converted to Pocket Word templates (.pwt).

Selecting and Editing Text

Selecting Text

Table 17: Selecting Text

To select

Do this

Any amount of text

Drag the stylus over the text

A word

Double-click the word

A single paragraph

Triple-click within the paragraph

An entire document

SeleEdit>Select All

A picture

Select the picture

Finding Text

1. Select the part of the document you want to search. If you want to search the entire
document, do not select an area.

Selectdit>Find.

3. Enter the text you want to find. For a paragraph, typea tab stop, typét; one

space, typéw.

Select the search options you want.

5. Selectind Next. Selectedit>Find Next to continue searching.
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Replacing Text

1. Select the part of the document you want to search. If you want to search the entire
document, do not select an area.

SelectEdit>Replace

. Enter the text you want to find and the text you want to replace it. For a paragraph,
type”p; a tab stop, typét; white space, typéw.

Select the replacement options you want.
Selectrind Next.
Select the appropriate button on the Find/Replace toolbar.

o o

Moving, Copying, or Deleting Text

1. Select the text you want to move, copy, or delete.
2. Select the Cut button to move or delete text. Select the Copy button to copy the text.

3. Move the cursor to the desired location, and select the Paste button to paste the infor-
mation. To undo an earlier action, select the Undo button. To restore the action, select
Edit>Redo.

Checking Spelling
1. Selecflools>Spelling.
2. PresENTER to accept the replacement for the first highlighted word.
3. Repeat step 2 for additional words.

If you select outside the spelling toolbar and then want to continue checking spelling,
select Resume. To move the spelling toolbar, drag the bar on the left side.

Changing Spelling Options

A custom spelling dictionary (Custom.dic) is created on your device when you add a word
as you check spelling. You can also copy a custom dictionary from your desktop computer
to your device.

1. Selecflools>Options.
2. Make the changes you want.

To use a different custom dictionary, selebtangeand browse to locate the new dictio-
nary. To make changes in the dictionary, sditit. The dictionary opens in Pocket
Word. Make any changes you want and then save the dictionary.
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Formatting Text

Creating Bulleted and Numbered Lists

1.
2.
3.
4.

Select the Bullets or Numbering button.

Type the first item.

Pres€NTER, type the next item, and repeat as needed.
Select either of the buttons again to end list formatting.

You can change the number style for the selected list by selécrntat->Paragraph.
In theFormat list, select the number style you want.

Setting the Default Font

1.
2.
3.
4.

Selectrormat->Font.
Select the font options you want.
SelectSet As Default

Selectyesto confirm that your changes are applied to subsequent documents you cre-
ate. To apply the default font and style to selected text, in the Font dialog box, select
Apply Default.

Choosing a Different Font for Selected Text

N

3.
4.

Select the text you want to change. To select all text, $ed@ect Select All
Select the font you want from tRent list.

Select a size from theont Sizelist.

Selectrormat->Font to see more formatting options.

Changing Font Formatting

Select desired text and select the Bold, Italic, or Underline button. To change the color,
selectFormat->Font and select the color you want from the Color list. To see more for-
matting options, sele&ormat->Font.

Adjusting the Paragraph Alignment

1.
2.

Select the paragraph you want to align.

Select the Align Left, Center, or Align Right button. To see more formatting options,
selectFormat->Paragraph.
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Indenting a Paragraph
1. Select the paragraph you want to indent.
2. Selectrormat->Paragraph.

3. Adjust the indentation settings as needed.

Setting Tabs

SelectFormat->Tabs and change the tab settings as needed.
Adjusting the Display

Wrapping Text in the Window
SelectView->Wrap to Window.

Displaying the Document using the Full Screen

SelectView->Full Screen To exit Full Screen view, seleRestore To move the Restore
button, drag the bar on the left side.

Displaying or Hiding Scroll Bars

SelectView~>Horizontal Scroll Bar or Vertical Scroll Bar.

Zooming In or Out

SelectView->Zoom, and select the desired percentage. For Custom, enter the exact per-
centage and clickK.

Working in Outline View

Switching between Normal and Outline Views

SelectView->Normal or Outline.

Assigning and Changing Outline Levels
1. Selectview->Outline.

2. Select the appropriate buttons on the toolbar.

Inserting Symbols
1. Place the cursor where you want to insert the symbol.

2. Selecflools>Insert Symbols
3. Select the symbol you want, and then clitsert.
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If you select a different font, or subset of a font, a different set of symbols is displayed. To
use additional symbols that are available on your PC, connect your device to your PC and
open the Mobile Device window. Copy the .ttf file from the Font folder on your PC to the
device name/My Handheld PC/Windows folder in the Mobile Device window. In the Syn-
chronized File dialog box, seledb, just copy these filesFor more information, see
ActiveSync Help on your PC.

Printing a Document
1. Selectrile>Print.
2. Select the printing options you want.

Port lists the available printer ports. If Network is selected fronPthrtlist, enter the
path to the network printer in tidet Path box.

Setting a Password for a Document

1. Selectile>Password

2. Type and verify the password.

3. You must save the documehil€->Save to retain the password.

You cannot synchronize password protected Microsoft Word documents. You must

remove the password protection in Word, and then synchronize your device with your PC.
Once the document has been synchronized and converted to a Pocket Word document, you
can set password protection.
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Synchronization

Documents are synchronized using the File synchronization service in ActiveSync. This
service is enabled automatically. Your device files are synchronized with files in a folder
named device name_Synchronized Files on your PC.

You can view files in this folder by double-clicking your device icon in the Mobile
Devices window on your desktop computer. This folder is stored in one of the following
locations on your PC:

* Windows 95: My Documents\device hame_Synchronized Files

* Windows NT: WINNT\Profiles\your username\Personal\device name_Synchronized
Files

If you mark a file as hidden on your desktop, the file is deleted from your device the next
time you synchronize. When you delete a file on either your desktop computer or your
device, the file is deleted in the other location the next time you synchronize.

Converting Documents

Introduction

ActiveSync converts Word documents (.doc) and templates (.dot) created in Word version
6.0 or later to Pocket Word documents (.pwd) or templates (.pwt) during synchronization.
For more information, see ActiveSync Help.

If an e-mail program is installed on your mobile device and you receive a Word document
or template created in Word version 6.0 or later attached to a message, Pocket Word will
convert the file on your device. Pocket Word is also capable of converting InkWriter and
NoteTaker documents (.pwi) to Pocket Word documents. Simply open the attachment
from your e-mail program, or open the file in Pocket Word to view the information.

During conversion some formatting attributes may be changed or lost. To avoid losing
these attributes permanently, close the file after viewing it rather than saving the file on
your device. If you save the file, save the file with a different file name.

Changes Caused by Word Document Conversion

Changes to Formatting

Borders and Shading:Borders and shading are not displayed in Pocket Word, but are
restored when converted back to a Word document. Shading is not restored when used in a
table, but simple borders are restored.

Character formatting: Bold, italic, strikethrough, superscript, subscript, and hidden text
are retained and displayed. Other effects are changed or removed.

Colors: Colors are retained and mapped to colors available on your device.
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Fonts and font sizesfonts not supported by your mobile device are mapped to the clos-
est font available in Pocket Word. To use additional fonts, copy the .ttf files from your PC
into the Fonts directory (\Windows\Fonts) on your device.

Page formatting: Headers, footers, footnotes, columns, page set-up information, and
style sheets are removed during conversion to Pocket Word. Pocket Word does support
built-in headings.

Paragraph formatting: Tabs, alignment, bullets, indentation, simple numbered lists, and
paragraph spacing are retained and displayed in Pocket Word.

Changes to PicturesPictures are converted to a bitmap format supported by your mobile
device. When converting to your PC, pictures are converted to bitmap formats supported
by your PC applications. Pictures that are linked, but not stored, in a Word document are
not displayed in Pocket Word. Frames are removed during conversion.

Table of Contents ChangesTable of Contents text and some of the formatting is pre-
served. However, any text set at right-aligned tab stops may wrap to the next line.

Index Changes:Index text and some of the formatting is preserved.

Changes to TablesTables appear as tab-delimited text. Cells containing wrapped text or
cells containing tabs or paragraph markers may be difficult to read. Simple tables are dis-
played accurately and restored when you convert the Pocket Word file back to a Word
document.

Changes to OLE Objects:OLE Objects are converted to a bitmap format supported by
your mobile device. When converting to your PC, these objects are converted to bitmap
formats supported by applications on your PC. Pictures that are linked, but not stored, in a
Word document are not displayed in Pocket Word.

Changes to Revisions Marks, Annotations, and CommentRevision marks are visible
but cannot be changed. Annotations and comments are removed during conversion.

Changes Caused by .pwi File ConversioniVhen you open a .pwi file in Pocket Word,
handwritten notes and drawings are converted to bitmaps and can no longer be edited. If
you save the file in Pocket Word as any kind of file type, including .pwi, you will never be
able to edit the handwritten notes or drawings. If you want edit handwritten notes or draw-
ings at a later time, either do not save the file in Pocket Word or save the file with a differ-
ent file name.

When converting Pocket Word documents (.pwd) to .pwi files most attributes are retained.
However, some types of formatting, such as numbering, are lost during conversion.
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Shortcuts

Table 18: Pocket Word Shortcuts

To Press
Make the selected text bold CTRL+B
Make the selected text italic CTRL +1
Underline the selected text CTRL+U
Left-align a paragraph CTRL +L
Center a paragraph CTRL+E
Right-align a paragraph CTRL+R

Format a bulleted paragraph

CTRL + SHIFT + L

Format a numbered paragraph

CTRL + SHIFT +J

Increase indent CTRL+M
Decrease indent CTRL + SHIFT + M
Increase hanging indent CTRL+T
Underline selected text CTRL+U
Decrease hanging indent CTRL+SHIFT +T
Zoom ALT +Z

Reverse a zoom

ALT + SHIFT +Z

Move up one paragraph

CTRL + ALT + up arrow

Move down one paragraph

CTRL + ALT + down arrow

Open the Font dialog box

CTRL + SHIFT + F

Increase the font size

CTRL + SHIFT + >

Decrease the font size

CTRL + SHIFT + <

Remove character format

CTRL+ SHIFT + Z

Remove paragraph format

CTRL +Q

Show all text or headings in outline view

ALT + SHIFT + A

Show all headings with Heading X style
outline view

PALT + SHIFT + X (whereX is the head-
ing level number)
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Table 18: Pocket Word Shortcuts

To

Press

line

Move paragraphs up and down in an oUtCTRL + SHIFT + { and

CTRL + SHIFT +}
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chapter 6

CoMPAQ SOFTWARE

Introduction

This chapter provides information on using the Compaq applications included with your
Aero 8000. Some Compaq applications are preinstalled on your Aero 8000, and some are
installed from the Compaqg CD. For help using the applications, read this information or
refer to the online Help supplied with the applications.

To learn about updates that may have occurred to your Aero 8000 device after this docu-
ment was printed, access tBtart menu on your device, then sel&tt Documentsand
Compag Updates

NOTE: If updated information is not available, Compaq Updates will not appear on the screen.

Getting on the Internet

Once the new profile is copied to your Aero 8000, make a dial-up connection by selecting
Start->Communication>Remote Networking For more information on accessing the
Internet, se&Jsing the Modemand see the ActiveSync Help that you installed on your
computer.

Using the Internet Setup Utility

Configuring a device for Internet access can be a complicated, time-consuming process.
The Internet Setup Utility simplifies this process by automating the way you set up pro-
files to use when accessing the Internet on your Aero 8000.

The Internet Setup Utility allows you to transfer your existing Internet service provider
(ISP) profile information from your computer to your mobile device, select profiles from a
list of pre-defined ISPs, or create new, custom profiles for use on your Aero 8000.

The Internet Setup Utility consists of two major components: the Internet Setup Utility cli-
ent and the Internet Setup Utility server. The client (which must be installed on your com-
puter from the Compaqg CD) collects ISP information and provides you with an easy-to-
understand user interface. The server (which is preinstalled on your Aero 8000) runs on
your Aero 8000 and transfers ISP information to and from the device.
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Setting Up a Profile

To set up a profile, follow these steps:
1. Be sure the Internet Setup Utility is installed on your computer.

2. Connect the mobile device to your computer via the auto-sync cable or an infrared
link.

3. On the computer, open Internet Setup Utility by sele@iagt->Programs->Aero
8000>Internet Setup Utility. A welcome screen appears.

Follow the instructions on the screen to begin the setup process.
5. When the profiling options screen appears, select the type of profiling you want:

* Express:Select this to automatically transfer your computer ISP profile to the Aero
8000 with very little involvement from you.

* Pre-Defined: Select this when you don't have any ISP information on your computer
or when you want a different ISP configuration for your device. With this option,
Internet Setup Utility gives you a pre-defined list of ISPs to select from.

NOTE: You may need to obtain the following information from your provider: ISP name, dial-
up number (country code + area code + number), server (TCP/IP) settings, authentication
data, Internet mail settings, proxy server settings for Web browser, and DNS (domain name
server). You may also need to provide a diskette of the latest script files for your ISP if
prompted by the program.

IMPORTANT:  Because Internet service providers often change their settings, the pre-
defined ISP profile you want may not be valid. If your provider has recently changed settings,
use the Custom ISP option to set up the profile. Contact your provider for assistance in setting
this up.

» Custom: Select this to modify or create your own ISP profile. Internet Setup Utility
guides you through the process, providing recommended configuration settings but
letting you modify them as needed. Be sure you have the following information from
your Internet service provider: ISP name, dial-up number (country code + area code +
number), server (TCP/IP) settings, authentication data, Internet mail settings, proxy
server settings for Web browser, and DNS (domain name server).

Once the necessary information is supplied, Internet Setup Utility begins the profiling pro-
cess. A progress bar appears on screen indicating that the profile data is being compiled
and transferred to your device.
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Printing

You can print files that reside on your Aero 8000 by:

connecting to a printer equipped with a serial port using the auto-sync cable or any
standard serial cable.

sending files through the IR port to an IR-equipped printer.

transferring files to a Windows CE—equipped computer and printing from the com-
puter.

using the Compag-recommended printing solutions found on the Internet at
WWWwW.compag.com

NOTE: When printing from the computer, Microsoft application files are printed using the print
defaults established in the computer version of the application.

Setting the Alarm

To remind yourself of important events, you can set the alarm on your Aero 8000 two dif-
ferent ways:

Outlook Calendar: To set an alarm for an event in your Calendar, add the calendar
entry you want to be reminded of, then set the alarm usirgehender box. For
more information on setting an alarm through the Calenda€aleadar

World Clock: To set a general alarm, open the World Clock application from the Con-
trol Panel, then select tiddarms tab.

To turn off an alarm once it sounds, press the alarm button on the front panel of your PC
companion.

Using the Backup and Restore Utilities

The Aero 8000 stores your personal information (data you have entered and third-party
applications you have installed) in the RAM (random access memory). However, a power
loss or other disruption of power can cause your data to be deleted from the device.

Your Aero 8000 provides you with several ways to protect against this kind of data loss.
You can:

back up data to the computer.
back up data to an ATA Flash RAM PC Card or CompactFlash card.

back up data to flash memory located in your Aero 8000. (Flash memory is an area in
your device that securely stores saved information even if there is a power loss.)
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You can back up and restore your Aero 8000 data using the following utilities:

* Microsoft Backup/Restore.For comprehensive and secured backup protection, use
this ActiveSync utility to periodically back up your data onto your computer's hard
drive. You can manually back up data or set this utility to back up automatically each
time you connect to your Aero 8000. For detailed instructions, see "Backup and
Restore" in the ActiveSync Help that you installed on your computer.

» Compaq Backup and RestoreFor comprehensive and convenient backup protec-
tion, these utilities let you back up and restore your entire Aero 8000 memory contents
to an ATA Flash RAM PC Card (purchased separately). You can then carry a PC Card—
based copy of your data with you at all times for quick retrieval. For more on this, see
the next topic, "Using Compaq Backup and Restore".

» Compaq Database BackupsWhen you do not have access to your computer or a PC
Card, use the Database Backups utility (preinstalled on your Aero 8000) to back up as
much data as possible onto your device. Use this utility for emergency backups when
the main and backup batteries are almost depleted. Depending on the amount of space
available in memory, your Contacts, Tasks, Calendar, and other application and system
data can be backed up. For more on this, see "Using Compaq Database Backups" later
in this section.

NOTE: To avoid losing your data in the event that your Aero 8000 is lost, stolen, or becomes
defective, Compaq recommends periodic backups to the computer or ATA Flash RAM PC Card.
Depending on your Aero 8000 usage, you may want to perform a backup as often as once a
day.

Using Compaq Backup and Restore

Use the Compaq Backup and Restore utilities to save the entire contents of your Aero
8000 memory to a PC Card, CompactFlash Card, or internal CompactFlash (purchased
separately), which can be carried everywhere your device goes for easy retrieval while on
the road.

NOTE: These utilities are designed for use with ATA Flash RAM PC Cards which are approved by
Microsoft as Windows CE 3.0 compatible. A minimum card size of 10 MB is recommended. For a
list of Compagq-tested PC Cards, visit the Aero 8000 home page at www.compag.com/products/
handhelds.

Backing Up Data

Each time you use the Compaq Backup utility, your data files, databases, preferences,
Windows CE system data, and applications are copied to the ATA Flash RAM PC Card.
The subdirectories on your Aero 8000 are also duplicated on the PC Card.
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To perform a backup, follow these steps:
1. Connect to external power or make sure that you have good batteries in your device.

2. Insert the ATA Flash RAM PC Card into the PC Card slot, or insert the CompactFlash
Card on your Aero 8000.

Double-click the Compaq Utilities icon.
Double-click the To PC Card icon.

At the prompt, close all active programs before proceeding.

o g M w

In the dialog box that appears, check Dual Backup if you want to operate in dual
backup mode. (Dual backup creates two top-level folders on the PC Card: \BackupA
and \BackupB. It toggles between these folders each time it copies data, thus retaining
copies of the last two backups that you have made. Single backup copies only to
\BackupA and always overwrites the last backup.)

7. Click theBackup button to begin the backup process.
8. When backup is complete, remove the PC Card and keep it close by for easy retrieval.
Backup Tips

* Use dual backup mode if you have sufficient space on your PC or CompactFlash Card.

» If you run out of space on your PC Card when using dual backup mode, delete the
\BackupB folder on the PC Card and use single backup mode.

Restoring Data

To restore data onto your Aero 8000, follow these steps:

1. Reset your Aero 8000 to its original factory settings by following the procedure in
Resetting Your Aero 8000

2. Turn on the Aero 8000 and insert the ATA Flash RAM PC Card into the PC Card slot
or the CompactFlash Card slot.

Run the Restore utility by double-clicking the Compag Utilities icon.

Double-click the From PC Card icon.

Follow the instructions that appear on the screen.

When the restore process is complete, press the reset button to restart your device.
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Set the correct time and date using the World Clock applet in the Control Panel.

If Errors Occur

If Restore detects that you don't have a good backup file from which to perform the
restore, you can still perform a manual restore by copying selected files and folders from
your PC Card to your Aero 8000.

For more information on this and other errors, visit the Compaq web sitevatom-
pag.com/products/handhelds
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Using Compaq Enhanced Security

To help protect against unauthorized use of your Aero 8000, four levels of password secu-
rity are provided.

IMPORTANT:  For immediate protection, Compaq recommends setting up the first two levels of
security (login password and password reminder) through the Password utility in the Control Panel
of your device.

For a detailed explanation of the four levels of Compaq security, read the following topics
in this section.

Understanding the Password Levels

Login Password: The most basic level of protection. If set, your login password or the
administrator password must be entered to access Windows CE. This occurs each time
you turn on your device (provided you have not set the password delay feature). You
are allowed five attempts to enter this password. If the correct password is not entered
on the fifth attempt, one of two things happens:

» If you set a password reminder, the Compaq Password Reminder screen appears.

» If you did not set a password reminder, the device prompts you to erase your pass-
words and all of your data, or to enter one of two lockout modes (Lockout or
Administrator Lockout). See the following sections for more on this.

Password Reminder:If set, this screen appears after you have made five unsuccess-
ful attempts in a row to enter the login password. It displays a question that you have
created, to which your response phrase or the administrator password must be entered.

You have five attempts to enter the correct response. If the correct response is not
entered on the fifth attempt, the device prompts you to erase your passwords and all of
your data, or to enter one of two lockout modes (Lockout or Administrator Lockout).
See the following section for more on this.

Lockout: If an administrator password has been enabled, the device enters Lockout
mode. To gain access to the device again, the administrator password or the unlock key
(a character combination) must be entered. After 10 unsuccessful entries in succes-
sion, the device transitions to Administrator Lockout mode.

Administrator Lockout: This mode occurs when all password attempts have been
unsuccessful. You will not be able to access your device until the unlock key is
entered.

IMPORTANT:  When the unlock key is used to gain access to your Aero 8000, your login pass-
word and the administrator password are removed. To reestablish security, you will need to reset
these passwords.
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Setting Passwords

For maximum security, you can set three different kinds of passwords on your Compaq
Aero 8000. All passwords are set through the Control Panel. The login password and pass-
word reminder are set in the Passwords application. Your login password must be
restricted to eight (8) characters or less. The administrator password can be up to 40 char-
acters in length.

NOTE: The passwords are not case-sensitive; however, any punctuation used when setting the
passwords must also be used when subsequently entering the passwords in order for the pass-
words to be recognized.

Setting the Login Password

To set your login password, follow these steps:

1. Onyour device, sele8tart->Settings>Control Panel and double-click the Pass-
word icon.

Select th®©wner tab.

. If a password has been previously set, enter that passwordHagkeordbox, and
click Check Passwordo verify it. This gives you access to the remainder of the Pass-
word application. This step is necessary only if a password has been previously set.

4. To set a new password or change an existing password, type the new password into the
New Passwordbox, then into th€onfirm Password box.

5. Save your new settings by clicki@i .

Your login password is now set. The login password screen will appear each time your
turn on your device, provided you have not enabled the password delay feature.

Disabling Power-On Security

You can disable the power-on security feature. Clearingtiadle Power On Security
check box in the Password Properties screen prevents the system from displaying a pass-
word security screen when you power on the Aero 8000.

NOTE: When you disable power-on security, the system erases your password and displays a
warning. Erasing your password prevents accidental lockouts by those who use this feature and
forget their system passwords. Although asterisks (*) still appear in the password fields of the
Password Properties screen, there is no retention of your system password.
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Enabling SmartCard Security

To set SmartCard security, follow these steps:

1.

a M DN

On your Aero 8000, seleStart-> Settings>Paneland double-click th@assword
icon.

Select th®©wner tab.

SelecEnable SmartCard Security.

Insert the SmartCard into the SmartCard slot on the Aero 8000.
Click OK.

Setting the Password Reminder

To set the password reminder, follow these steps:

1.
2.
3.

7.
8.

SelectStart>Settings>Paneland double-click the Passwords icon.
Select th®©wner tab.

In thePasswordbox, type the login password you previously set. Asterisks will
appear as you type.

Click theCheck Passwordbutton to verify the password and gain access to the other
password fields.

In theReminder Questionarea, type a question to which only you know the answer.
The question may be up to 80 characters long, and should be something to which the
answer can be easily recalled.

Type the answer in tidew Responsdox. The answer may be up to 40 characters
long. Asterisks will appear as you type.

Retype the answer in tidonfirm Responsebox.
Save your settings by clickir@K .

Your password reminder is now set. Remember, the password reminder screen appears
only after five incorrect login passwords are entered in a row.
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Setting the Administrator Password

To set the administrator password, follow these steps:
SelectStart->Settings>Control Panel and double-click the Password icon.
Select thédministrator tab.

Type the password in temin Passwordbox.

w0

Click theCheck Passwordbutton to verify the password.

NOTE: If you are updating your administrator password, you will be prompted to enter your
original administrator password before being allowed to create a new one.

5. Save your settings by clickir@K .
The administrator password is now set.

IMPORTANT:  When the login password is enabled in conjunction with this password, the
administrator password can be used to access the Aero 8000 at any level of password security
except Administrator lockout mode.

Setting the Password Delay Feature

The password delay feature allows you to temporarily bypass the login password screen
that appears each time you turn on your Aero 8000 device. This gives you immediate
access to Windows CE when you turn on the device. The login password screen can be
bypassed up to four hours from the last time the login password was entered. To set the
password delay feature, follow these steps:

1. SelectStart->Settings>Paneland double-click the Password icon.
2. Select th®©wner tab.

3. In thePasswordbox, enter the login password you previously set. Asterisks will
appear as you type.

4. Click theCheck Passwordbutton to verify the password and gain access to the other
password fields.

5. Use the drop-down list box to select the amount of time you wish to temporarily
bypass the login screen: 15 minutes, 30 minutes, 1 hour, 2 hours, 3 hours, or 4 hours.

When the time has expired, the login screen will appear the next time your turn on your
device and you will be prompted to enter the login password.
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Using the Unlock Utility

The Compaq Unlock utility is part of the enhanced security built into your Aero 8000. Use
this utility to generate a special code that allows you to regain access to a handheld unit
that has entered either Lockout or Administrator Lockout mode.

NOTE: It is recommended that H/PC owners who use the enhanced security features obtain a
copy of the Compagq Unlock utility before they encounter a lockout situation.

Lockout mode results when a user fails to enter a valid password in all security levels. The
handheld PC displays the following message:

"This H/PC has entered Administrator Lockout mode, because you failed to enter a valid
password. You will not be able to use this H/PC until it has been unlocked using the Com-
pag Unlock utility."

The Compaq Unlock utility runs on your desktop PC. The utility requires the user to enter
special data displayed on the screen of the locked H/PC. It generates an alphanumeric
unlock code which, when entered in the H/PC, releases it from Lockout mode.

NOTE: The Compaq Unlock utility is case-sensitive; therefore all alphanumeric characters must
be entered exactly as displayed.

The Compaqg Unlock utility is available for a nominal fee through the Compaq At Home
web site. To purchase a copy:

Open the URIhttp://goesd.com/compan your web browser.

Click Handheld underCategories

Click View all Handheld titles.

Scroll to the bottom of the page and click et button.

Scroll to theCompaqg Unlock Utility and click on it.

Click theADD button to purchase a copy and download it at your convenience.

N o g bk~ wDd e

Install the Compaq Unlock utility on your desktop, so that it will be available when
needed to recover from Lockout mode.

Using Compaq Database Backups

To use the Backup/Restore utility, follow these steps:
1. Double-click the icon in the system tray to open the utility.

2. A popup box appears with three choid@ackup, Restore andDelete Latest
Backup. Select an option to manually perform any of these database operations.
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Using the Dictionary Synchronizer

The Dictionary Synchronizer lets you synchronize the custom dictionary used in
Microsoft Word with the custom dictionary used in Pocket Word on your Aero 8000. Shar-
ing a custom dictionary is useful when performing spell checking in either application.

To synchronize dictionary terms, follow these steps:
1. Be sure the Dictionary Synchronizer is installed on your computer.

2. Connect the auto-sync cable or establish an IR link between the computer and Aero
8000.

3. On the computer, seleStart=>Programs>Compaq Utilities>Dictionary Synchro-
nizer.

4. Inthe screen that appears, se®aichronize
5. A status indicator appears while the synchronization occurs.
6. When synchronization is complete, click K button to close the application.

Your custom dictionaries are now synchronized. You can update the dictionaries at any
time by repeating this process.

Database Backups Control Panel Application

Use the Database Backups Control Panel application to specify periodic backups of data.
To use Database Backups, follow these steps:

1. SelectStart->Settings>Control Panel and double-click Database Backups. The dia-
log box appears.

2. Select Database Backups. Backs up the Contacts, Tasks, Calendar, Appointments, and
selected system data directly to your Aero 8000 so that this information can be easily
retrieved in case of a power failure or other disturbance to the system. Using Database
Backups, you can also:

» Specify the number of days between backups. The default value is 7 days.

» Enable or disable the Auto Backup feature. Auto Backup tells the system to perform a
database backup each time it transitions from battery power to AC power, provided
that at least 12 hours have elapsed since the last backup was done. Using Auto Backup
decreases the number of periodic backups that must be performed while using battery
power.

* View the date and time of the last backup, as well as the amount of space occupied by
the current backup.

Asset Viewer Control Panel Application

Use the Asset Viewer Control Panel application to track and manage information unique
to your Aero 8000.
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To use Asset Viewer, follow these steps:

1.

SelectStart-> Settings> Control Panel and double-click Asset Viewer. The dialog
box appears.

Select Asset Viewer. Provides information specific to your Aero 8000, such as model
number, serial number, and memory size. This information is useful when making a
technical support phone call and to give system administrators the data needed to
understand their inventory.

Using the Internet Favorites Synchronizer

The Internet Favorites Synchronizer lets you share favorite Internet addresses (book-
marks) between the browser on your computer and the browser on your Aero 8000. Using
this program, you can:

synchronize bookmarks (put the same list of bookmarks and folders on the computer
and Aero 8000).

copy selected bookmarks and folders by dragging and dropping them between the two
devices.

NOTE: The Internet Favorites Synchronizer only works with Microsoft Internet Explorer and
Netscape Navigator.

Synchronizing Bookmarks

To synchronize the bookmarks and folders on both devices, follow these steps:

1.
2.

Be sure the Internet Favorites Synchronizer is installed on your computer.

Connect the auto-sync cable or establish an infrared link between the computer and
your device.

On the computer, open the application by sele@iagt>Programs-> Utili-
ties>Favorites Synchronizer

From the Bookmark menu, place a check mark next to the Internet browser (Explorer
or Netscape) installed on your computer.

Click Synchronizeto begin the synchronization process. A status indicator appears on
the computer screen to track progress.

NOTE: To determine the currently selected communications port and the connection status,
select Communications from the Bookmark menu.
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Copying Bookmarks

To copy selected bookmarks or folders from one device to another, follow these steps:

1.
2.

Be sure the Internet Favorites Synchronizer is installed on your computer.

Connect the auto-sync cable or establish an infrared link between the computer and
your device.

On the computer, open the application by sele@iagt->Programs>Compaq Util-
ities=>Internet Favorites Synchronizet

From the Bookmark menu, place a check mark next to the Internet browser (Explorer
or Netscape) installed on your computer.

Using the mouse, drag and drop the item(s) you want to copy from one pane to
another. (The left pane represents the Pocket Internet Explorer, the right pane repre-
sents your computer Internet browser.)

An indicator appears on the computer screen as the files are copied from one device to
another.

Using a SmartCard

A SmartCard is similar in size and shape to a credit card, but it includes a small computer
chip used for storage. This chip stores your passwords and owner information and allows
you to take your personal access information on the road.

Simply insert your SmartCard into the SmartCard slot on your device and the system
allows you access depending on the login password information contained on the card.
You can seledEnable SmartCard Securityin the Password Properties dialog box to
require the system to store information on a SmartCard. If SmartCard security is enabled,
you may insert the SmartCard instead of entering a password. For more information, see

Using Compag Enhanced Security
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Controlling Volume

WARNING: To reduce the risk of personal injury, turn down the volume before putting on head-
phones.

Using the internal audio features on the Aero 8000, you can record and play back sounds
in digital audio files.

To adjust the playback level and speaker volume adjust the volume through Volume &
Sounds Properties in the Control Panel or by using the function keys on the keyboard.

NOTE: When the volume is muted, system beeps are still audible.
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chapter 7

USING INFRARED

Introduction

The built-in infrared (IR) port on your Aero 8000 provides a convenient, "wireless" way to
send and receive data. Through the lens on the right side of the device, an invisible beam
of IR light creates a point-to-point link with other infrared-equipped devices such as com-
puters, printers, and other Aero 8000s.

Establishing an Infrared Connection

Establishing an infrared connection involves three steps:

» Step 1: Configure the software
» Step 2: Set up the infrared devices
» Step 3: Transfer information

Step 1: Configure the Software

To set up the IR communications ports on the sending and receiving devices, refer to
"Connecting with an Infrared Port" in the ActiveSync Help that you installed on your
computer.
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Step 2: Set Up the Infrared Devices

To prepare for IR communication between your Aero 8000 and another IrDA-compliant
device, follow these guidelines:

» Be sure the IR ports on both devices are turned on and facing each other at a distance
no greater than one meter (3.28 feet) and no less than 5 centimeters (2 inches) apart.

» Aim the ports directly at each other. (The maximum capture angle is 30 degrees. Do
not point one port more than 15 degrees away from the center line of the other port.)

* Remove all obstacles between the IR ports.

» Certain types of fluorescent lamps can interfere with IR communication. If this hap-
pens, turn off the lights or move to another location with different lighting.

* When transmitting to another device, seReteiveon the Windows CE Explorer File
menu of the receiving device before sending.

* When transmitting to a computer or another mobile device, make sure that each device
has a unique computer (machine) name. See the online Help for the operating system
you are using for instructions on assigning a computer name.

Step 3: Transfer Information

Your Aero 8000 is designed to transfer information to other computers and devices that
have Windows CE installed.

To transfer files from your Aero 8000 once the devices have been properly set up, follow
these steps:

1. On the device sending the file, go to Windows CE Explorer and select the file you
want to transfer.

2. On theFile menu, selectend To> Infrared Recipient to begin the transfer process.
A dialog box appears on screen displaying the status of the file as it is sent. The trans-
ferred file will be stored in the root folder of the Windows CE Explorer.

NOTE: It may take several attempts before the devices establish an IR connection and begin
transferring information.

Printing with the IR Port

Your Aero 8000 can print directly to a printer equipped with an IR port. You can print the
following kinds of information from your device:

* Pocket Word, Pocket Excel, and Pocket Power Point files

» Contacts and Tasks lists

» A view of your schedule or agenda in Calendar

* Inbox messages

For more information about printing, see the ActiveSync Help that you installed on your
computer.
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chapter 8

USING THE MODEM

Introduction

Depending on your geographic region, your Aero 8000 may include a built-in modem for
making dial-up connections over an analog telephone line (the kind used in most homes
and offices). You can use the modem to send and receive e-mail, explore the Internet, send
faxes, and connect to other services. Additional software and services may be required in
order to perform some tasks.

NOTE: If your model does not have an internal modem, you can use a PC Card modem or an
external modem to perform modem tasks. For information on using a PC Card with your Aero
8000, see Using PC Cards.

Safety Precautions for Modems

Always follow these basic safety precautions when using a modem or telephone that is not
cordless.

WARNING: When using this device, basic safety precautions should always be followed to reduce
the risk of fire, electric shock, and injury to persons, including the following:

» Do not use this product near water, for example, near a bath tub, wash bowl, kitchen
sink or laundry tub; in a wet basement; or near a swimming pool.

* Avoid using this product during an electrical storm. There may be a remote risk of
electric shock from lightning.

* Do not use this product to report a gas leak in the vicinity of the leak.

» Use only the power cord and batteries indicated in this manual. Do not dispose of bat-

teries in a fire. They may explode. Check with local codes for possible special disposal
instructions.

» If this product was not provided with a telephone line cord, use only No. 26 AWG or
larger telecommunication line cord in order to reduce the risk of fire.

* SAVE THESE INSTRUCTIONS.
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Connecting the Modem

To connect the built-in modem, follow these steps:
1. Open the modem jack cover (indicated by a telephone icon).

2. Plug one end of the modem cable that came with your Aero 8000 into the analog tele-
phone jack.

3. Plug the other end of the modem cable into the telephone jack.

;é-l

4. Establish a dial-up connection through the Remote Networking application. (Select
Start->Programs>Communications>Remote Networking)

NOTE: For information on the software and COM port settings needed to create a dial-up connec-
tion, refer to the ActiveSync Help that you installed on your computer.
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Accessing the Internet

To use the Internet with your Aero 8000, you will need to do the following:
1. Connect and configure your modem.

2. Establish an Internet Service Provider (ISP) profile using the Internet Setup Ultility.
(SeeUsing Compag Softwaydéor more information.)

3. Make a dial-up connection by selectBigrt->Programs>Communica-
tions=>Remote Networking

Browsing the Internet

Browsing the Internet on a mobile device can be different from browsing it on a desktop
PC. Below are some tips for using the Internet more efficiently with your Aero 8000.

* The Aero 8000 does not support large amounts of graphics. To avoid problems while
browsing, disable th8how Picture option in Pocket Internet Explorer. This allows
you to open web pages that contain graphics without the graphics being displayed.

» Performance with (and support for) Windows CE varies among Internet service pro-
viders. If you experience difficulty accessing the Internet, call your service provider to
determine if they support the Windows CE 3.0 operating system. For more informa-
tion on accessing the Internet, see the ActiveSync Help that you installed on your com-
puter.
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International Usage with TravelSafe

TravelSafe is an application designed to diminish the need to enter manual modem dialing
strings when traveling internationally. You select the country where you will be using your
modem, and TravelSafe adjusts your modem's settings for you. In countries not on Travel-
Safe's selection list, you can still use your Aero 8000's modem by manually entering the
appropriate dialing strings.

TravelSafe can be found in t@®mpaq Utilities folder or:

1.

Click onStart->Programs>Communication and then selediravelSafe A Travel-
Safe dialog box appears.

Select from the drop-down list M Port on which your modem is installed.
TravelSafe's default SOM Port 6, which is where the Aero 8000's internal modem

is installed. If your Aero H/PC does not have an internal modem installed, you can still
use TravelSafe by installing an approved PC Card modem. In this case, select the
COM Port that is assigned to the PC Card modem.

Select from the drop-down list t®untry where you intend to use your modem.
After TravelSafe has properly set up the modem, the flag of the country you have
selected will be displayed in the lower right-hand corner of the TravelSafe application.

Click onApply. TravelSafe will attempt to communicate with your modem to set the
necessary modem properties according to your selections. If you receive an error mes-
sage, verify that the COM Port you selected is correct, and try again. Once the selec-
tions have been set, they can be changed by repeating steps 1 - 4 in these instructions.

Click on theHide button to put the TravelSafe icon in your System Tray. To close
TravelSafe, double-click the TravelSafe icon in the System Tray to maximize the
application, and then click on the "X" in the upper right-hand corner.
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chapter 9

USING PC OR COMPACTFLASH CARDS

Introduction

Your Aero 8000 comes equipped with a versatile feature that allows you to connect credit
card-sized options called PC Cards (PCMCIA Cards) or CompactFlash Cards. These cards
expand the capability of your Aero 8000 by providing modem, network, ATA flash stor-
age, and other capabilities. Because they are small and light-weight, these cards are
mobile.

Supported PC Cards

There are three types of PC Cards, each of which vary in thickness (Type I, Type Il, and
Type Ill). The PC Card slot in your device accommodates only Type | or Type Il PC
Cards. In addition, the Aero 8000 supports 16-bit PC Cards only.

Some PC Cards consume large amounts of power. When a PC Card drains too much
power from the batteries, the Aero 8000 automatically shuts down to protect against data
loss.

To avoid draining the batteries when using a PC Card with your Aero 8000, do the follow-
ing:

» Connect the device to external power.

* Use lower-voltage PC Cards, which consume less power.

For a list of PC Cards that have been tested and approved for use with the Aero 8000, visit
the Aero 8000 web site atww.compag.com/products/handhelds
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PC Card Software

Your Aero 8000 automatically recognizes a wide range of PC Cards approved for use with
Windows CE. If you are instructed to install card-specific device drivers provided by a PC
Card manufacturer, be sure to install only device drivers specifically designed for Win-
dows CE. Do not install card and socket service enablers. If you are unclear about installa-
tion instructions, call your PC Card manufacturer for more information.

Operating Guidelines

* Do not save data to a PC Card when the batteries on your device are low, as this can
result in loss of data. Be sure the batteries are in good condition or connect to external
power before attempting to save your data.

* Do not turn off your device while the PC Card is performing an operation (such as sav-
ing data), as this can result in data loss.

* Do not eject a PC Card while it is performing an operation, as this can result in data
loss.

* Do not expose the PC Card to dirt, moisture, or liquids.
» Always carry PC Cards in protective cases or sleeves when they are not being used.
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Inserting a PC Card

To insert a PC Card, follow these steps:

1. With the 68-pin connector facing in and the label containing the arrow facing up,
insert the card into the PC Card slot.

2. Gently push the card into the slot until it is seated. If inserted correctly, the card is
ready to use right away.

CAUTION: Forcing a PC Card into the PC Card slot can damage the slot.

Y~

Removing a PC Card

You do not have to stop a PC Card from running before removing it from the card slot.

However, you should wait until a PC Card operation is complete before attempting to
remove the PC Card.

To remove a PC Card, follow these steps:

1. Press the PC Card eject button next to the PC Card slot until the eject button pops out.
2. Press the PC Card eject button and remove the PC Card.

Using PC or CompactFlash Cards 9-3



Installing the Internal CompactFlash Memory Card

WARNING: Use only Compag-approved memory cards in your Aero 8000. Using an unapproved
card may damage your device.

WARNING: Disconnect all power to the device before installing the memory card. Failure to do so
can damage the equipment and expose you to the risk of electrical shock.

CAUTION: Electrostatic discharge can damage electronic components. Before touching any part
beneath the keyboard, be sure you are discharged of static electricity by touching a grounded
metal object.

To install an internal memory card, follow these steps:

1. Back up your Aero 8000 data onto the computer using the Microsoft Backup/Restore
utility.

2. Turn off the Aero 8000 by pressing the power button.
Disconnect the device from external power.

Remove the main and backup batteries. (The backup battery compartment screw is
attached to the backup battery cover and does not come out.)

5. Wait at least 5 minutes until all residual power is gone.
Lift the Aero 8000 lid.
Begin removing the keyboard by pressing up on the three tabs holding the keyboard in
place.

CAUTION: The keyboard is attached to the unit by a ribbon cable. Be sure not to damage the
cable when manipulating the keyboard.
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8. Tilt the keyboard up from the top and pull toward the screen to free the bottom portion
of the keyboard.

0w

° /,

WARNING: The Compagq internal CompactFlash card should be installed label side down. The
card has grooves to prevent improper installation. Do not force the card into the slot as damage
may occur to the card or your Aero 8000 device.

9. Place the keyboard face down on the unit, leaving the cable attached.

10. Align the holes on the module with the gold pins in the internal memory card slot and
push the module into the slot until it is connected.

11. Replace the keyboard by aligning the tabs on the bottom of the keyboard and tilting
the keyboard into place.

12. Snap the three top tabs to secure the keyboard.
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13. Reinstall the main and backup batteries and replace the battery covers.
14. Press the power button to turn on the device.

15. Restore the backup data onto your Aero 8000 using the Microsoft Backup/Restore
utility.
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chapter 10

REMOTE GONNECTION

Introduction

In order to establish communications between your Aero 8000 and your desktop PC, you
first need to install ActiveSync on your PC. ActiveSync allows you to synchronize, back
up and restore your device, add and remove programs from your device, and copy data
between your device and your PC.

Once ActiveSync is installed on your desktop PC, you are prompted to create a partner-
ship with your handheld device using a serial cable connection. After the partnership is
created, you can set up additional connections for your varied mobile computing needs:

If you have a modem connected to your device and you have a RAS account, you can
establish a dial-up network connection to your PC. Connect through a RAS server if
you need to connect remotely and you don’t have a dedicated modem on your PC.

With an Ethernet card for your mobile device, you can connect directly to your PC
through a network on which you have an account without using a modem. You need to
be in a location where you can connect to the network's cable system.

If you have modems installed on both your mobile device and desktop PC, you can
establish a PC modem connection between your device and PC. Connect by modem
when you want to synchronize or transfer data while you are away from your PC with-
out going through a network.

If your device is not equipped with a built-in modem, you need to install a compact
flash card modem or external modem in order to use a RAS or PC modem connection.
See your modem manufacturer's instructions for details on installation. Once the com-
pact flash card modem or external modem is installed, create a RAS or PC modem
connection.

NOTE: Connect to your PC using one type of connection at a time. Multiple connections to
your PC can't be accomplished simultaneously. In order to synchronize with your PC through a
network or PC modem connection, you computer needs to be powered on, and Microsoft Out-
look or Exchange needs to be running.
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Connecting to Your PC through a Network

Creating a Network (Ethernet) Connection

NOTE: You must have a NE2000 Compatible Ethernet card.

On your device, insert the Ethernet card.

SelecObtain an IP address via DHCPin the NE2000 Compatible Ethernet Driver
Settings dialog box.

Click OK.
SelectStart-> Settings> Control Panel and double-click the Network icon. Select the

Adapters tab.

Select NE2000 Compatible Ethernet Driver.

Select theédentification tab. Enter thé&Jser Name Password andDomain name
you use to log on to your PC.

Open the Mobile Device folder, cli¢kle and make surEnable Network Connec-
tion is checked.

You do not need to make a new connection on your device for the Ethernet card. When
connecting, simply seledtetwork Connection. If you want to synchronize with your
desktop PC using an Ethernet card, leave your PC running while your are away. You do
not need to leave your PC running in order to connect to a remote network.

Creating a Dial-Up Network Connection

Ask you network administrator to create a RAS account. Once the account is set, ask you
network administrator for the following information: dial up phone number, password,
and computer name.

1.

SelectFile>Enable Network Connectionfrom the Mobile Devices folder on your
desktop PC.

Make a new connection on your device using the information in step 1. You should be
able to use the default TCP/IP settings provided in the Make New Connection wizard.
If you can't connect using these default settings, contact you network administrator for
specific TCP/IP information.

If you want to synchronize with your PC, your PC must be left running. You do not need
to leave your PC running in order to connect to a remote network.
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Creating a New Connection on Your Device

You must create a connection for each computer or network that you want to access
remotely, unless you are using an Ethernet card. When using an Ethernet card, simply
selectNetwork Connectionin the ActiveSync dialog box.

1.

a r~ 0N

7.
8.

SelectStart->Programs>Communication>Remote Networking
Double-click the Make New Connection icon.

Enter a name for the connection in the Make New Connection dialog box.
SelecDial-Up Connection and click theNext button.

Select the modem you want to use and diokfigure. Use the default settings pro-
vided underConnection Preferenceslf you can't connect using these setting, see
your ISP or network administrator for specific information. If you want to always
enter a phone number before connecting, séactual Dial. SelectOK.

Select TCP/IP Settings. In tleneral tab, make sure Use Server-assigned IP address
is checked. In th&lame Servergtab, make sure Use Server-assigned addresses is
checked, and sele@K. If you are unable to connect with these default settings, see
your ISP or network administrator for specific TCP/IP information.

Select théNext button and type the telephone number.
Select thé&inish button.

The connection you just created appears as an icon in the Remote Networking folder.

The connection appears as an icon on the Connections screen. If you are creating a PC
modem connection for an external modem, select Hayes Compatible on COM1 as your
modem. When connecting your device to your PC using an external modem, use the
modem cable or adapter provided by the manufacturer of your modem.

Preparing the Remote Computer

Make sure your PC and/or network server is available for communications, as described
below:

The PC must be turned on. Schedule+, Exchange, or Outlook must be running with
your user profile.

In the lower right corner of the Mobile Devices window, the connection status must
show Waiting for mobile device to connect.

In the ActiveSync Options dialog box in ActiveSync, synchronization must be

enabled. (Or you can selestitomatically synchronize if data is out-of-date.)

If you are communicating through a modem connected to the PC, the modem must be

turned on. Also, théuto Connectshould be set to At all times in ActiveSync. Other-
wise, a Mobile Devices window must be open in order to synchronize remotely.
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* If you are communicating with the PC via a RAS connection or Ethernet LAN, you
must be logged on to the network on the remote computer. Before you leave make sure
Enable a network connection is selected in the ActiveSync Properties dialog box.

See ActiveSync Help for more information on configuring ActiveSync.

NOTE: When connecting to an Internet service provider or corporate network using Ethernet, the
server must be running before a connection can be made. If the telephone number is busy, or if
static causes a disruption, wait a minute and try again.

Synchronizing using a Remote Connection

When accessing a computer or network remotely, you must prepare a head of time so that
communications run smoothly.

1. Connect the phone line to your device's internal or external modem. If you are using
an Ethernet card, insert the card into your device.

SelectStart->Programs>Communication->ActiveSync

Select the connection you created for the remote computer fradhtiose a method
to connect to the selected P@st. If you are using an Ethernet card, select Network
Connection.

4. Select the desktop PC from tGennect tolist.
5. Enter your user information and sel€cnnect

To update after the initial synchronization, sef&gc Now To disconnect, seleBiscon-

nect To close the connection, double-click the Communications icon in the taskbar, and
then selecDisconrect. If you are synchronizing with a PC running Windows NT, do not
enter a domain name in tB®main field of the User Logon dialog box.

If Network Connection doesn't appear when using ActiveSync with an Ethernet card, wait
a few minutes and try again. If it still doesn't appear, reset the device and try again. If you
receive an error statingConnected, synchronization error. Combine/Discard required on
the desktop computeror if some items stay out-of-date after synchronization, you will
need to synchronize directly with your PC using a cable or infrared. You will need to
enable the synchronization service for files, Inbox messages, and channels. For more
information, see individual programs' help files on your device or ActiveSync Help on
your PC.
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Connecting to Your PC through a Modem

Creating a Connection to a Modem Attached to Your PC

1. Follow the modem manufacturer's directions to install a modem on your PC.
Note the telephone number for your PC modem.

Open the Mobile Devices folder on your PC.

Selecfile>Communications

a M DN

Select your modem from tiiorts list under Device Connections via Serial Port. If
your modem isn't listed, clickistall New Port to add it to the list.

SelectEnable mobile device connection

SelecEnable in both Device Connections via Serial Port and Device Connections
via Network Enabled.

8. Make a new connection on your device using the information in step 2.

If your PC is running Windows 95, you will need to install Dial-Up Networking Upgrade
1.2. If your PC is running Windows 95 and User Level Access is enabled in Dial-Up Net-
working, you must create a user account. If your PC is running Windows 98, you must add
a second dial-up adapter. For more information, see ActiveSync Help on your PC.

Creating a New Connection on Your Device

You must create a connection for each computer or network that you want to access
remotely unless you are using an Ethernet card. (When using an Ethernet carbleselect
work Connectionin the ActiveSync dialog box.)

SelectStart->Programs>Communication->Networking.

Double-click the Make New Connection icon.

Enter a name for the connection in the Make New Connection dialog box.
SelecDial-up Connection.

Select théNext button and select the modem you want to use.

SelectConfigure.

N o g b~ wDd R

Use the default settings und@onnection Preferenceslf you cannot connect using
these settings, see your ISP or network administrator for specific information. If you
want to always enter a phone number before connecting, Bacatl Dial and click
OK.

8. Select TCP/IP Settings. In teneraltab, verify that Use Server-assigned IP address
is selected. Veriffse Server-assigned addressesselected in thBlame Servers
tab.

9. SeleciNext followed byFinish.
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Connecting to the Internet

Introduction

Besides connecting to ActiveSync on your desktop PC, you can use your mobile device to
connect to the Internet. Connecting to the Internet allows you to browse the World Wide
Web (WWW) and exchange e-mail.

You need to install a CompactFlash card modem or external modem on your mobile
device, if your device is not equipped with a built-in modem. See your modem manufac-
turer's instructions for details on installation. When connecting your device to your PC
using an external modem, use the modem cable or adapter provided by the manufacturer
of your modem. Once the CompactFlash card modem or external modem is set up, set up
an Internet service provider connection.

Creating an Internet Connection

NOTE: PPTP accounts are not supported on your device.
Set up a Point-to-Point Protocol (PPP) account with the Internet service provider (ISP),
and obtain the following information:

» Telephone number
e User name
+ Password

Once you have an account, create a new connection on your device to the ISP. You do not
need to do any special configuration to ActiveSync on your PC. When creating this con-
nection you should be able to use all of the default TCP/IP settings provided in the Make
New Connection wizard. If you can't connect using the default settings, contact your ISP
or access your ISP's Web site for specific TCP/IP information.

Connecting to the Internet
1. Connect your device's modem to a phone line.
2. SelectStart>Programs>Remote Networking

3. Double-click the connection you have created for Internet connections.
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Connecting to a Network

Introduction

In order to synchronize with your PC while you are away from your office you must leave
your PC on and Microsoft Outlook or Microsoft Exchange running. There may be times
when this is not practical. You can connect directly to a network through a network or
RAS connection. You will be able to get your e-mail and browse the Internet, but you will
not be able to synchronize any other files or items. To receive e-mail, create either a POP3

or IMAP4 mail service in Inbox.

Connecting to a Remote Network

If you connect to a remote network, you will only be able to receive e-mail and browse the
Internet. To receive e-mail, create either a POP3 or IMAP4 mail service in Inbox.

1. SelectStart>Programs>Communications>Remote Networking
2. Double-click the remote connection icon you want to use.

3. The first time you connect using the connection, enter your user name, password and
domain. To prevent having to reenter your password on subsequent connections, select

Save password
4. SelectConnect To disconnect, seleBtisconnect

Adjusting Remote Connection Properties

Modifying Connection Settings
SelectStart->Programs>Communication->Remote Networking
Select the icon for the connection you need to modify.

Selectrile>Properties.

e N

Select desired options.
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Turning Off Software Compression

SelectStart->Programs>Communication->Networking.
Select the icon for the connection you need to modify.
Selectrile>Properties.

SelecfTCP/IP Settings

ClearUse software compressioim theGeneral tab.

o ok~ w D

Reset your mobile device according to the manufacturer's instructions.

NOTE: While turning off software compression shortens the time it takes to complete a connec-
tion, it also slows the rate of data transmission. Only turn off software compression if you connect
frequently and transfer small amounts of data in each session.

Changing the Baud Rate for Your Aero 8000

IMPORTANT:  Changing this setting may disable communications with your PC. Make sure the
baud rate you select for your device matches the baud rate on your PC. For more information on
changing the baud rate on your PC, see ActiveSync Help.

SelectStart>Settings>Panel

Double-click the Communications icon.

SelectChange Connectionin thePC Connectiontab.

P w NP

Select the desired baud rate.
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Using Terminal

Introduction

You can connect your device to an online service or corporate server that requires TTY or
VT-100 terminal emulation. Terminal allows you to, for example, view and download
files from a bulletin board or send and receive e-mail.

Use Terminal only when communicating with services that require terminal emulation. If
you use an Internet, RAS, or network connection, you can access information through syn-
chronization or by connecting directly to a network.

Creating a New Terminal Session

1. SelectStart>Programs>Communication->Terminal.
Double-click the Make a New Session icon.
Enter the name for the session in8@ssion Namdox.

Select the name of your modem in 8edect a Modenfist.

a pr WD

Enter the numbers for the remote computer irAtlea Code Telephone Number
andCountry Code boxes.

6. Selectorce long distanceor Force local dialing
7. Select OK to connect unless you need to adjust the emulation properties.

The session you created appears as an icon in the Terminal folder. To disconnect, select
File>Cancel

Connecting using an Existing Session

In the Terminal window, double-click the icon for the session you want to use. When your
H/PC has connected to the online service, the Terminal window appears.

You can create a desktop shortcut for the session, and connect by double-clicking it. To
disconnect, seleétile>Cancel

Adjusting Session Properties

1. Select the icon for the session you want to modify in the Terminal window.
2. Select théroperties button.

3. In theCommunicationstab, modify the settings as needed. SelecEthalation tab
to modify emulation settings.

4. Select the type of terminal to emulate in @@ose an emulation typdist.
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5. Select the code page option for the character set you wantGQodecpage selection
list.

Select to display text you type before sending irLtieal Echo box.
Set your font preference in thise small font by defaultbox.
Selectnbound or Outbound settings in th&€R->CR/LF box.

Set your scrolling preference in tAatomatic Scrolling box. ClickOK. To clear the
buffer, selecEdit->Clear Buffer.

© © N O
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chapter 11

SYNCHRONIZATION

Introduction

To establish communications between your Aero 8000 and your desktop PC, you first
need to install ActiveSync on your PC. ActiveSync enables you to synchronize (keep a
matching copy of data), back up and restore your device, add and remove programs from
your device, and copy data between your device and your PC. Once ActiveSync is
installed on your PC, you are prompted to create a partnership with your device using a
serial cable connection. After the partnership is created you can connect your device and
PC using a serial cable, an infrared device, a modem, or an Ethernet card.

You can share data between your handheld device and desktop PC by synchronizing or by
copying data. Synchronization allows you to update data between your device and com-
puter automatically. Any changes you make to the data in one location, including deleting
it, is mirrored in the other location the next time you synchronize. You can also copy data
between your device and desktop computer using drag and drop. Any changes you make
to copied data does not affect the original.

Some synchronized and copied data must be converted before you can work with it on
your mobile device. The conversion process may remove or change some formatting
attributes. For more information, see help topics for specific programs or ActiveSync
Help.
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Synchronizing Data

What gets Synchronized

ActiveSync provides many synchronization services. The synchronization services for
some programs are enabled automatically, while others must be enabled manually. To see
which services are enabled, open the Mobile Device window on your PC and select your
device. ClickTools>ActiveSync Options Synchronization services including a check

mark are enabled.

Depending on which programs are installed on your device, you may be able to enable
other synchronization services. For complete steps to enabling synchronization services,
see help files in specific programs on your device or ActiveSync Help on your PC.

Setting Up a Serial Cable Connection

If you are using default communication port settings, you should have established a serial
cable connection when you created a partnership. If you have changed any of your com-
munication port settings or are having problems connecting using a cable, follow these
steps:

1. Open the Mobile Devices folder in ActiveSync.
2. Click File and make surEnable Serial Connectionis checked.

3. Determine which communications port the cable is connected to on the back of your
desktop computer. This port should be labeled.

4. Click File and then clickCommunicationsin ActiveSync. In thd?ort list, click the
correct communications port.

5. Verify the baud rate is 19200. The baud rate selected on your PC displayBandhe
Rate field. It must match the baud rate selected on your device. If you have changed
the baud rate on one computer, change the baud rate on the other.

For more information on changing the baud rate on your desktop computer, see Active-
Sync Help.
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Synchronizing using a Serial Cable

The serial cable establishes a direct link between your mobile device and desktop com-
puter. You must use a cable connection when creating a partnership. Cable connections are
also handy when you are synchronizing many files and need access to your desktop com-
puter during transfer.

If you are using default communication port settings, you should have established a cable
connection when you created a partnership. While your device is on, connect the cable
between your device and your PC. PC Link is activated. Synchronization automatically
takes place if you selected eitl@@ntinuous or On Connectas your synchronization

option. If you selecteManual, in the Mobile Devices window on your PC, clitBols¢
Synchronize Now Connection Status lists the number of out-of-date items.

NOTE: If you are synchronizing with a PC running Windows NT, do not enter a domain name in
the Domain field of the User Logon dialog box.

Setting Up an Infrared Connection

To set up an infrared connection, you need:

* Your mobile device.

* A PC running Windows 95/98.

» ActiveSync compact disc.

» Drivers from you infrared adapter's manufacturer.

1. Install and configure an infrared port following the manufacturer's instructions on your
desktop PC.

2. Install the Windows 95 infrared driver. Insert the ActiveSync compact disc, and run
Setup.exe.

3. Click Optional Componentsfrom the ActiveSync Setup dialog box.

Run Setup.exe from the Setup Windows 95 Infrared Communications Driver v2.0
directory. When asked to specify a virtual port, choose a port that does not exist on
your PC (COMS usually works).

Open the Mobile Devices folder.
Click File=>Communications.

Click the virtual port you created. If the virtual port is not listed, dhskall New
Port to add the infrared port. If you install a new port, you may need to reinstall
ActiveSync.

Click Start-> Settings>Control Panel. Double-click the Infrared icon.

Click theOptions tab in the Infrared Monitor dialog box. Make smable infrared
communications onis checked.
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Synchronizing using Infrared (IR)

If you have an infrared (IR) port on your PC, you can quickly create a direct connection.
Simply align the IR ports and initiate the connection from your mobile device. This
method also allows you to switch quickly between multiple devices.

1.

S A

SelectStart-> Settings> Communicationsand click the PC Connection tab on your
Aero 8000.

SelectChange Connection

Selectnfrared Port .

Place the device within a few feet of the PC, lining up the IR ports.
SelectStart>Programs>Communication=>PC Link.

Close the connection by double-clicking the Communications icon in the taskbar, and
then selectingisconnect

NOTE: If you are synchronizing with a PC running Windows NT, do not enter a domain name in
the Domain field of the User Logon dialog box.

Copying Data

Copying Data to Your PC

1.

Establish a serial cable or infrared connection between your mobile device and your
PC.

Double-click your mobile device in the Mobile Devices window of your desktop PC.

Locate the file you want to transfer in the Explorer window.

4. Copy the file by dragging it from your PC to the Explorer window for your mobile

device.
Right-click the file and then clickut to move the file.

6. Open the folder where you want to move the file and Ele$tein the Explorer win-

dow for your mobile device.
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Copying Data to Your Device

1. Establish a serial cable or infrared connection between your mobile device and your
PC.

Double-click your mobile device in the Mobile Devices window of your desktop PC.
Locate the file you want to transfer in the Explorer window.

4. Copy the file by dragging it from your PC to the Explorer window for your mobile
device.

Right-click the file and then clickut to move the file.

6. Open the folder where you want to move the file and &lastein the Explorer win-
dow for your mobile device.

NOTE: To store the file on a CompactFlash (CF) card in your device, copy or move the file to the
CF card's My Documents folder.

Tasks

Introduction

Tasks helps you keep track of what you need to do. Enter the details for a task on the task
card. You can assign a task to a category, and if you associate a date with a task, you can
set a reminder for it. Overdue tasks display in bold. Mark tasks as complete when you fin-
ish them.

All active tasks (tasks that have a start date before the current date and are not marked
completed) are displayed in tAetive Tasksbox in the Agenda view of Calendar on your
device. If you use Schedule+ or Outlook on your PC, you can synchronize tasks between
your device and PC.
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Creating and Updating Tasks

Creating a Task

Enter the task name in the Select here to add a new task. Select the other columns in the
same row to set options such as due date. You can create a task with more details by
selecting théNew Taskbutton.

If you have Microsoft Team Manager installed on your desktop computer, you can select
Team Manager to identify the task as a Team Manager task. This task is added to your
Team Manager tasks when you synchronize with your desktop computer.

When using-ile>New Task you can add a note by selecting 8edect here to add
notesbox. You can also assign the task to a category by selecti@atbgoriesbutton.

Updating a Task
1. Double-tap the entry in the task list.
2. Make the desired changes.

Marking a Task Complete

Select the check box in tistatus column of the task list.

Deleting All Completed Tasks

SelectEdit>Delete Completed Tasks

Finding a Task

1. Selecflools>Find.

2. Enter the name, time, or other data you want to find. If you have looked for this item
before, select its name from the list.

3. Verify Tasks (all) or Tasks (recurring only) is listedlype.
4. Click Find Now.

Adding Notes

1. Select the Notes button in a task card and then select the Notes area.
2. SelecWiew and select an input method. Enter your notes.

When you are in the Notes area, the InkWriter input methods, formatting functions, and
editing functions are available to you.
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Organizing Tasks

Sorting Tasks

Select the column heading by which you want to sort. The triangle in the column heading
indicates ascending or descending order. To reverse the order, select the heading again.

Reordering Columns

1.
2.

Selecflools> Customize Columns

Select desired options.

You can resize columns in the task list by dragging the bar between column headings.

Reorganizing Categories

1.
2.
3.

SelectEdit>Category List.
Add a category by entering it in the New category box and clicking Add.

Delete a category by selecting it in the list and selecting Delete. Any items assigned to
deleted categories keep their assignments.

SeleciResetto restore the default categories. The categories you create in Tasks are
also available in Calendar and Contacts.

Displaying a Subset of Tasks

1.

Select the All Items button. If you have used the filter before, the button displays the
name of the category you used last.

2. Select the category you want displayed.
3. Select All Items to clear the category you selected in step 2. If no categories appear in

the list, you have not assigned any tasks to categories. Open a task, click the Category
button, and select the categories you want.

Printing Tasks

1. Selectrile>Print.
2. Select the printing options you waRort lists the available printer ports. If Network

is selected from thBort list, enter the path to the network printer in ket Path box.

Synchronization 11 -7



Adjusting Tasks Options

1. Selecflools>Options.

2. Select desired options. The Edit Panel allows you to quickly add and update tasks. To
view your task information in another font, cliChoose Fontand select desired
options.

Synchronizing Tasks

You can synchronize tasks stored on your device by using Schedule+ or Outlook on your
desktop PC. New items entered on one computer are copied to the other during synchroni-
zation. The Task synchronization service is automatically enabled in ActiveSync. When
you synchronize, typed notes from your device are added to your Schedule+ or Outlook
data, while handwritten notes and drawings are saved as metafiles (pictures) and added to
Outlook only.
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chapter 12

VoICE RECORDER

Introduction

Quickly capture thoughts and reminders, ideas, and phone numbers with Voice Recorder.
As you record or play back a recording, a progress bar and a status bar on the screen pro-
vide visual indications of the process.

If your device runs out of memory while you're recording, you'll hear several beeps and
see an out-of-memory message on your screen. You can adjust the allocation of memory
on your device by selectirfgtart-> Settings> Control Panel>Systemand selecting the
Memory tab. If you run out of memory frequently, you might consider buying a Compact-
Flash storage card for your device.

NOTE: Voice Recorder uses approximately 300 bytes per second for recording, using the Mobile
Voice format. For example, a 10-second note uses approximately 3K.

Creating and Managing Recordings

Selecting a Recording Format

1. Selecflools>Recording Format.
2. Select desired options.

Mobile Voice is a 2.4K audio codec (compressor decompressor). It is the recommended
format because it provides good voice recording and takes far less storage space than
PCM. Pulse Code Modulation (PCM) provides slightly better sound quality. However,
PCM recordings may take up to 50 times more storage space than Mobile Voice record-
ings.

Voice Recorder 12 - 1



Making a Recording
1. Hold your mobile device's microphone near your mouth or other source of sound.
2. SelectControl>Record New You'll hear a beep when recording begins.
3. SelectControl>Stop to stop recording.

The new recording appears in the recording list and is named Recordingx. If you selected
a folder before you made the recording, the recording name will be the folder namex.

You may also create a recording by simply pressing the external Record button. The LED
flashes while recording. Press again to stop recording.

Renaming a Recording

1. Select the recording from the recording list.
2. Selecfile>Rename

Modifying a Recording's Properties
1. Select the recording from the recording list.
2. Selectile>Properties.
3. Select desired options.

ChoosingNonefrom Folder stores the recording in the My Documents folder. To store the
recording on a memory card, insert the card into your device and then choose it from
Location.

Viewing a Recording's Status

View the status bar at the bottom of the recording list to see the selected recording's status.

Hiding or Showing the Controls

SelectTools> Show Controls

Transferring a Recording using Infrared

You can send a recording by selecting the recording, lining up the infrared ports, and
selectingFile>Send To receive a recording, line up the infrared ports, and select
File>Receive
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Playing Recordings

Playing a Recording

Select the recording.

SelecControl>Play to begin playback.

SelectControl >Pauseto pause playback. Seldeauseagain to resume playback.

P w NP

SelectControl > Stop to stop playback.

Playing Recordings Sequentially

1. Select the recording you want to play first.

2. SelecControl>Play Sequential The selected recording and the recordings after it in
the list are played back. A short beep sounds between recordings.

Rewinding or Fast Forwarding Recordings

Select the Back or Forward button. If you fast forward while the recording is playing, Fast
Playback is enabled. The recording plays back at an increased speed, but still is audible.
To use Fast Playback, the recording must be recorded in a codec that supports Fast Play-
back, such as Mobile Voice. For all other codec formats, check the manufacturer's docu-
mentation for more information.

Adjusting Playback Volume

1. Selecflools>Volume.

2. Drag the slider up to increase volume or down to decrease volume. The new volume
setting is also recorded in Volume & Sounds in control panel.
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Using Columns to Sort Recordings

Reordering Columns

1. Selecflools>Options and select th€olumns tab.
2. Select the columns you want displayed.

3. Select a column and selétbve Up or Move Downto move a column.

Sorting by Column

Select the column heading by which you want to sort. The triangle in the column heading
indicates ascending or descending order. To reverse the order, select the heading again.

Using Folders to Organize Recordings

Creating a Folder

1. Select the <All Folders> list on the toolbar.
2. Select <Edit Folders>.
3. SeleciNew

Moving a Recording to a Folder
1. Select or open the recording.
2. Selectile>Properties.
3. Select a folder from the list.
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Renaming a Folder

1. Select the <All Folders> list on the toolbar.
Selectdit Folders.
Select the folder to rename.

WD

SeleciRename

Deleting a Folder
1. Select the <All Folders> list on the toolbar.
SelectEdit Folders.
3. Select the folder to delete.
4. SelecDelete

no

Viewing Recordings by Folder

1. Select the <All Folders> list on the toolbar.

2. Select the folder whose recordings you want to view.

Changing Options for Voice Recorder

1. Selecflools>Options and tap the General tab.
2. Select desired options.

When Save to external card when available is selected, all new recordings are saved to the
installed compact flash card. To turn off beeps that sound when recordings start, clear
Enable beep feedback
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Synchronizing Recordings

Recordings are synchronized using the File synchronization service in ActiveSync. This
service is not automatically enabled. Once you enable it, your device files are automati-
cally synchronized with files in a folder on your desktop computer named device
name_My Documents.

You can view files in this folder by double-clicking your device icon in the Mobile
Devices window on your desktop computer. This folder is stored in one of the following
locations on your PC:

* Windows 95: My Documents\device name_My Documents

* Windows NT: WINNT\Profiles\your username\Personal\device name_My Documents
Voice Recorder files remain .wav files on both your device and your desktop computer. If
you mark a file as hidden on your desktop, the file is deleted from your device the next

time you synchronize. When you delete a file on either your desktop computer or your
device, the file is deleted in the other location the next time you synchronize.
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chapter 13

SETTINGS

Communications

Changing the Device Name

You can change the name of your Aero 8000 by seleStiaig-> Settings>Control
Paneland double-clicking the Communications icon. Enter the new name of the device in
theDevice Nametab.

Adjusting the PC Connection Setting

IMPORTANT:  Changing this setting may disable communications with your desktop PC.

1. SelectStart->Settings>Control Panel.
Double-click the Communications icon.

3. Select thé>C Connectiontab and make surlow connection with desktop com-
puter when device is attacheds selected.

4. SelectChange
5. Select a different connection or baud rate.
IMPORTANT: The baud rate on your Aero 8000 must match the baud rate on your desktop PC.

If you change the baud rate on one computer, you must change the baud rate on the other. For
more information on changing the baud rate on your PC, see ActiveSync Help on your PC.
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Dialing

Adjusting Dialing Location Settings
1. SelectStart->Settings>Control Panel.
2. Double-click the Dialing icon.
3. In the When dialing from list, select the location you want to change.
4

. To create a new location, cliddew. Enter the name of the location, and then click
OK.

5. Enter or edit the area code and local country code as needed.
6. SelecfTone or Pulsefrom Dial using. Most phone lines are tone.

You can automatically disable call waiting by selectngable call waiting by dialing
Then, select the appropriate number sequence in the list or enter a new sequence.

Adjusting Dialing Patterns

You can adjust dialing patterns by selectsigrt-> Settings>Control Panel. Open the
Dialing icon, and then selebialing Patterns. Using the codes listed in this topic, revise
the dialing patterns as needed.

If you need to use characters other than the ones listed in the Dialing Characters table, use
manual dialing. Hyphens and spaces in dialing strings are ignored. Some modems may not
respond to special characters, even though your device lets you add them to the dial string.

Dialing Characters

Table 19: Dialing Characters

To Enter

Dial country code (specified by the dialinge
program)

Dial area code (specified by the dialing | F
program)

Dial local number (specified by the dial-| G
ing program)

Insert a pause (typically 2 seconds) , (comma)

Wait for a credit card tone (specified by | $ (dollar sign)
the dialing program)
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Table 19: Dialing Characters

To Enter
Wait for a second tone (typically used | W
after the$)
Tone dial the following numbers
Pulse dial the following numbers P

Transfer to another extension (0.5 sec ¢
hook, 0.5 sec off hook)

n (hookflash)

Wait for “quiet answer” (typically indi-
cated by 6.5 seconds of silence followe
by a ringing tone)

)

@

Use special controls on some systems
(tone only)

ABCD or* or#
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Display

Selecting a Background Image
1. SelectStart->Settings>Control Panel.
2. Double-click the Display icon and then selectBlaekground tab.

3. Select an image you want from tingage list. Click Browseto locate an image in
another file.

To have the image cover the entire background, s€lkecimage on background

Changing the Desktop's Color Scheme

1. SelectStart->Settings>Control Panel.

N

Double-click the Display icon and then selectAlppearancetab.

w

Select a scheme from tBehemsdlist.

e

View your choice in th@review box. If you like the scheme, selegbply.

Creating a Custom Color Scheme

1. SelectStart->Settings>Control Panel.

Double-click the Display icon and then selectAlppearancetab.
Select a display item from tliem list.

Select the black square next to e list.

Select a color from thBasic colorslist and selecDK.

View your color selection(s) in thHereview box.

SelectSaveto save the scheme.

© N o g bk w D

Enter a name for the scheme in 8a&ve this color scheme asox and clickOK.
9. SelectApply.
NOTE: To create your own custom colors, select an empty square in Custom colors of the Color

dialog box and then select Define. For more information, click the question mark in the Color dia-
log box.
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Keyboard
1. SelectStart->Settings>Control Panel.
2. Double-click the Keyboard icon.

3. Adjust theRepeat delayslider to change the amount of time between depressions
before repetition starts.

4. Adjust theRepeat rateslider to change the repeat rate.

5. Test your new settings.

Touch Pad (Mouse)

1. SelectStart->Settings>Control Panel.
2. Double-click the Mouse icon.
3. Double-click the checkerboard grid at a comfortable speed.

4. Double-click the Test icon to test your settings.

Network

Changing Adapter Settings
Because most servers use Dynamic Host Configuration (DHCP), you should not need to
change these settings.

SelectStart->Settings>Control Panel.

Double-click the Network icon and select tkaapters tab.

Select the adapter and then selroperties.

To receive an IP address automatically using Dynamic Host Configuration (DHCP),
select thdP Addresstab and seledbtain an IP address via DHCP The network
configures TCP/IP information for your Aero 8000.

5. To specify the TCP/IP information for your device, seSgmcify an IP address
Enter the IP address, subnet mask, and default gateway obtained from you network

administrator.

6. If you have specified an IP address, select the Name Servers tab and enter Domain
Name System (DNS) and Windows Internet Name Service (WINS) IP address
obtained from your network administrator.

»p wnN
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Setting Up Identification for Remote Networks
1. SelectStart->Settings>Control Panel.
2. Double-click the Network icon and select the Identification tab.

3. Enter the user name, password, and domain name you use to log on to the remote net-
work.

Power

Checking Battery Power

You can check you battery power by selecttgrt-> Settings> Control Panel and dou-
ble-clicking the Power icon. Select tBattery tab.

NOTE: The Battery tab provides general information on battery condition. The amount of useful
operating time remaining varies depending on battery type and how you use your device.

Setting the Device to Turn Off when Idle
1. SelectStart->Settings>Control Panel.
2. Double-click the Power icon and select Bwver Off tab.
3. Select the desired options for suspending operation when not in use.

NOTE: Suspending operation helps conserve batteries.

Regional Settings
1. SelectStart->Settings>Control Panel.
2. Double-click the Regional Settings icon.

3. Select the tab for the type of information you want to change and select the desired
options. The available characteristics are determined by the region selected on the
Regiontab.
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Removing Programs
1. SelectStart->Settings>Control Panel.
2. Double-click the Remove Programs icon.
3. From theProgramsllist, select the program you want to remove.
4. SelecRemove

NOTE: If you are unable to remove a program, see ActiveSync Help on your PC or the program's
documentation for more information.

Taskhar

Hiding the Taskbar

The Taskbar that appears at the bottom of the Aero 8000 screen can be hidden by selecting
Start-> Settings> Taskbar and selectind\uto hide on theTaskbar Options tab. To dis-

play the taskbar, select the narrow horizontal bar at the bottom of the window. To hide the
taskbar again, select outside the taskbar.

Changing Taskbar Settings
Change taskbar settings by selectgrt-> Settings> Taskbar and selecting the options
on theTaskbar Options tab.

Modifying Start Menu Items

You can modify the items appearing in the Start menu by seletiamg> Set-
tings-> Taskbar and selecting th8tart Menu tab. SelecAdd, and select the program
you want to add.

NOTE: Programs added to the Start menu no longer appear on the Programs menu. To move a
program from the Start menu to the Programs menu, select the Remove button.
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Volume and Sounds

Adjusting Volume and Sounds

SelectStart->Settings>Control Panel and double-click the Volume & Sounds icon.
Select desired options in thelume tab.

NOTE: Turning off sounds saves power and prolongs battery life.

Changing Event Sounds

1. SelectStart->Settings>Control Panel.

2. Double-click the Volume & Sounds icon and select the Sound tab.
3. Select an event from tikevent Namelist.
4

. Select a sound from therent Soundlist. You can remove a sound from the selected
event by clickingNone

5. SelectSave Asand then name the sound scheme to save the changes to a different
scheme. You can delete a sound scheme by selecting it in the list and deleis

NOTE: To quickly turn off all event sounds, select No sounds from the Scheme list.

World Clock

Setting the Date and Time

1. SelectStart->Settings>Control Panel.
2. Double-click the World Clock icon and select b&te & Time tab.

3. Set the month by selecting the Date box arrow, and then selecting the arrows on either
side of the month shown. You can also select the month label to choose from a list of

months.

4. Set the date by selecting it in the calendar.

5. Set the time by dragging the hands on the clock or entering the time in the box below
the clock.

NOTE: To quickly display the Date & Time tab, double-click the time display in the taskbar.
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Setting Your Home City

Set your home city by selectir®jart-> Settings>Control Panel and double-clicking the
World Clock icon. Select theome tab and select your home city from the list. If your
home city is not in the list, select the closest city.

Adding a City to the List

You can add a city to the list by selectidrt-> Settings> Control Panel and double-
clicking the World Clock icon. Click th@ptions tab, selecAdd and follow the directions
on the screen.

To modify information about a city you have added, select the city in the listEditk
and make the changes you want.

Setting a Visiting City
Set your visiting city by selectingtart->Settings>Control Panel and double-click the
World Clock icon. Select théisiting City tab and select the city you are visiting.

When you travel, specify the city you are visiting using\tsiting City tab and select
the city name in thBate & Time tab. The device automatically switches to that city's
date and time. If the city is not in the list, select the closest city.

Setting an Alarm

1. SelectStart->Settings>Control Panel.

2. Double-click the World Clock icon and select Alarms tab.
3. Enter the alarm description and time.

4. Select th@©ptions button to adjust alarm settings.

You can turn off or reset an alarm in #hkarms tab by clearing the check box for the
alarm. When you select a sound in Matification Options box, your device plays a
short sample. Options depend on the device you are using.
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Solitaire

Playing the Game

Select the Deal button to deal the cards. If you want to display cards in the upper-left
stack, select the stack. Move a card to one of the stacks by dragging the card. Then build
the row stacks in descending order, alternating between red and black cards. Within the
row stacks, turn a card face-up by selecting it. You can move a king to an empty row stack
and move an ace to an empty suit stack.

Select the Undo button to undo a move. Build the suit stacks at the top in ascending order,
from ace to king. You win the game when all the cards are in the suit stacks.

Setting Solitaire Options

1. Select the Options button.
2. Select desired options.

Solitaire Scoring Systems

In Standard scoring, you earn the following points based on time and moves:

» 10 points for each card moved to a suit stack.

* 5 points for each card moved from the deck to a row stack.

» -15 points for each card moved from a suit stack to a row stack.

» -20 points for each pass through the deck after four passes (Draw Three option).

» -100 points for each pass through the deck after one pass (Draw One option).

You receive a bonus when you complete a timed game. The shorter the game, the larger
the bonus. In Vegas scoring, your ante is $52 to begin playing each game. The object is to
earn more than you wagered. No time penalty or bonus is given with Vegas scoring. If you

select the Keep cumulative score option, you see a running total of your score from game
to game. You win $5 for each card moved to a suit stack.
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appendix A

TIPS & TROUBLESHOOTING

Tips

Introduction

This chapter provides tips on getting the best performance from your Aero 8000, as well
as information on identifying and solving typical problems that may occur while using
your device. If you need troubleshooting information for ActiveSync, select
Help->ActiveSync Help Topicsin the Mobile Devices folder on your desktop computer.

Adjusting Memory

Memory allocation in the Aero 8000 is comprised of storage memory and program mem-
ory. You may want to increase the amount of storage memory if you do not have enough
space for files. You may want to increase the amount of program memory if your device is
running too slow.

Increasing Storage Memory

To increase the amount of available storage memory, follow these steps:
NOTE: Increasing storage memory will decrease the amount of available program memory.

Delete any unnecessary files.
Close any applications that are open.
SelectStart-> Settings> Control Panel and double-click the System icon.

0w Dn P

Select thdvlemory tab and adjust the memory slider to increase the amount of storage
memory.
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Increasing Program Memory
To increase the amount of available program memory, follow these steps:
NOTE: Increasing program memory will decrease the amount of available storage memory.

Delete any unnecessary files.
Close any applications that are open.
SelectStart-> Settings> Control Panel and double-click the System icon.

»p w0 NP

Select thé/lemory tab and adjust the memory slider to increase the amount of pro-
gram memory.

Increasing the Data Transfer Speed

To increase the speed of data transfer between your Aero 8000 and your computer, follow
the procedure outlined in "Changing the speed of data transfer” in the ActiveSync Help
that you installed on your computer.

Technical Support

Servicing the Aero 8000

To get help from Compaqg Customer Support or to find a Compaq authorized reseller or
service provider, refer to the telephone guide included with your Aero 8000.

Your Compag authorized reseller or service provider is available to answer your questions
and service your device when necessary.

If you return the device for servicing, remember to provide all the necessary passwords, or
disable the passwords prior to delivery to the service provider.

Preparing for a Technical Support Call

To receive the fastest possible solution, have the following available when you place a call
to Compaq Customer Support:

e your Aero 8000

» serial number on the bottom of the device

* purchase date on your invoice

» conditions under which the problem occurred

e error message that occurred

* hardware configuration

» hardware and software that you are using.

-2 Tips & Troubleshooting



Troubleshooting

Introduction

While your Aero 8000 is configured just for you, problems you encounter while working
may not be unique. Eliminating the typical problems described in this section can save you

time and money.

See the categories on the following pages to find the possible solution to your problem. If
you cannot resolve the problem, contact your Compaq authorized service provider or call

Compag Customer Support for help.

NOTE: If you need troubleshooting information for ActiveSync, setalp->ActiveSync
Help Topicsin the Mobile Devices folder on your desktop computer.

Solving Audio Problems

Table 20: Solving Audio Problems

Problem

Possible Cause

Solution

Cannot get sound from
device.

low.

Volume is muted or too

Adjust the volume through
Volume & Sounds Proper-
ties in the Control Panel.
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Solving Infrared (Communications) Problems

Table 21: Solving Infrared (Communications) Problems

Problem

Possible Cause

Solution

| cannot transfer files using
the IR port.

) The IR devices are not se
up properly.

I Set up the devices properly.

The sending or receiving
device is not properly con
figured for IR.

Configure each device for
IR according to the manu-
facturer's instructions. For
additional information, see
"Connecting with an Infra-
red Port" in the ActiveSyng
Help that you installed on
your desktop computer.

The receiving device is no
compatible with the send-
ing device.

t Transfer files another way

such as through the auto-
sync cable or viaa PC Card
or CompactFlash Card.

one file at a time using the
IR port.

| cannot transfer more thapnThe Aero 8000 is designe

to transfer one file (or 25
Contact cards) at a time
when sending data to

d Transfer only the recom-

mended number of files at
one time.

another device.

Solving Keyboard Problems

Table 22: Solving Keyboard Problems

Problem

Possible Cause

Solution

The device does not
respond to keystrokes.

Device is locked up.

Press the Reset button.

NOTE: Pressing the Reset
button will delete unsaved
data.

-4
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Solving Memory Pro

blems

Table 23: Solving Memory Problems

Problem

Possible Cause

Solution

The device will not turn on
or the device does not rec
ognize the memory.

Memory expansion modulé
- is installed incorrectly or
not seated properly.

2 Reinstall the memory
expansion module.

There is an unstable con-
nection between the mem
ory expansion module ang
the device.

Remove the memory
- expansion module, clean
| the edge connector with a
soft, dry cloth, and reinstal
the module.

Memory has failed.

Remove the memory
expansion module and tur
on the device.

If the same error occurs,
contact Customer Support.
If the same error does not
occur, clean the module
contacts, reinstall the mod
ule and turn on the device|
If the same error returns,
remove the module and
operate with less memory
until the module is
replaced.

Insufficient memory error
occurs during an operatiot

ngram memory for the

The device ran out of pro-

application.

Close all open application
and delete the files that ar
not being used.

Adjust the amount of avalil
able program memory.
Upgrade memory if

U

needed.
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Table 23: Solving Memory Problems

Problem

Possible Cause

Solution

The device gets slower
each time | use it.

Too many document short
cuts are taking up memory

- See how many recently
.used document shortcuts

exist by pressing the Win-
dows key, then seleEtoc-
uments.

Remove seldom used dog
ument shortcuts by delet-
ing them from the
Windows/ Recent folder.

Memory needs to be
refreshed.

Save your data, then per-
form a full reset.

Not enough space to save
my work.

Device ran out of memory,

Close all open applications
and delete files that are not
being used.

Adjust the amount of avalil
able storage memory.
Upgrade memory if
needed.

Use an ATA Flash RAM
PC Card or a Compact-
Flash Card for additional
storage.

-6
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Solving Modem (Communications) Problems

Table 24: Solving Modem (Communications) Problems

Problem

Possible Cause

Solution

| cannot connect my
modem at the specified
baud rate.

There may be static or
other forms of interference
on the telephone line.

Disconnect (hang up) and
® try to connect again.

The bandwidth of the Inter
net service provider (ISP)
is limited.

-You can connect only at th
maximum baud rate sup-
ported by the ISP.

The dial-up connection is
unreliable.

The telephone cable is no
connected properly.

t Secure the telephone cab
connection.

Call waiting is interrupting
the connection.

Disable call waiting. Selec
Start-> Settings>control
Panelthen selecCommu-
nications Properties On
the Dialing tab, seledis-
able call waiting by dial-
ing. Then enter the disablé¢
code specified by your
local telephone company.

| cannot use the Aero 800
modem when connected t
a computer.

DThe computer or Aero
08000 may not be properly
set up for modem commu
nication.

Make sure you have
enabled the device conne
tions on the Communica-
tions tab of the Mobile
Devices folder on your
computer.

Make sure a partnership i
established with your com
puter.

See the Troubleshooting
section in the ActiveSync
Help that you installed on
your computer.

4%

e

\1%4

"4}

| cannot access the Inter-
net like | used to be able.

Your Internet service pro-
vider has changed the set
tings.

Contact your ISP and set
- up a profile using the new
settings.

The modem is too loud or
too soft when dialing.

The volume needs to be
adjusted.

Adjust the volume through
Volume & Sounds Prop-
ertiesin the Control Panel

Tips & Troubleshooting
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Solving Partnership/Serial (Communications) Problems

Table 25: Solving Partnership/Serial (Communications) Problems

Problem Possible Cause Solution

| cannot establish a con- | The auto-sync cable may | Reconnect the auto-sync

nection between the Aero| be loose or defective. cable.
8000 and my desktop com- Replace the defective cable
puter. with a new one.

There are problems with | See "Communications
the serial communications Problems" in the Active-
configuration. Sync Help that you
installed on your computer.

| cannot synchronize data| There are problems with | See "Communications
when connected to the the serial communicationg Problems" in the Active-
computer. connection. Sync Help that you
installed on your computer.

There is a compatibility | See the online help
problem with Microsoft included with Microsoft
Outlook on the computer. | Outlook for information on
synchronizing mail.
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Solving PC or CompactFlash Card Problems

Table 26: Solving PC or CompactFlash Card Problems

Problem

Possible Cause

Solution

The PC Card or Compact:
Flash Card is not recog-

nized as part of the system.

Drivers must be installed.

=)

Check the documentatig
included with the card for
information on installing
drivers on your Aero 8000,

n

Cables or power cords
attaching the PC Card or
CompactFlash Card are
loose or unplugged.

Check to make sure the
cables are properly and
securely connected.

PC Card or CompactFlasl
Card is not seated properl

) Remove and reinsert the
ycard correctly.

The device shuts down
while the PC Card or Con
pactFlash Card is in use.

The PC Card or Compact
-Flash Card drains too muc
power from the device bat
teries.

Remove the PC Card or
hCompactFlash Card.

- Connect the device to
external power and rein-
sert the PC Card or Com-
pactFlash Card.

The PC Card or Compact:
Flash Card does not work

properly.

The card or card driver is
not compatible with the
Aero 8000.

Refer to the documenta-
tion that came with your
PC Card or CompactFlasl
Card.

Visit the Aero 8000 home
page on the Internet for a
list of PC Cards and Com/
pactFlash Cards supporte
by Compag.

[N

PC Card or CompactFlask
Card is not seated properl

1 Remove the reinsert the
ycard correctly.

If using a PC Card or Com
pactFlash Card modem, th
modem cable is not
plugged in all the way.

-Secure the modem cable
econnection.
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Solving Battery and

Power Problems

Table 27: Solving Battery and Power Problems

Problem

Possible Cause

Solution

The Aero 8000 goes into
auto-suspend after a shor
period of inactivity.

When operating on batter

I power, the Aero 8000 sus
pends operation after thre
minutes of idle time (the
default setting).

Press the Power button to
+ resume operation, then
eincrease the amount of idl

time through the Power

icon on the Control Panel.

NOTE:Increasing the idle time
drains the batteries more
quickly.

The Aero 8000 does not
auto-suspend when con-
nected to a computer or
using the modem.

The Aero 8000 is designe
to stay on while connecte
to a computer.

dNo action required.
]

The device turned off while
left unattended.

Device initiated a safety
shutdown due to a critical
low battery condition.

Replace the batteries or
connect the device to exte
nal power.

Turn on the device.

Device shuts down while
the PC Card is in use.

The PC Card drains too
much power from the
device batteries.

Remove the PC Card.
Connect the device to
external power and rein-
sert the PC Card.

Battery life is very short.

You are using the device
ways that drain that drain

the battery quickly.

iReview your battery usage.

D

- 10 Tips & Troubleshooting



Solving Screen Prob

lems

Table 28: Solving Screen Problems

Problem

Possible Cause

Solution

The screen appears to be
off, even though the powe

The screen contrast is
I extremely light.

Increase the contrast usin
Fn+<orFn+ >

is on.

The system is configured
for an external monitor.

Switch to LCD mode using
Fn + PgUp

Backlight is off.

Presgn + Home

Iltems on the screen do no
display properly.

t The angle of the screen
needs to be adjusted.

Adjust the angle of the
screen until you can see th
items on the screens clear
as possible.

y

Characters are dim.

The screen is too light g
too dark. The contrast ang
or brightness need to be
adjusted.

rAdjust the contrast using

/theFn + < or > keys.
Adjust the brightness usin
theFn + arrow up ofFn +
arrow down.

The screen gets lighter or
darker.

The screen has overheate

d. Move the device away
from the heat source (suc
as direct sunlight) and
allow it to cool.

NOTE:Prolonged exposure to
direct sunlight may cause
your screen to temporarily
darken.

Tips & Troubleshooting
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Solving Security Pro

blems

Table 29: Solving Security Problems

Problem Possible Cause Solution

| cannot access the systemYou are using the wrong | Enter the correct passworg

using my login password. | login password. or move to the next stage in
the password process by
entering the wrong pass-
word five times in a row.

| cannot access the systemYou are entering the wrong Enter the correct response

using my response phrase.response phrase. phrase or more to the next
stage in the password pror
cess by entering the wrong

response five times in a
row.

You are not entering the
correct punctuation.

Compagq security pass-
words are punctuation-sen-
sitive. Type the

punctuation exactly as it
was typed when you estab
lished the password.
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